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6 Preface 

Preface 
Oracle Hospitality Simphony is a cloud-based Point-of-Sale (POS) solution that provides 
business management capabilities using a single tool with vast integration capabilities to 
property management systems, paperless kitchen display systems, credit card interfaces, 
and reporting applications. 

Purpose 
These Release Notes provide a brief overview of additions, enhancements, and 
corrections implemented in this software release. Their intent is informative, not 
instructional. Review Simphony's product documentation, including technical and 
application advisories for previous versions, for detailed information on installation, 
upgrade, configuration, and general use. 

Audience 
This document is intended for all users of Oracle Hospitality Simphony version 2.6. 

Customer Support 
To contact Oracle Customer Support, access My Oracle Support at the following URL: 
https://support.oracle.com 

When contacting Customer Support, please provide the following: 
• Product version and program/module name 
• Functional and technical description of the problem (include business impact) 
• Detailed step-by-step instructions to re-create 
• Exact error message received and any associated log files 
• Screen shots of each step you take 

Documentation 
Oracle Hospitality product documentation is available on the Oracle Help Center at 
http://docs.oracle.com/en/industries/hospitality/ 

PA-DSS Implementation Guide Updates 
You can now harden your system’s security access to the Enterprise Management 
Console (EMC) (in the Enterprise Parameters module) by creating more complex 
passwords for users. 

Revision History 
Date Description of Change 

July 2015 • Initial publication 

August 2017 • Removed Simphony v2.6 content 
referencing Target Process ID 33547 

https://support.oracle.com/
http://docs.oracle.com/en/industries/hospitality/
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1  Features and Updates 
Simphony 2.6 MR1 

 

Important Notice 

Simphony 2.6 MR 1 contains the hot fixes (HF) that were released on Simphony 
2.6 GR up through HF 4. Any issue that was corrected in a hot fix after HF 4 was 
not included in this release. Customers that are installed with Simphony 2.6 GR 
HF 5 or higher should wait until a HF comes out on Simphony 2.6 MR 1 which 
contains a roll up of the remaining v2.6 GR hot fixes. 

EMC 

Support to allow users to copy existing names (primary and foreign) to 
a new Menu Item created from a template has been introduced 
A new feature, Copy Menu Item names, has been added to EMC-> <Enterprise / Zone / 
Property / Revenue Center>-> Configuration tab-> Menu Item Maintenance module. When a 
new Menu Item is added, this feature allows the user to copy all of the existing names 
(primary and foreign) to the new Menu Item. 

• If Add Master Record from Template is selected in the Add Menu Items dialog 
and Copy Menu Item names is enabled, all of the names—including the Long 
Descriptor(s)—will be copied from the original Menu Item to the new Menu 
Item. 

• If Add Master Record from Template is selected and Copy Menu Item names is 
disabled, the original primary and foreign names will not be copied. 

The Context Sensitive Help (CSH) for Copy Menu Item names reads as follows: 
Select this checkbox to copy all of the Menu Item names from the original template menu item. 
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The ability to configure a Service Charge for a Deposit Forfeit Return 
Item has been introduced 
Prior to this release, only a Menu Item could be linked in the Deposit Forfeit Return 
Item field (located in EMC-> Revenue Center level-> Setup tab-> RVC Parameters-> General 
tab). With this release, users can now link a Service Charge to a Deposit Forfeit Return 
Item. The new option [67 – Use Service Charge as Deposit Forfeit Return Item] has been 
added to the EMC-> Revenue Center level-> Setup tab-> RVC Parameters-> Options tab-> 
General section. 
When a Service Charge is used as a Deposit Forfeit Return Item, the service charge 
amount is not included in the Net Sales on the RVC Financial Report. This is because any 
forfeited deposit amount is used to repair damages to the rented item and/or to purchase 
a new rentable item. 
The Context Sensitive Help (CSH) for option [67 - Use Service Charge as Deposit Forfeit 
Return Item] reads as follows: 
Enable this option to use Service Charge as Deposit Forfeit Return Item. If this option is disabled, 
Menu Item will be used as Deposit Forfeit Return Item. 
The Context Sensitive Help (CSH) for Deposit Forfeit Return item (Service Charge) 
(located in EMC-> Revenue Center level-> Setup tab-> Parameters-> RVC Parameters-> 
General tab) has been updated and now reads as follows when option [67] is enabled: 
Select the Deposit Forfeit Return Item for this Revenue Center. This setting is used in conjunction 
with the Deposit Handling feature and is necessary in order to refund a deposit. This item will 
automatically be added to a check when a rental item is returned and the deposit rental refunded. 
The price for this return item will automatically be set to the un-refunded amount of the deposit. 
To use Menu Item as Deposit Forfeit Return Item, disable option #67 - Use Service Charge as 
Deposit Forfeit Return Item. [Simphony v2.6] 
When option [67] is disabled, the Context Sensitive Help (CSH) for Deposit Forfeit 
Return item (Menu Item) reads the same as above, except the last sentence is changed to: 
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To use Service Charge as Deposit Forfeit Return Item, enable option #67 - Use Service Charge as 
Deposit Forfeit Return Item. 

Extensibility 

Two Extensibility events now support Automatic and Coupon Discounts 
With this release, two discount extensibility events are triggered when an Automatic or 
Coupon Discount is applied to or removed from a check. The first event, called 
OpsDiscountEnginePreviewEvent, triggers every time the Discount Engine is about to 
run. The second event, called OpsDiscountEngineEvent, occurs after the Discount 
Engine has run and all the automatic discounts have been applied to the check. Both of 
these events are empty events and do not contain any discount information. These 
simply notify extensibility that the Discount Engine is about to run and that it has run. 
These events allow the extensibility applications to modify the check prior to the 
Discount Engine running or after it has completed and the discounts are added to the 
check. 

Property Management System (PMS) 

Support to print PMS Messages and Responses on Guest Checks and 
Customer Receipts has been introduced 
With this release, Simphony supports printing PMS Messages and Responses on Guest 
Checks and Customer Receipts. When Tender/Media option [30 - ON=Print PMS 
Response and Posting Msg; OFF=Print Response ONLY] is enabled, the PMS Response 
(reference entry) and Posting Message will print on all Guest Checks and Customer 
Receipts below the tender (as shown below) and be included in the Workstation Check 
Journal Report for the transaction. When disabled, only the PMS Response Message will 
be printed. 

 
The Context Sensitive Help (CSH) for option [30 – ON=Print PMS Response and Posting 
Msg; OFF=Print Response ONLY] reads as follows: 
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Select this option to print the PMS Response and the Posting Message on the guest check. If this 
option is Not selected, only the PMS Response Message will be displayed on the guest check. 

Enabling option [30 - ON=Print PMS Response and Posting Msg; OFF=Print Response 
ONLY] does not affect the behavior of ‘non-PMS’ Tender/Media. 

Workstation Clients 

Support for the mTablet E Series device has been introduced 
The mTablet E Series device is available in 2 differing screen sizes: 

• 8” screens 
• 11” inch screens 

The mTablet E Series supports the following operations and configuration(s): 
• Ops is supported on the mTablet E Series. 
• When Ops is running and a user accesses an Open check with rung up items 

present, the long press (pressing the screen for over 5 seconds) will enable 
Gesturing within the Check Detail area. When Ops is not running, a long press 
on the display screen will initiate the equivalent of a right mouse-click. 

• The mTablet E Series can be configured to utilize fingerprint Biometrics logon 
capabilities. See the Fingerprint Reader Configuration and Enrolling Procedures 
article for more information. 

• When Ops is up and running, the device’s Battery Life Status and Wi-Fi Signal 
Strength can be viewed on the display screen. These indicators can be configured 
to display on either the top or bottom of the Ops display screen. 

 
The tablet's remaining Battery Life Status appears as a percentage value (78% as shown 
above). 
The Wi-Fi Signal Strength shows one of the following possible indicators (listed in order 
below from best to worst Wi-Fi connectivity): 

o RFSIG : EXCELLENT  
o RFSIG : VGOOD  
o RFSIG : GOOD  
o RFSIG : POOR 
o RFSIG : NO 
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• CAL v128 has been added to the Simphony Installation package to 
standardize the supported version of CAL for all clients, including the 
mTablet E Series. CAL Packages will be sent to and perform all of the 
same tasks for the mTablet E Series as for any other Workstation. 

• After an mTablet E Series device has been CAL’d and Ops is running, the screen 
orientation is locked in the Landscape perspective and cannot be changed by 
users. 

See the 2.x mTablet E Series article for more information. 

Simphony 2.6 
CAL 

A New Version of the Client Application Loader (CAL) has been 
introduced 
With this release, CAL Packages will now be stored in the Transactional database. 
Additionally, the EMC has been enhanced to allow users to upload CAL Packages to the 
database. 
There were no changes made to the CAL client. Storing CAL packages in the database 
solved the following issues: 

• It was very difficult to synchronize CAL folders across Application servers. 
Storing CAL Packages in the database provides a central storage location and 
eliminated this synchronization problem. 

• Most users do not have access to the application server to add a CAL package to 
a directory in the CAL file structure. These changes eliminated the need to access 
the application server to upload custom CAL packages. 

This enhancement allows privileged users to access or modify CAL Packages without 
needing to go through any additional steps. Once the user signs onto the EMC, they 
can deploy existing CAL Packages how they see fit. If a new CAL Package needs to 
be applied, simply save the CAL Package to the disk, the local PC, make the changes 
and upload it directly into the Simphony database and deploy. 

New CAL and the 2.x Gateway 
The New Client Application Loader (CAL) only uses the 2.x Gateway. With this 
release, New CAL handling has been moved from the 1.x Gateway to the 2.x 
Gateway. This will be a seamless transition. Users will not have to re-CAL 
Workstations or make changes to their Remote EMC configuration. 
See the New CAL 2.x and CAL Packages articles for more information. 

EMC 

Functionality for the Direct Entry of a Charge Tip has been introduced 
It is now possible to post a Charge Tip through direct entry. Previously, Charge Tips 
could only be posted by overtendering a Charge Tender. Now an Operator may post a 
Charge Tip immediately before a Charge Tender by selecting a Charge Tip key. This 
functionality has been implemented by modifying Ops.dll and Micros.Payment.dll files. 
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Custom Content Loader in the EMC Page Design module for Win32 
Clients has been introduced 
With this release, a new Custom Content Loader has been added to the EMC-> 
<Enterprise / Property / Revenue Center> -> Configuration tab-> User Interface-> Page Design 
module. Previously, if a user desired to add a control to a page other than what was 
provided by the EMC out-of-the-box (buttons, tab control etc.), they had to create a 
Custom (database) Page Template. The Custom Content Loader provides page designers 
the ability to select a loose XAML (previously added as Content) to be the content of the 
control. This enhancement has been accomplished by modifying the EMCText.xml file. 
Currently, this feature is supported on Win32 clients. To load custom content to the Page 
Designer, follow these steps: 
1. Navigate to the EMC-> Setup tab-> Custom Content-> Content Enterprise. 
2. Click the Add icon and add a new record. 
3. Set the Content Type to 1-LoosesXaml. 
4. Click the Save icon. 
5. Navigate to the EMC-> <Enterprise / Property / Revenue Center> -> Configuration tab-> 

User Interface-> Page Design module. 
6. In the Page Designer, click the + Other button. 
7. Select Custom Content Loader. 

 
8. From the Custom Content Loader configuration menu, select the previously added 

Content. 
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Assigning Menu Item Ranges to Properties is now supported 
Users now have the ability to control the Menu Item numbers that are used by a 
Property. As Simphony Reporting is based on Menu Item numbers, and as it would 
cause reporting integrity issues if the same number was assigned to two different Menu 
Items at different Properties, a new functionality has been added to provide Enterprise 
users the ability to allocate Menu Item ranges to the Properties. 
For this purpose, the Assigned Menu Items field has been introduced to the EMC-> 
Enterprise level-> Setup tab-> Enterprise Configuration-> Properties. 

 
The Context Sensitive Help (CSH) for this field reads as follows: 
The Range of object numbers allowed for Menu item master object numbers at a Property. These 
values should not overlap with range from another property. At Enterprise these values will not be 
used when adding menu item masters. 
To prevent the same range from being assigned to multiple Properties, when a range is 
entered in the Assigned Menu Items field, upon clicking the Save or Save All icon, the 
following error message is displayed: 
The menu item object number range for this property is invalid. (###-###) 
Note: ###-### is the range of Menu Items assigned to the Property. 
When adding a new Menu Item from the Enterprise level: 

• The Record Number field in Add Master Record from Template and the Next 
available Position in Add Master Records without a Template will display the 
next available position that is not assigned to a property. 

When adding a new Menu Item from the Property level: 
• The Record Number field in Add Master Record from Template and the Next 

available Position in Add Master Records without a Template will display the 
next available position in the assigned Property Menu Item range after the 
currently selected Item. 

• The allowed Menu Item range for that Property is displayed in the Add Menu 
Items dialog box for both Add Master Record from Template and Add Master 
Records without a Template. 
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When a user attempts to enter a number outside the assigned Property Item 
range, the following error message is displayed: 
The requested object number(s) are not allowed. 

The Serving Periods Module now supports Data Extensions 
The Serving Periods module in the EMC-> Revenue Center level-> Configuration tab-> 
Reporting and Data has been enhanced to support Data Extensions. New data columns 



 

Features and Updates  15 

can now be added to the Serving Periods module by configuring additional columns via 
the EMC-> Enterprise level-> Configuration tab-> Reporting and Data-> Data Extensions. 

Support to Copy and Paste Buttons in Page Designer Using Keyboard 
Commands has been introduced 
With this release, the Simphony Page Designer in the EMC-> <Enterprise / Property / 
Revenue Center> -> User Interface-> Page Design has been enhanced to provide users the 
ability to copy an existing button and paste it using the Ctrl + C and Ctrl + V keyboard 
commands. 

Guest Count Configuration for Catering Orders has been introduced 
Traditionally, Menu Items could be used to increment the Guest Count when configured 
to do so. This functionality was typically used to increment the Guest Count according to 
the number of Entrées or drinks ordered at a table. In the case of catering, large parties, 
or tapas style dining, a single menu item could represent more than one guest. To 
accommodate this functionality, a configurable Guest Count has been added to Menu 
Item Definitions. 

Configuration 
To allow this functionality, option [11 – Add to Guest Count] in the EMC-> Configuration 
tab-> Menu Items-> Menu Item Classes Enterprise-> Options tab must be enabled to identify 
a menu item which increments the Guest Count. 

 
An additional field has been added to the Menu Item Definitions module in the EMC-> 
Configuration tab-> Menu Items-> Menu Item Maintenance Enterprise–> General tab-> 
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Miscellaneous Properties section called Guest Count. This field represents how many 
guests the count is incremented when the item is ordered. 
The Context Sensitive Help text (CSH) for Guest Count reads as follows: 
Enter the Guest Count for this menu item to increment the check guest count when ordered. For 
example, if a catering order consists of 2 Catering Appetizer Platters, each representing 10 guests 
as defined here, the Guest Count on the check would be 20. This menu item will increment the 
check guest count by the number defined here only if its Menu Item Class option "Add to Guest 
Count" is enabled. This value will not affect the Guest Count if the [Use Number of Seats for 
Guest Count] option is enabled in the 'Revenue Center Parameters' module. Also, if the operator 
presses the Number of Guests key during a transaction, the Guest Count will no longer increment 
when Menu Items are added to the check. 

 

Usage 
When ordering an item configured to [11 - Add to Guest Count] with a Guest Count of 
10, every time the item is ordered the Guest Count will increment by 10. Ordering a 
Quantity of 10 of this item will result in a Guest Count of 100. 
Note: The Guest Count can still be modified manually. Entering a manual Guest Count 
will override any Guest Counts calculated using the Menu Item Definitions-> Guest Count 
configuration. 

Simphony Options [85 - Not Allowed With Incomplete Meals] and [164-
Authorize/Perform Service Total/Payment with missing meal sides] have 
been renamed 
EMC options [85 - Not Allowed With Incomplete Meals] and [164 - Authorize/Perform 
Service Total/Payment with missing meal sides], which prevents and/or authorizes 
Operators and Cahiers from closing and Service Totaling Checks when a Combo Meal 
has placeholders, have been renamed to include the word “Placeholder” with this 
Simphony release. Associated Context Sensitive Help (CSH) texts have been modified 
accordingly. This change better communicates to the users the use of the options and 
preserves consistency within the EMC. 
The option [85 - Not Allowed With Incomplete Meals] has been renamed to [85 - Not 
Allowed With Incomplete Meals (Meals with Placeholders)] in the EMC-> Configuration 
tab-> Sales-> Tender/Media-> Options tab-> Ops Behavior tab-> Tender Options. 
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The CSH text for option [85 - Not Allowed With Incomplete Meals (Meals with 
Placeholders)] reads as follows: 
Enable this option to disallow this Tender when a Meal has a Placeholder item. 
The option [164 - Authorize/Perform Service Total/Payment with missing meal sides] 
has been renamed to [164 - Authorize/Perform Service Total/Payment with Placeholder 
item] in the EMC-> Configuration tab-> Personnel-> Roles-> Operations tab-> Transactions tab-
> Transaction Control Options. 
The CSH text for option [164 - Authorize/Perform Service Total/Payment with 
Placeholder item] reads as follows: 
Enable this option to allow employee to perform/authorize tendering a transaction with a 
Placeholder item, if Tender Media option bit 85 is enabled. 

Support for Override in the EMC-> Menu Item Maintenance has been 
introduced 
New Override functionality has been added in the EMC-> Menu Item Maintenance-> 
Search/Table View. 
See the Support for Override in the EMC Menu Item Maintenance article for more 
information. 

Remote EMC Now Uses the Simphony v2.x EGateway 
With this release, a Remote EMC uses the Simphony v2.x main EGateway service port 
8080 when newly installing the EMC Client, and when upgrading from a version prior to 
Simphony v2.6. However, if Simphony is being upgraded from a Simphony 2.x version 
prior to this release, Simphony v2 will listen to service port 8080 as well as 8050. 

Support to Check for Existing Menu Item Names and Numbers has been 
introduced 
Simphony now provides the ability to check and prevent Users from inserting existing 
Menu Items from the Enterprise level, Property level, or Zone level. Two new EMC 
options have been added to check for duplicate Menu Item Names and duplicate Item 
Numbers respectively. However, users may insert duplicate entries by enabling the 
newly added Role privilege options. In addition, a new report named, Module Reference 
Report has been introduced to provide privileged users the ability to search and review 
the system to see if a Menu Item Name or Number (or a range of numbers) already exists. 
See the System Check for Existing Menu Items article for more information. 

Select All and Clear All links have been added to Dialog Boxes that have 
Check Boxes 
All dialog boxes in Simphony that have check boxes now include Select All and Clear 
All links. This enhancement has been implemented by modifying the EMC module. 

Property Parameters-> Workstations tab column '#’ has been renamed 
to Service ID 
The column named ‘#’ in the EMC-> Property level-> Setup tab-> Parameters-> Property 
Parameters-> Workstations tab-> Service Host has been renamed to Service ID. The Context 
Sensitive Help (CSH) text for the Service ID column reads as follows: 
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This column displays the ServiceID of the service record. This column is not configurable, and it is 
displayed for troubleshooting purposes only. 

Support to Link Multiple Family Groups to a Major Group has been 
introduced 
With this release, support to link multiple Family Groups to a Major Group has been 
added to Simphony. A new column named Parent Major Group has been added to the 
EMC-> <Enterprise / Property> ->Configuration tab-> Menu Items-> Family Groups. 
The Context Sensitive Help (CSH) text for the column Parent Major Group reads as 
follows: 
Select a Major group to which this Family group belongs. When a Major Group linked to a Family 
Group is assigned to a Menu Item, only those linked Family Groups will be presented in the 
selection list in the Family Group field. 

 
Note: If no changes are made to the Parent Major Group drop-down menu, the default 
value will be [0 - None]. 

Adding or Editing Menu Items in Menu Item Maintenance 
When a Family Group has a Major Group assigned, that Family Group is linked to the 
Major Group in Menu Item Maintenance. When adding a Menu Item with Add Master 
Records Without Template, or when editing a Menu Item via the EMC-> 
<Enterprise/Property/Revenue Center> ->Configuration tab-> Menu Items-> Menu Item 
Maintenance module, once a Menu Item is assigned a Major Group that has a linked 
Family Group, the Select Family Group Lookup will only display the Family Groups that 
have been assigned to the selected Major Group.  
For example: If the Family Groups Concessions, Pastas and Appetizers are linked to the 
Major Group - Food, in Menu Item Maintenance, if the user assigns a Menu Item to the 
Major Group - Food, when the user selects Family Group, only the Family Groups 
Concessions, Pastas and Appetizers will be displayed in the Family Group Lookup. 
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If a Major Group does not have any Family Groups assigned, all free or unassociated 
Family Groups will be displayed in the Family Group Lookup. However, if a Major 
Group does not have any Family Groups assigned, and if all Family Groups are assigned 
to other Major Groups, then the entire list of Family Groups will be displayed. 
In the Table View of Menu Item Maintenance, Family Groups linked to a Major Group 
will behave as follows: 

• If a user tries to enter the Family Group number directly in the Family Group 
column to a Menu Item already assigned to a Major Group linked to Family 
Groups, it will only allow entering the number of a Family Group linked to the 
Major Group. If the user has entered an invalid number, when attempting to save 
the record an error message will be displayed. 
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• When copying a Family Group linked to a Major Group to another row using the 
F3 and F4 keyboard functions, if the Major Group of the row to which the content 
will be copied to is not eligible, the Major Group of that row will be changed 
according to the copied Family Group. 
When copying a Major Group assigned to a Family Group to another row using 
the F3 and F4 functions, if the Family Group of the row to which the Major 
Group will be copied to is not eligible, once the copied Major Group is pasted, 
the Family Group of that row will be changed to [0 - None]. 

Combo Meal Group Item Price Records can now be Assigned Effectivity 
Groups 
With this release, Simphony has been enhanced to provide the ability to assign Effectivity 
Groups to a Combo Meal Group Item Price. Four new columns named Effectivity 
Group, Effectivity Status, Date Start and Date End have been added to the EMC-> < 
Enterprise/ Zone / Property / Revenue Center> -> Configuration tab-> Sales-> Combo Meal 
Groups-> Items tab-> Prices tab. 

 
See the Effectivity Group article for more information. 

Encryption of EMC Data Traffic is now supported 
A new option named [16 - Enable Secured Connection] has been added to the EMC-> 
Enterprise-> Setup tab-> Parameters-> Enterprise Parameters-> EMC Options tab to encrypt 
and secure the data transmitted between the server and the EMC. Users must disconnect 
and reconnect the EMC to effectuate the changes made to this option. 
The Context Sensitive Help (CSH) text for the [16 - Enable Secured Connection] option 
reads as follows: 
When this option is enabled, data transmission between EMC and the Server will be encrypted for 
all users. If this option is changed the user must disconnect before the change will occur. 

EMC and Ops 

Support for Rental Deposits has been introduced 
Support of Rental Deposits has been introduced whereby both the EMC and Ops have 
been modified to allow for the configuration and use of Deposits for Rented or Returned 
items. Menu Items (via the Menu Item Classes module) can be configured to create 
Rental Deposit Items. Additionally, Service Charges can be configured to create Rental 
Deposit Service Charges that can be Non-Revenue in nature. Unlike conventional Non-
Revenue Service Charges, more than one Rental Deposit Service Charge can be applied to 
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a check. The [Deposit Forfeit Return Item] setting can be configured in the Revenue 
Center Parameters module to allow Rental Deposit refunds. 
Note:  

• Deposits may be voided 
• A Rental Item may be a Non-Revenue Service Charge. Unlike traditional Non-

Revenue Service Charges, a check may contain more than one of these items. 
See the Rental Deposits article for more information 

Support for Condiment Prefixes has been introduced 
Simphony now provides the ability to insert Condiment Prefixes. Many establishments 
allow customers the ability to modify Menu Items. They may add, remove, increase and 
decrease the number of Condiments that is on the Item. The Condiment Prefixes feature 
inserts prefixes such as ‘NO’, ‘ADD’, ‘EXTRA’, etc. to the Condiment in the Guest Check, 
Order Devices and Customer Receipts so that the Operator, server, kitchen staff and the 
customer may explicitly see the changes made to the Menu Item. This provides helpful 
preparation instructions to the kitchen staff and helps to eliminate order confusion. 
See the Condiment Prefixes article for more information. 

Support for Team Service has been introduced 
With this release, Simphony provides privileged Employees the ability to assign multiple 
service personnel to a check with the introduction of the Team Service feature. A Service 
Team may consist of one or more servers, bussers, food runners, sommeliers, etc. 
Privileged Employees may preconfigure Service Teams or create them on the fly. A team 
member who is not the Check Operator may post Menu Items, Discounts, Service 
Charges or Tenders to a Team Check only if the required privileges have been granted. 
Being a part of a Service Team does not impact an Employee’s ability to interact with 
non-Team Checks (regular checks). 
See the Team Service 2x article for more information. 

Direct Posting Service 

Check Extensibility Data is Now Stored in the Reporting Database 
With this release, all Check Extensibility Data is stored in the Reporting database. At 
present, this enhancement only supports Type 0, 1, 2 and 3 Extension Applications. 
Currently, the Data Transfer Service (DTS) transfers Extension Application information 
to the EXTENSION_APPLICATION table in the Reporting database while all 
Extensibility Information is transferred to the GUEST_CHECK_LINE_ITEM_EXT and 
GUEST_CHECK_LINE_ITEM_EXT_HIST tables in the mymicros.net database by the 
Direct Posting Service (DPS). 
Note: Extensibility Information of Type 0 Extension Applications are not transferred to 
the mymicros.net database. 
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Install 

Updated EAME_AllChecksDiscDtl.xml Report has been added to the 
EAME Reports Folder 
An updated EAME_AllChecksDiscDtl.xml report has been added to the EAME reports 
folder. The following changes have been made to the report: 

• The ReportLineCount column has been renamed to LineCount while the 
ReportLineTotal column has been renamed to LineTotal. 

• The report now applies discounts to all Menu Items on a Check. Previously, 
when a Check had multiple Menu Items, the discount was only applied to the 
first Menu Item. 

Support to Print Runner Chits from a Printer Connected to a Restaurant 
Display Controller (RDC) Box Locally has been introduced 
With this release Simphony provides installers the ability to configure an RDC box as a 
print controller to locally print Runner Chits. 

Printed EMC Output Now Includes a Header 
To improve the readability of printed EMC output, a header is now included in the 
output which identifies what module is being printed, from where, when, and by whom. 

 
1. Module 
2. Location/Date and Time Stamp 
3. Employee Number and Last Name 

mymicros.net inMotion Services have been added to the Simphony 
installation 
With this release, the mymicros.net inMotion Services have been integrated to the 
Simphony installation. During a fresh installation or an upgrade of Simphony, inMotion 
components will also be deployed. This eliminates the need to manually run the 
mymicros.net installation application in order to install the inMotion components. 

iPad 

Credit Card Authorizations are now supported on iOS devices 
Credit Card authorizations are now supported on iOS devices. Operators can authorize 
and finalize credit card transactions through an external Magnetic Card reader or by 
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manually entering the card number. The iDynamo Magtek card readers with Encryption 
Key connect externally via the lightening connector, for the most recent iOS devices, or 
by a 30 pin connector, for older iOS devices. This functionality is supported with the use 
of the MCreditDebit payment driver; no other payment drivers are currently supported 
with iOS. 

Logging is now available on iPad Workstations 
With this release, logging is available on iPad clients. To view log files, navigate to Ops-> 
Launch PMC-> Support tab-> Log-> Log Files. The latest log file is displayed on the screen 
by default. Users may upload the default log file using the Upload button. To view other 
log files, navigate to the Select Log File tab, select the log file and click the View Log 
button. Click the Upload Selected button to upload the selected log file. 
Note: In this release, Find and Find Next search functions have not been implemented. 

 
 
 

Interfaces 

An interface to the myreservations Online Reservations System has 
been introduced 
Simphony now integrates with myreservations, MICROS’ Online Reservations System. 
Online reservations are created and cancelled through myreservations via a restaurant’s 
web site. These reservations are made against Revenue Center level inventory in the 
Simphony Table Management System (TMS). 
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Mobile MICROS 

Support for the Motorola MC40 HHT has been introduced 
Simphony now supports the Motorola MC40 handheld device with Windows Embedded 
Compact (WEC) 7 platform. With this release, Simphony no longer supports the DT 
Research 430 and Motorola 55A handheld devices. MICROS Handhelds functions are 
different from conventional Workstation clients. 
 

See the Mobile MICROS and Bluetooth Printing articles for additional information. 

KDS 

The Posting of KDS Statistics to the Transactional Database is now 
supported 
KDS statistics are now posted to the following Transactional database tables: 

• CHECK_DETAIL 
• KDS_DETAIL 
• KDS_DETAIL_SUBORDER 

The KDS statistical information posted to the database may be viewed on KDS reports 
configured in mymicros.net (e.g., KDS Speed of Service (SOS) report). 

Support for a Backup KDS Controller has been introduced 
The addition of support for a Backup KDS Controller has been introduced. 
See the Backup KDS Controller article for more information. 

Printing of Backup Runner Chits from the Kitchen Display System (KDS) 
has been introduced 
Added support for printing runner chits from a backup printer when the primary printer 
assigned to the KDS failed. At the end of 30 seconds, if the print job is not completed, it 
will be sent to the backup printer or show an error message if backup printing fails. This 
has been corrected by modifying the PosCore.dll, KdsHandler.dll, EGatewayDefs.dll, 
KdsToPosServ.dll and SerializationGenerator.exe files. 

Added a New Kitchen Display System (KDS) Chit Layout Style in the 
EMC 
A new KDS Chit Layout Style named 320-Chit-Std-DOM2 W/Seat has been added to the 
EMC in the EMC-> Enterprise level-> Setup tab-> Hardware/Interfaces-> KDS-> KDS Chit 
Layout Styles. A user is able to apply this Chit Layout Style by clicking the Select link 
next to the KDS Chit Layout Style field in the EMC-> Property level-> Setup tab-> 
Hardware/Interfaces-> KDS-> KDS Displays- > Display tab-> Chit Display Options. 
The header portion of this chit layout shows the Check ID (if available) or the Check 
Number of the order on the left and an active timer on the right displays the time length 
of the order in the system. If the option [9 - Display Subtotal] is enabled for Kitchen 
Themes or Order Devices in the EMC, directly below the Check Number the Subtotal will 
be displayed if the check is currently not tendered. Once the check is tendered, the text 
****Paid**** will be displayed. A status icon is not displayed in this chit layout. 
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The body of this Chit Layout Style shows the Order Type and lists down the items 
ordered on the left. The Condiments ordered are displayed below the Parent Menu Item 
with a single indent. Additionally, items ordered are grouped according to the Seat 
number. A trailer portion is not displayed in this chit layout. 

mymicros.net 

Support for mymicros.net version 8.3.1 has been introduced 
The installation of Simphony v2.6 now distributes mymicros.net version 8.3.1 (patch 2). 

Ops 

Support for Autofire has been introduced 
With this release, support for the Autofire feature has been added. Autofire provides 
Operators the ability to add items to a guest check and hold the order until a pre-set "fire" 
time. Unlike the Hold and Fire function, Autofire lets the operator schedule an order in 
advance and automatically fires the order when the scheduled time arrives. 
See the Simphony v2.x Autofire article for more information. 

Shift Tracking 
Service personnel may work on a shift basis. A shift is a scheduled period of time a 
service personnel is scheduled to work. Many service personnel may volunteer or are 
scheduled to work more than one shift. “Shifts” is a reporting feature that provides the 
ability to post service personnel or cashier totals to a “shifts” to account for the multiple 
shifts worked in single business day. 
See the Shift Tracking article for more information. 

Support for Refills has been introduced 
With this release, support for the Refills feature has been added. The Refills feature 
provides privileged Employees the ability to copy Menu Items from the Previous round 
of a check to the Current round, without charging for it. Customers may order Item 
Refills free of charge until the Refill threshold is reached. Subsequently, customers will be 
charged for all future orders of the refillable Menu Items during the transaction. 
See the Refills article for more information. 

Simphony now Supports Multiple Order Types on a Single Check 
With this release, support has been added to allow more than one Order Type on a Guest 
Check. This enhancement enables an Operator to apply different Order Types such as; 
Dine In and Take Out to the different rounds and Menu Items of the same Check using 
function keys. 
See the Simphony 2.x Order Type article for more information. 

Font size of the Condiment Orderer is now Configurable 
A new property, named Title Bar Font Size, has been added to the Condiment Orderer 
title bar. This property can be used to set the font size of the Condiment Orderer title bar 
and can be accessed from the Layout tab of the Condiment Orderer properties panel in 
the EMC-> <Enterprise / Property / Revenue Center> -> Configuration tab-> User Interface-> 
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Page Design. This option is only visible if the option 'Display Title Bar' is enabled from 
the Data tab of the Condiment/Combo Orderer configuration menu. The default font size 
is set to 18. Users can enter any value between 0-100. If the user enters the value '0', the 
font size will change to the default size. 

Support to Consolidate Menu Items on Demand has been introduced 
Now it is possible for Operators to toggle between consolidated and unconsolidated 
Menu Items on demand. A new function key named, [Consolidation Mode] has been 
added to the Page Design module. If the EMC option [46 - Sort And Consolidate Current 
Round Items on Screen] is enabled and the sort method defined in the EMC-> <Enterprise 
/ Revenue Center>-> Setup tab-> Parameters-> Format Parameters-> Configuration tab-> Sorting 
and Display-> Screen Sort Type is Consolidated, the Menu Items are automatically 
consolidated. When the [Consolidation Mode] function key is pressed, the Menu Items 
will be unconsolidated. However, if the sort method used is Unconsolidated, pressing 
the [Consolidation Mode] function key will consolidate the Menu Items and pressing it 
again will unconsolidate them. 
The [Consolidation Mode] function key can be configured by adding the Consolidation 
Mode button via the EMC-> <Enterprise / Property / Revenue Center> -> Configuration tab-> 
User Interface-> Page Design. 
This feature does not apply when printing Customer Receipts or Guest Checks. 

The Ability to Switch between Two Order Confirmation Boards (OCB) 
has been introduced 
It is now possible to toggle between OCBs if there are two OCBs configured to a single 
Workstation. To toggle between OCBs, a Smart Key should be configured from the EMC-
> <Enterprise / Property / Revenue Center>-> Configuration tab-> User Interface-> Page 
Design and the Condition for the Smart Key should be selected as OCB in the Button 
Configuration menu. 
By default, the Workstation will use the OCB configured with the lowermost OCB 
Number in the EMC-> Property level-> Hardware/Interfaces-> Workstations-> Devices. When 
the Operator presses the button, the Workstation will switch to the second OCB. 

Support for the Integrated Serial (RS232) Magnetic Stripe Reader (MSR) 
for the DT Research 362 Tablet has been introduced 
Previously, Serial Port configuration was not supported on the DT Research 362 Tablet. 
Support for this device was added with the release of Simphony v2.5 MR2. 
See the Simphony 2.5 Maintenance Release 2 ReadMe First article referencing SCR 27940 
for more information. 

Increased the number of lines for Customer Receipt Header from three 
to six 
As certain countries are required to print additional information on Customer Receipts 
due to regulatory reasons, the number of lines for Customer Receipt headers has been 
increased from three to six. 
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Simphony now Supports USB connected T-Flex Coin Dispensers and 
Foreign Currencies 
Simphony has been enhanced to support T-Flex Coin Dispensers that use a USB cable 
connection. Earlier, only Serial connections were supported in Simphony. Using Coin 
Dispensers with a USB cable is only supported on Windows 32 Workstations, while 
Windows CE Workstations support both types of connections. The Coin Dispenser 
software has been modified to support currencies other than the US dollar. For this 
enhancement, the smallest bill for the currency should be configured in EMC-> Enterprise 
level-> Setup tab-> Currency-> Currency-> Smallest Bill Amount column. A new line has 
been added to the Change Due dialog window. The "Change to dispense in bills" line will 
indicate the change in bills that should be given to the customer after the Coin Dispenser 
completes dispensing. This line will only be displayed in the Change Due dialog window 
if the option [54 - Display Change to dispense in Bills in the Change due dialog] is 
enabled from EMC-> Property level-> Setup tab-> Hardware/Interfaces-> Workstations-> 
Options tab-> Display/Security tab-> Display Options. This line will not be displayed if 
there is no change to be dispensed in bills. This feature has been implemented by 
modifying the Ops.dll, OpsUI.dll, PosCore.dll, EMC.exe, EmcText.dll, EMCData.dll, 
OpsUICommon.dll and PosManagedDevices.dll files. 
See the Coin Dispenser article (under the Simphony v2.x section) for more information. 

Support for Rounding the Change (Change Due) given to the Customer 
has been introduced 
The option [56 – Payments Need Not Be Rounded] has been renamed to [56 - Round 
Change Due] in this release, and its functionality has been enhanced to support 
rounding the change due to the customer. The option [56 - Round Change Due] can be 
accessed via EMC-> <Enterprise / Property> level-> Configuration tab-> Sales-> Tender/Media-
> Options tab-> Ops Behavior tab-> Amount Options. When enabled, the change due to the 
customer will be rounded and displayed in the Change Due dialog window. 
Additionally, it will override the behavior of option [87 - Rounded Payments and 
Change]. This option only applies to Cash Payment Tenders. 
The Context Sensitive Help (CSH) text for the option [56 - Round Change Due] reads as 
follows: 
Enable this option to allow end users to accept payments to the exact amount and to round any 
change that is due. This option is used to override the behavior of option #87 "Rounded Payments 
and Change". If option #88 "Round Payments and Change To the Nearest 0" is set, the least 
significant decimal digit will be rounded to 0 or 10. If option #88 is not set, the least significant 
decimal digit will be rounded to 0 or 5. 
This enhancement has been implemented by modifying Micros.Payment.Cash.dll, 
Micros.Payment.dll, PosCore.dll, EMC.exe, EMCText.dll and Ops.dll files. 

Clarification Messages have been added to Various Screens in Ops 
With this release, when a user navigates to Launch PMC-> Support-> Network-> Services 
in a Windows CE Workstation and presses ICMP ping, the following error message will 
be displayed: 
ICMP Ping is not available on CE 
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Additionally, in the View Service Host screen, Service Hosts with URL mismatches will 
be displayed along with the list of mismatches. 

A new option to Include Menu Item Parents in Enhanced Prefixing has 
been introduced 
A new option named [65 – Support Enhanced Prefix Mode (Parents Only)] has been 
added to the EMC-> Configurations tab-> Menu Items-> Menu Item Classes-> Options tab-> 
Options to enable Menu Item Parents in Enhanced Prefix mode. This option should be 
enabled only for non-condiment menu items. 

 
The Context Sensitive Help (CSH) for this option reads as follows: 
Enable this option for non-condiment menu items only. This option enables Enhanced Prefix 
Support for items in this menu item class. Enhanced Prefix Support is very similar to RES style 
Conversational Ordering where condiment prefix items are used to more fully  describe 
condiments "Extra" Lettuce, "No" Cheese [Simphony v2.6]. 
As a result, Revenue Center (RVC) option [61 - Enhanced Prefix Mode] is no longer 
displayed in the EMC-> RVC level-> Parameters-> RVC Parameters-> Options tab. 
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Splitting a Guest Check by Seat Number is now supported 
With this release, Simphony has been enhanced to provide Operators the ability to split a 
Check by Seat number. A Guest Check may be split for a single Seat or a group of Seats. 
A new function key, [Touch Split by Seat] has been added to the EMC-> 
<Enterprise/Property/Revenue Center>-> Configuration tab-> User Interface-> Content-> Page 
Design module. The Context Sensitive Help (CSH) text for the [Touch Split by Seat] 
function key reads as follows: 
This key is used to split checks by seat. With this function key, checks can easily be split by seat 
using the Touch Split interface. 

 
When splitting Menu Items with quantities by seat, the Operator is prompted to specify 
the count number to move for each Menu Item on the check. 
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Operators do not require special privileges to perform the [Touch Split by Seat] 
operation. 



 

Features and Updates  31 

The Ability to prompt for the Guest Count at the End of a Transaction 
has been introduced 
A new option [62 - Prompt for Number of Guests when posting the final Tender] has 
been added to the EMC-> Setup tab-> Control Parameters-> Options tab. When enabled, the 
Operator will be prompted to enter the Guest Count when posting the final tender. 
Entering the Guest Count at the end of a transaction will overwrite any prevailing Guest 
Count. The Operator can cancel the Guest Count entry only if there is a prevailing Guest 
Count. If the prevailing Guest Count is 0, it will keep prompting for entry if the Operator 
presses the Cancel button. However, the Operator can enter the Guest Count as 0 and 
tender the Check. 
The Context Sensitive Help (CSH) text for option [62 - Prompt for Number of Guests 
when posting the final Tender] reads as follows: 
If set, will prompt to enter Number of Guests when posting the final Tender which will override 
any previously entered count. If "Auto Service Charge Defaults to Off" is enabled and "# Of 
Guests Before Auto Service Charge" is set to to a value greater than 0, this will not impact the 
automatic service charge for a transaction. If not set, the prevailing Number of Guests will be used 
(if there is one). 

The Ability to start a Service Host as a Windows Service is now 
supported 
A new Service Host option named [Is Windows Service] has been added to provide the 
users the ability to start the Service Host as a Windows Service. When enabled, the 
MICROS Service Host service starts on Windows startup with other Windows Services. 
Ops will only start when the user logs in to the operation system. 
The Context Sensitive Help (CSH) text for the [Is Windows Service] option reads as 
follows: 
When this option is enabled, this service host will run as a Windows service (without GUI). This 
option should be enabled for Service Hosts running on the Windows XP or higher operating 
systems. 
This option can be enabled from two locations: 
1. EMC-> Enterprise level-> Setup tab-> Hardware/Interfaces-> Service Host. 

If the Service Host is configured as a Windows Service from this location, it is not 
necessary to change the Ports of the services being run, as the device is not intended 
to run Ops. 
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2. EMC-> Property level-> Hardware/Interfaces-> Workstations-> General tab. 

If the Service Host is configured as a Windows Service from this location, it is 
necessary to change the Ports of the services being run in addition to Ops (e.g., 
CAPS, KDS Controller, and Interface). 

 
Notes: 
• Port Numbers for services can be altered from the corresponding modules in the 

EMC. Port Numbers cannot be altered from either the Service Host module or 
Workstation module. 

• If any non-Ops service (e.g., CAPS) is required to run on the Service Host, they 
must run on a different Port than the Workstation Port. 

Support to Batch Activate Gift Cards has been introduced 
With this release, Simphony has been enhanced to provide Operators the ability to batch 
activate Gift Cards for the same denomination. This only applies to Gift Cards that have 
been configured as Non-Revenue Service Charges. To batch activate Gift Cards, the 
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option [18 - Gift Certificate Sold] must be enabled from the EMC-> Configuration tab-> 
Sales-> Service Charges-> General tab. When this option is selected, the following 
functionality is enabled: 

• The Gift Card amount will not be posted to Net Sales and will be recorded as a 
Non-Revenue Service Charge. 

• Allows the Operator to ring in Menu Items after ringing in the Non-Revenue 
Service Charge. 

MagTeK IPAD and DynaPro Card Readers/PIN-Entry Devices are now 
supported 
With this release, support for MagTeK IPAD and DynaPro card readers/PIN-entry 
devices have been added. These devices are currently only supported on Win32 
Workstation clients, not for any Workstation clients running Windows CE. A new 
Workstation option, [57 - Use PinPad as MSR reader] has been added to the EMC-> 
Property level-> Setup tab-> Hardware/Interfaces-> Workstations-> Options tab-> 
Hardware/Cash Drawer tab-> Hardware/Interface options. 
The Context Sensitive Help (CSH) text for this option reads as follows: 
This option would enable the PinPad, if connected to this Workstation, as the MSR reader for 
bank cards. 
Workstation option [57 - Use PinPad as MSR reader] and option [55- Enable the 
Encrypted MSR] in the EMC-> Property level-> Setup tab-> Hardware/Interfaces-> 
Workstations-> Options tab-> Display Security tab-> Security options, must be enabled to 
provide Transaction Shield (TVS) drivers the ability to read magnetic swipes from the 
MagTeK IPAD and DynaPro card readers/PIN-entry devices . This enhancement has 
been implemented by modifying the EMC.exe, EMCtext.dll, Ops.dll, 
PosManagedDevices.dll, and OpsUICommon.dll files 

Unavailable Menu Items Can now be hidden from Screen Look Ups 
(SLU) and Condiment Orderer Controls 
Users now have the ability to hide Menu Items flagged as Out of Menu Item or when the 
availability count of the Menu Item is zero from SLUs and Condiment Orderer controls 
(Menu Item availability is configured via Menu Item Availability PMC Procedure). The 
new option [64 - Suppress display of "Out of Item" Menu Items] has been added to the 
EMC-> Revenue Center (RVC) level-> Setup tab-> RVC Parameters-> Options tab. When 
enabled, instead of displaying the customary red X icon over the unavailable Menu Item 
button, that Menu Item will not appear on the SLU nor on the Condiment Orderer 
controls. 
The Context Sensitive Help (CSH) text for option [64 - Suppress display of "Out of Item" 
Menu Items] reads as follows: 
Enable this option to suppress the display of menu items with an availability count of zero or with 
the "Out of Item" status set to true. The availability settings can be set using the "Menu Item 
Availability" function [Simphony v 2.6 ]. 

The Repeat Round Function can now be utilized 
The Repeat Round function provides an Operator the ability to add Menu Items from the 
most recent Service Round of a Guest Check to the current round using a Repeat Round 
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key. Repeat Round is intended to be used in situations where customers may want to re-
order the same set of Menu Items for another round. 
For example: A group of 10 at the bar originally ordered 10 drinks. After consuming the 
drinks, they ordered another round of drinks. Instead of entering all 10 drinks again, the 
bartender presses the Repeat Round function key to quickly re-enter the drink order. 
Repeat Round must be the first function of a service. The use of any other function key 
prior to Repeat Round will disable the function. To use this function key, no additional 
authorizations are required — if a user can sign in and post Menu Items, the user has the 
ability to use the Repeat Round key. However, Menu Items must be specifically enabled 
to be used with the [Repeat Round] function key. To apply Repeat Round to a Menu 
Item Class, follow these steps: 
1. Navigate to EMC-> <Enterprise / Property / Revenue Center> -> Configuration tab-> Menu 

Items-> Menu Item Class-> Options tab-> Options. 
2. Enable the option [25 - Use with Repeat Round Key]. 
The Context Sensitive Help (CSH) text for the option [25 - Use with Repeat Round Key] 
reads as follows: 
Select this option if all menu items in this class may be posted again when the [Repeat Round] key 
is pressed. Disable this option if all menu items in this class are to be excluded from the repeat 
round function (e.g., food). Note that for an item to be repeatable, all of its associated condiments 
must also be repeatable. If not, the parent menu item will not repeat when the [Repeat Round] key 
is pressed. Also, note that the system will always try to repeat Definition #1 for a menu item (if 
more than one definition exists), or the first menu item available on a particular Main and Sub-
Level combination. 

 
If a Menu Item is set to check for availability, the Repeat Round function will check and 
update this status. If the availability of an item is exceeded, the entire Repeat Round is 
stopped. 
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As prices could have gone into effect since a Menu Item was last posted to the check, 
such as changing to and from Happy Hour pricing, if a price change takes effect between 
a previous round and a current round, the Menu Item Class option [26 - Keep Main 
Levels with Repeat Rounds] and/or option [27 - Keep Sub Levels with Repeat Rounds] 
in EMC-> Configuration tab-> Menu Items-> Menu Item Class-> Options tab-> Options, will 
determine whether Repeat Round uses the current or previous Menu Levels when 
applying the repeatable Menu Items. 
The following are not supported: 

• Voided and returned Menu Items will not be included in a repeat last round 
transaction. 

• The [Repeat Round] key cannot be used for Weighed Menu Items or Menu Items 
that are programmed to allow a decimal amount entry. 

• Combo Meals cannot be repeated as some Menu Items making up that Combo 
Meal might not be repeatable. 

When an Operator picks up a Check, if a Menu Item is repeatable, the Check Detail Area 
in the Workstation displays a less-than mark (<) on the line of all Menu Items that may be 
re-ordered using the [Repeat Round] key. If a Menu Item is not repeatable, an asterisk (*) 
displays on the line of the Menu Items. 

 

Support to Prompt for Guest Count on the Original Check when 
Splitting has been introduced 
Simphony now provides the ability to prompt for the Guest Count on the original check 
when performing a [Split Check] operation. A new Control Parameters option [63 - 
Prompt for Number of Guests on original check when split] has been added to the 
EMC-> <Enterprise / Property / Revenue Center> -> Setup tab-> Parameters-> Control 
Parameters-> Options tab. When enabled, the Operator is prompted to enter the number 
of guests on the original check when split regardless of whether the Guest Count of the 
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primary check was zero. Additionally, if the primary check includes a Guest Count, 
enabling this option will override the existing Guest Count in the primary check when 
the check is split. 
The Context Sensitive Help (CSH) text for option [63 - Prompt for Number of Guests on 
original check when split] reads as follows: 
Enable this option to prompt for Number of Guests on the original check when splitting a check. 

 

PMC Reports 

Support for Tip Tracking has been introduced 
In a hospitality environment, service personnel receive tips for their services. There are 
two types of tips, Direct and Indirect. Direct is a tip that is given to the service personnel 
by the guest, an example would be cash or charge. Indirect tips would be received from 
other service personnel (i.e., a server tipping a bartender for the assistance in servicing a 
guest). This indirect tip may be referred to as “tipping out”. At the end of a service 
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personnel’s scheduled shift, they will declare tips (record within Simphony). The service 
personnel will declare the amount received from their customers and tip out other 
service personnel. 
See the Tip Sharing Modifying and Monitoring article for more information. 

Blind Drop Support to Prevent the Visibility of Tender Media Details on 
Employee and Cashier Financial Reports has been introduced 
Blind Drop is a configuration that allows an Employee to run a report but prevents 
tenders from displaying on the report. This feature only applies to the Employee 
Financial Report and the Cashier Financial Report. The visibility of Tender Media details 
on the Employee and Cashier Financial Reports are controlled by two options in the 
EMC. Tender Media details will be hidden in the reports only if both these options are 
enabled. 
The Report Groups option [4 - Do Not Display for Blind Drop Reports] in the EMC-> 
<Enterprise / Zone / Property> -> Configuration tab-> Reporting and Data-> Report Groups-> 
Options tab, prevents tenders in a group from being displayed on the report. 

 
The Context Sensitive Help (CSH) text for this option reads as follows: 
This option will be used to prevent tenders in this group from showing on reports. An employee 
cannot see Blind Drop Tenders if the Employee Role option, "Do Not Show Blind Drop Tender 
Groups" is enabled. 
The option [31112 - Do Not Show Blind Drop Tender Groups] in the EMC-> Enterprise 
level-> Configuration tab-> Personnel-> Roles-> Operations tab-> Ad Hoc Reports tab-> General 
Options, must be enabled to hide Tender Media details from all Employees belonging to 
the selected Role. 

 
The CSH text for Role option [31112 - Do Not Show Blind Drop Tender Groups] reads 
as follows: 
Select this option to not allow employees associated with this Role to see detailed tender media. 
This option works with Report group Option 4 - Do Not Display for Blind Drop Reports. 
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The Employee Financial Report will display the Tender Media details as shown below 
when both options [4 - Do Not Display for Blind Drop Reports] and [31112 - Do Not 
Show Blind Drop Tender Groups] are disabled: 

 
When both the options are enabled, the Tender Media details will be hidden as shown 
below. 
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This functionality has been implemented by modifying EmpFinancial.rdl, 
EmpFinancial_2.rdl, Empfinancial_VAT.rdl, Cashier.rdl, ServingPeriodFinancial.rdl, 
TimePrdDtl.rdl, PropFinancial.rdl, ProoFinancial_VAT.rdl and RvcFinancial_VAT.rdl 
files. 

Property Management Console (PMC) Timeout introduced 
PMC Timeout has been introduced to allow the timeout of certain privileged procedures 
accessible from within the PMC. The application will now terminate and return to the 
workstation sign-in screen after the configured amount of time. 
All PMC screens, with the exception of dialogue boxes will auto log off based on the 
configured interval. If the PMC application is performing a continuous operation (e.g. 
ping test, Jobs list, etc.) and the auto-logout time expires, the system will automatically 
stop any such operation and logoff the user. 
Auto log off will not occur if a dialog box is displayed to the user while accessing any of 
the PMC features. For example, if a prompt or informative/error dialog box is displayed 
(e.g. log file is saved), the auto log off will not occur. Once the user closes the dialog box, 
the log off timer will reset and the PMC screen will auto log off after the time expires. 
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Configuring the PMC Timeout Interval 
The timeout interval can be configured using the existing setting Automatic Operator 
Popup Interval in the EMC-> Setup tab-> Parameters-> Control Parameters-> Configuration 
tab, which supports an interval of minutes and seconds. 

 
The Context Sensitive Help text for the Automatic Operator “Popup” Interval (min:sec) 
setting is as follows: 
Select the amount of time (in minutes and seconds) that a workstation should wait before signing 
out an inactive "Popup" operator (or "Staydown" operators with the Operator Module option 
enabled, "If Staydown Operator, Enable the Auto Popup Timeout"). Pop-up operators who 
complete a transaction are signed out immediately. Operators who sign in and do not begin a 
transaction, or who sign in and perform non-transaction activities (e.g., PMC Procedures) are 
automatically signed out when this interval expires. For MMHs, this interval cannot exceed 60 
minutes. The interval may be disabled for specific workstations if the workstation option "Disable 
Employee Auto Sign Out" is enabled. 
Note: Ensure that the option [21 - Disable Employee Auto Sign Out] is not enabled in 
the EMC-> Property level-> Hardware/Interfaces-> Workstations-> Options tab. 
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Data Extension Support has been added to Additional Modules in the 
EMC 
With this release, Data Extension support has been added to the following Simphony 
modules: 

• Employee module 
• Employee Class module 
• Menu Item Master module 
• Menu Item Definition module 
• Job Codes module 
• RVC Configuration module 
• Property module 
• Tender/Media module 

Extension Data can be added to the above modules via the Data Extensions module in 
the EMC-> Enterprise level-> Configuration tab-> Reporting and Data. 

PMS 

Serial Property Management System (PMS) Interface introduced 
With this release, Simphony provides the ability to connect the PMS to the Point-Of-Sale 
(POS) via a Serial Interface. To do so, the Interface Communications Type must be set to 
Serial by selecting TTY from the Communications Type drop-down menu in the EMC-> 
Enterprise level-> Setup tab-> Hardware/Interfaces-> Interfaces-> Interfaces-> General tab. 
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This will make visible the COM Communications settings in the EMC-> Enterprise level-> 
Setup tab-> Hardware/Interfaces-> Interfaces-> Interfaces-> Options tab, where Users may 
configure the Serial communication parameters. 
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Simphony now Adheres to the Canadian Europay, MasterCard and Visa 
(EMV) Receipt Printing Standards 
With this release, Simphony adheres to the Canadian Europay, MasterCard and Visa 
(EMV) Receipt Printing standards. All Receipts printed for electronic payments now 
include a footer area. The data which is printed on the footer portion varies depending 
on the card type that is used during the transaction. This enhancement was made 
possible by modifying the Micros.Payment.CaTR.xml file. 

• The Chip and Pin Credit Card transaction receipt footer will include: 
1. Credit Card Type and Masked Card number 
2. Card entry method and Sequence number 
3. Transaction Type and Grand Total 
4. Terminal number 
5. Application Label 
6. AID number 
7. TVR number 
8. TSI number 
9. Authorization number and approval status of the transaction 
10. Chip & Pin legal agreement 

• The Tap Credit Card transaction and the Swiped Credit Card transaction receipt 
footer will include: 

1. Credit Card Type and Masked Card number 
2. Card entry method and Sequence number 
3. Transaction Type and Grand Total 



 

Features and Updates 44 

4. Terminal number 
5. Authorization number and approval status of the transaction 

• The Debit Card transaction receipt footer will include: 
1. Debit Card Type and Masked Card number 
2. Account Type 
3. Card entry method and Sequence number 
4. Transaction Type and Grand Total 
5. Merchant number 
6. Terminal number 
7. Reference number 
8. Trace number 
9. Authorization number and approval status of the transaction 

• The E-Payment Refund printed footer will include: 
1. Card Type and Masked Card number 
2. Account Type 
3. Card entry method and Sequence number 
4. Transaction Type and Grand Total 
5. Merchant number 
6. Terminal number 
7. Reference number 
8. Trace number 
9. Authorization number and approval status of the transaction 
10. Guest and merchant signature and legal agreement for refund reason 

Printing 

Support for Banquet Guest Check Printing has been introduced 
The Banquet Guest Check is used to present a specially formatted Guest Check to the 
guest. Even though it can be used anywhere, the Banquet Guest Check is intended for 
use in a Banquet environment. In this environment, there are additional components of 
information that are reflected in the Guest Check (i.e., event name, address and contact 
information, name of the function room the event was held, name of the maitre’d and 
catering sales manager, serving period, etc.). 
See the Banquet Guest Check Printing article for more information. 

SIM 

System Interface Module (SIM) now supports the Minus Binary Operator 
With this release, SIM has been enhanced to support the minus binary operator. 
Previously, when the minus operator (-) was used to modify a variable’s value when 
being evaluated, an exception error was thrown unless the minus operator was preceded 
and followed by a space. This enhancement has been implemented by modifying the 
PosCore.dll file. 
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Stored Value Card 

iCare Transactions with Null Print Tokens are now Excluded from 
Printing 
Simphony has been enhanced to exclude null print tokens when printing iCare 
transactions. Previously, when printing iCare transactions, if a print token had no value 
(null), the word “null” was printed on Guest Checks, Customer Receipts, etc. making it 
visible to the customer. This enhancement has been implemented by modifying the 
Stored Value Card module. 

iCare option [User Generic Point Issue Msg] is now supported by 
Simphony 
Simphony has been enhanced to support the iCare option [User Generic Point Issue 
Msg]. Now when the option [User Generic Point Issue Msg] is enabled in iCare, once a 
Loyalty Point Issue transaction has been completed, the generic message “Transaction 
Complete” will be displayed to the Operator instead of displaying details of the Loyalty 
Point Issue transaction. However, if Simphony is configured not to display any messages, 
no messages will be displayed even when the iCare option [Use Generic Point Issue 
Msg] is enabled. This enhancement has been implemented by modifying the Stored 
Value Card module. 

Support for Exposing Totals Recalculation to Extensibility has been 
introduced 
The method OpsContext.CalculateTotals() has been exposed to extensibility code. Calling 
this will result in immediate update of all associated check totals, so that they are 
available to subsequent extensibility calls. 

System 

Support for Clearing Totals has been introduced 
A Clear Totals mechanism has been added to the EMC to allow privileged users to purge 
unwanted transaction totals accumulated during testing and training periods prior to 
going “live”. Users can enter a prior Business Date of their choice (including the Current 
Business Date) to purge the totals data created on and prior to that date. The Clear Totals 
operation is available to run on the Property level. When initiated, the Clear Totals task 
will immediately purge the totals for all of the designated Property’s Revenue Center’s 
(RVC) from the Enterprise. Individual RVCs cannot be selected to have their totals 
cleared. 
When executed, the Clear Totals task will perform the following steps: 

1. Immediately purge the designated Property’s Transaction totals and Check 
related data on and prior to the desired Business Date from the Enterprise. 

2. Initiate a request to run a Purge Job for the Reporting database (mymicros.net) 
totals.  

3. Purge the MRequest Queues data. 
4. It will purge the Check and Posting (CAPS) totals - on a delayed basis. 
5. It will purge all of the Property’s Workstations DataStore data - on a delayed 

basis. 
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6. Purge the Journal log file data. 
7. Purge Cash Management data (if enabled). 

Additional Important Information 
• Each Clear Totals task is logged within the Audit Trail module. 
• EGateway log files will display the date and time a 'Clear Totals' operation was 

performed. 
• All cleared database tables will be truncated for both Microsoft SQL Server® and 

Oracle® database platforms. 
• Time Zone synchronization between the Simphony Application server and 

Workstations is important for Clear Totals to work correctly. CAL has the task of 
keeping the time settings on Workstation clients in sync with the Simphony 
Application server. However, some devices (e.g., iPad client) do not use CAL to 
be configured. An iPad's time settings can be set manually or allowed to sync to 
an internet time server. This means that the time settings on devices that don't 
utilize CAL could possibly become out of sync with the Simphony Application 
server. Therefore, prior to running the Clear Totals task, users should ensure that 
the time settings on non-CAL’d devices are set to match the Simphony 
Application server's time settings as closely as possible. 

Warning: Before clearing totals, all Credit Card (CC) transactions dated prior to the 
selected Business Date must have already been Batched and Settled. If there are any 
unbatched CC transactions, users will receive a message and will not be allowed to clear 
totals. Click OK to exit and resolve the outstanding CC Batch and Settlement tasks before 
attempting to clear totals again. It is recommended that after all of the CC’s have been 
Batched and Settled, that users generate and save all CC related reports from either the 
EMC or mymicros.net for historical reference. 
See the Clear Totals article for more information. 

TMS 

Support for Table Management System (TMS) Reporting has been 
introduced 
Table Request reporting data from Simphony TMS is now transmitted to mymicros.net 
for authorized users to view. Six table management reports are now available in 
mymicros.net. These reports enable users to identify, track, and monitor a table seating 
request from inception through seating to checkout. 
See the TMS Reports page for more information. 

Support for the Table Management System (TMS) Module has been 
introduced 
With this release, Simphony now includes the ability to define a host command area and 
enhanced dining tables on a page in EMC, as well as configure service and check alerts, 
section layout templates, Table Management System operating (TMS) parameters, 
reservation periods, and numerous other options in EMC. In Ops, users can create, load, 
activate and close section layouts, show or hide various function dialogues from the host 
area, view table status details and run the Employee Section Assignment Report. 
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See the TMS page, Simphony Table Management Configuration Guide and the Simphony Table 
Management User Guide for more information. 

Support for Reservations Module has been introduced 
With this release, Simphony now includes the ability to define availability for reservation 
requests and create a Reservation List on a page in EMC, as well as add, edit, and cancel 
table reservations in Ops. When adding a reservation in Ops, users can select a date and 
time from the calendar, look up a patron’s loyalty account and associate it with the 
reservation, select cover count and table preferences and enter special requests and other 
patron information. Each reservation request is associated with a confirmation number. 
See the TMS page, Simphony Reservations Configuration Guide and the Simphony 
Reservations User Guide for more information. 

Support for Wait List Module has been introduced 
With this release, Simphony now includes the ability to create a Wait List on a page in 
EMC, and add, edit, greet, seat, or cancel parties waiting to be seated (either walk-in or 
reservations) in Ops. When adding a request to the wait list in Ops, users can look up a 
patron’s loyalty account and associate it with the wait request, enter cover count, special 
requests, and other patron information, select the wait quote time, and request a specific 
table. 
See the TMS page, Simphony Wait List Configuration Guide and the Simphony Wait List User 
Guide for more information. 
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2  Installation and Upgrade 
Simphony 2.6 

Important Information for Microsoft SQL Server® Customers 
Follow these additional instructions to upgrade to Simphony v2.6: 
The Simphony installation application upgrades the mymicros.net components of the 
system to the latest version of mymicros.net. Part of the upgrade process involves 
performing a database upgrade which includes the expansion of several columns to 
hold more significant digits. Testing the installation process in Microsoft SQL Server 
based lab environments has shown that the column expansion process causes the 
upgrade process to take longer than is typically expected. The amount of time the 
database upgrade takes will vary greatly by individual customer based upon the 
number of rows in the LOCATION_ACTIVITY_DB.guest_check_line_item and 
LOCATION_ACTIVITY_DB.guest_check_line_item_hist tables. 
 

To ensure that the upgrade process is consistent for all Microsoft SQL Server 
customers, the steps below must be performed prior to running the Simphony v2.6 
installation application. 
 

1. Stop the following Windows Services on all of the Simphony application 
servers: 

• Admin Server 
• Aggregation and Adjustment Service  
• MICROS Data Transfer Service MICROS  
• Direct Posting Service  
• MICROS EMS Batch Service  
• MICROS Portal 
• MICROS Portal Info Delivery 
• MICROS Simphony Mobile Aggregation 

 

2. Upgrade the mymicros.net databases using the utility located on the 
Simphony v2.6 installation media here: 

 

<Drive>:\Install\DbFiles\DbInstall.exe 
 

Once the database upgrade is completed, use the Simphony v2.6 installation 
application to upgrade the application server(s) and follow the standard steps to 
complete the upgrade. 
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3  Resolved Issues 
This section describes issues that have been corrected. A revision is a correction made to 
an existing form, feature, or function, using the following criteria: 

• The item must be part of the previous version. 
• The change must replace the current item or remove it from the application. 

Simphony 2.6 MR 1 
Table 1 – Simphony 2.6 MR1 Resolved Issues 

Module CRID TPID Description 

CAPS  N/A 62356 Issue: KDS Bump event caused an exception in the 
CAPS logs 
Resolution: When an order was bumped from the 
KDS, an "Invalid column name" exception was 
recorded in the CAPS log. This has been corrected. 

Data Transfer 
Service 

32044 8378 Issue: The Refresh Definitions button did not set the 
MOVEFLAG to 0 in the menu_item_definition table 
Resolution: After creating a Menu Item with 
definitions and prices at the Enterprise level, pressing 
the Refresh Definitions button (located in EMC-> 
Property level-> Setup tab-> Property Configuration 
section-> mymicros.net Config) did not update the 
MOVEFLAG column from 1 to 0 (zero) in the 
menu_item_definition table. This has been corrected. 
Now all definitions will be sent at the Enterprise, 
Property, and Revenue Center levels as the Menu Item 
information can be declared at the Enterprise and 
inherited down to the Property and Revenue Center. 
 

Direct Posting 
Service 

N/A 56323 Issue: An Autofire check remained outstanding after 
being closed 
Resolution: Previously, when an Autofire check was 
fired and closed after the start of the next business 
day, the check was closed, but the total and count for 
the check remained as a carried over and outstanding 
amount in the mymicros.net Employee Financial 
Report. This has been corrected. 
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Module CRID TPID Description 
Direct Posting 
Service 

 57348 Issue: Error generated in DPS log when an enhanced 
table had an open check without employee 
assignment 
Resolution: Previously, when an enhanced table 
without an assigned employee had an open check, the 
following error was displayed in the DPS log. 
Object reference not set to an instance 
of an object 

This did not affect posting of sales data, but affected 
Table Management System (TMS) related reporting 
data. This has been corrected. 

EMC 35121 54399 Issue: Zero and negative transactions increased 
amount for Checks/Avg Spend and Table Turns/Avg 
Spend in mymicros.net report 
Resolution: Previously, when a check was opened 
with either a zero or negative amount, the amount 
increased for Service Performance Summary (Checks 
/Avg Spend and Table Turns/Avg Spend) under 
Operating Metrics in the mymicros.net Today’s 
Operations Report. This has been corrected. When the 
option [5 – Zero or Negative Transactions Do Not 
Add to Guest or Guest Check Counts] is enabled in 
EMC-> Revenue Center level-> Setup tab-> RVC 
Parameters-> Posting tab, a zero or negative amount 
check will not increase the Service Performance 
Summary amounts in the mymicros.net Today’s 
Operations Report 

Install  62951 Issue: Hotfix patch generated incorrect setup.dat file 
for Win32 Workstations for KDS Controller patches 
Resolution: The Simphony 2.6 and higher hotfix 
patches generated the wrong set of setup.dat for 
Win32 workstations and for KDS Controller patches, 
which prevented the Win32 KDS Controller update 
from deploying. This has been corrected. The proper 
setup.dat is created in EMC for the hotfixes, and the 
hotfix KDS Controller is deployed to Win32. 

KDS  36481 Issue: Backup KDS Controller icons did not display 
correctly 
Resolution: Previously, when the Backup KDS 
Controller was active and the Backup KDS Controller 
ServiceHost went down, the KDS display did not 
show the appropriate status icon. This has been 
corrected. 
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Module CRID TPID Description 
KDS  47762 Issue: KDS void items displayed as separate chits in 

non-Dynamic Order Mode (DOM) 
Resolution: Previously using non-DOM, after a Menu 
Item (e.g., wings) was ordered and sent to the KDS, if 
the check was picked up and modified (e.g., blue 
cheese condiment added), then the KDS re-displayed 
the original chit with the item voided, and a third chit 
displayed with the item and condiment. Now two 
chits are printed: the original chit from the first round, 
and a new chit from the second round that shows the 
voided item(s) and the new items with condiment that 
were added in the second round. 
Note: The option [2 - Display Next Course after 
Previous Course Complete] must be disabled in 
EMC-> Property level-> Setup tab-> KDS Controllers-> 
General tab. 

KDS  56810 Issue: When a Backup KDS Controller was enabled 
and a property was upgraded, orders no longer went 
to the KDS display 
Resolution: Previously, when a Backup KDS 
Controller was enabled and a property was upgraded, 
orders no longer displayed on the KDS. This has been 
corrected. 
Note: After an upgrade, if option [9 - Enable Backup 
Controller Automatic Takeover] is checked (in EMC-> 
Property level-> Setup tab-> KDS Controllers-> General 
tab), the Backup KDS Controller may become the 
active controller regardless of the previous conditions. 
The Restore Primary KDS function key must be used 
on any workstation in order for the Primary KDS 
Controller to take over. 

KDS  63191 Issue: KDS was not updated with seat information 
changes in current round 
Resolution: With Fire on Next enabled in Dynamic 
Order Mode, when either the 'Touch Edit Seat' 
function or the 'Edit Seat' function was used in Ops to 
put Menu Items on a different seat, the KDS was not 
updated with the last item ordered. This has been 
corrected. 
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Module CRID TPID Description 
Ops  41133 Issue: Status bar element "Enterprise Connection 

Status" did not refresh properly 
Resolution: Previously, the status bar element 
"Enterprise Connection Status" did not refresh until 
Service Host was restarted. This has been corrected. 
"Enterprise Connection Status" in the status bar will 
now detect an unplugged network cable within a 
minute and change without user interaction. It will 
also detect Online when the network cable is plugged 
in to the workstation. In addition, "Enterprise 
Connection Status" will change after a Service Total or 
anytime the Data Store is accessed such that it 
refreshes its Enterprise Online status. 

Ops 34868 44792 Issue: Invalid journal entry logged when guest count 
was changed to a number that equaled an employee 
Resolution: Previously, if the guest count was 
modified to a number that equaled an employee ID 
value in Simphony, an invalid EnterGuestCount 
journal entry was generated regardless of the 
operator’s role privilege for option [33 – 
Authorize/Perform Change Number of Guests] 
(located in EMC-> Enterprise level-> Configuration tab-> 
Roles-> Operations tab-> Transactions sub-tab-> 
Transaction Control Options section). This caused 
issues when, for example, the Guest Count was 
updated to 3 guests and there was also an employee 
with an ID of 3. This has been corrected. 

Ops  46782 Issue: Condiment Orderer did not refresh within 
Combo Meal 
Resolution: Previously, when a condiment was added 
to a Menu Item within a Combo Meal, Ops did not 
refresh the page to show the indent of the button 
unless tabbing was used. This has been corrected. 
Now, when a condiment is added to a parent item or 
child item  of a combo meal, the buttons are updated 

Ops  56587 Issue: An extra space was added at the top of the 
receipt for Credit Card payments 
Resolution: Previously, an extra space was added at 
the top of the receipt when a check was paid with a 
Credit Card and a Sales Recording Module (SRM) 
device was configured. This has been corrected. 
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Module CRID TPID Description 
Ops 35205 58194 Issue: Service Host stopped on PAR Technology 

Workstation when OPOS MSR was used 
Resolution: Previously, when a card was swiped 
using the OPOS MSR on a PAR Technology 
Workstation, Service Host stopped unexpectedly. This 
has been corrected. 

Ops 35206 58196 Issue: Service Host stopped on PAR Technology 
Workstation when OPOS Cash Drawer was used 
Resolution: Previously, when the OPOS Cash Drawer 
was opened on a PAR Technology Workstation, 
Service Host stopped unexpectedly. This has been 
corrected. 

Ops  60736 Issue: Split Check of a table check did not show the 
table number in SLU for another workstation, and the 
second check was not shown in the table check list 
Resolution: When a new check was created from a 
Split Check of a table check and then the original 
check was picked up from the list on another 
workstation, the SLU did not show the table number. 
In addition, the second check was not shown in the 
table check list. This has been corrected. Now, when 
picking up a check from a list on another workstation, 
all checks show in the list along with their table 
numbers. 

Ops  63307 Issue: Pop Up Operator were signed out when partial 
tender were selected 
Resolution: Previously, when performing a partial 
tender, an operator was logged out of the transaction 
and was unable to continue. This has been corrected. 

Ops  63782 Issue: Void chit printed for Menu Item with 'Tax 
Exempt Item All' function 
Resolution: Previously, after tax exempt items were 
rung in and a check was service totaled, picked up 
and tendered, upon highlighting an item and selecting 
the 'Tax Exempt Item All' function, a Void chit was 
printed for the exemption item selected. This has been 
corrected. Now, a Void chit no longer prints for an 
item with exemption of taxes. 
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Module CRID TPID Description 
Ops  64802 Issue: KDS Seats/Trays did not display Menu Item 

information correctly in DOM 
Resolution: Previously, the KDS did not display 
changes for current and previous rounds in Dynamic 
Order Mode (DOM) once the 'Edit Seat' function was 
completed. 

• The Chit Layout option [320 – Chit-Std-
DOM2 w/Seat] was selected in EMC-> 
Property level-> Setup tab-> KDS Displays-> 
Display tab-> Chit Display Options section. 

• The Order Device option [7 – Sort by Seat] 
was enabled in EMC-> Revenue Center level-> 
Setup tab-> Order Devices-> Options tab-> KDS 
Options section. 

After using the 'Edit Seat' function, the KDS did not 
display results of the 'Edit Seat' function and 
continued to display as if the Seat(s) had not changed. 
This has been corrected. 

Ops  65872 Issue: A Button error was generated from PMC 
Support options 
Resolution: When clicking certain functions (Home, 
End, Pg Up, Pg Down, Line Up, Line Down) from 
within the PMC Support module, a "Button:Method 
'...' not found" error displayed. This has been 
corrected. These options now perform the appropriate 
functions without error. 

Ops  66043 Issue: Progress bar no longer showed on Start up 
Resolution: Previously, the progress bar did not show 
after starting Service Host. This has been corrected. 
The "Starting Simphony Client" progress bar now 
displays correctly after the Service Host is launched. 

Ops  66237 Issue: Text did not change on condiment order item 
buttons when changing condiment groups 
Resolution: Previously, the text did not change on 
condiment order item buttons when switching 
between condiment groups. This has been corrected 
and the buttons now display correctly. 
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Module CRID TPID Description 
Ops  66238 Issue: Ops stopped unexpectedly when attempting to 

order a Menu Item with required condiments 
Resolution: Previously, when trying to order a Menu 
Item with required condiments, Ops stopped and the 
following exception error occurred:  
Specified argument was out of the range of 
valid values 

This has been corrected. 
Ops 35453 68194 Issue: Menu Items could not be ordered after 

switching Menu Levels 
Resolution: Previously, after ringing in a Menu Item, 
if the Main Level or Sub Level was changed (in EMC-> 
<Enterprise / Zone / Property / Revenue Center>-> 
Configuration tab-> Menu Item Maintenance), Ops 
displayed the correct Menu Item Definitions. 
However, when ringing in a Menu Item that was only 
defined on the new Menu Level, the Menu Item was 
not ordered and the following error displayed in Ops: 
Entry not active on current levels 

This has been corrected. Switching Menu Levels 
between ordering now allows Menu Items from 
different levels to be added to the check. 

Reports  64008 Issue: Offline Revenue Center Financial Report 
displayed XSLT Transformation Error 
Resolution: Previously, when running the Offline 
Revenue Center Financial Report in Ops, an XSLT 
Transformation Error displayed in the print tab. 
This has been corrected. Now the report displays the 
results in the print tab. 
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Module CRID TPID Description 
Reports  65078 Issue: Shifts incremented incorrectly 

Resolution: Previously, shift numbers were not 
distributed correctly to the workstations when the 
option [30011 – Increment Employee Shift when 
Clocking Out] was enabled (in EMC-> Enterprise level-
> Configuration tab-> Roles-> Operations tab-> PMC 
General/Reports sub-tab-> Shift Incrementing Options 
section) and option [56 – Increment Employee Shift 
when Clocking Out] was enabled (in EMC-> 
<Enterprise / Zone / Property / Revenue Center>-> Setup 
tab-> Control Parameters-> Options tab). When an 
employee worked two shifts, the Employee Financial 
Report run from CAPS displayed the shift numbers 
incorrectly. This has been corrected. Shift numbers are 
obtained from CAPS asynchronously before posting. 

Reports 35331 65085 Issue: Employee Financial Report displayed Shift 0 
with Shift Tracking enabled and shift not incremented 
Resolution: Previously, when option [49 – Enable 
Shift Tracking] was turned on (EMC-> <Enterprise / 
Zone / Property / Revenue Center>-> Setup tab-> Control 
Parameters-> Options tab), and the Employee Financial 
Report with sales was run without incrementing the 
shift for an employee, the report displayed a "Shift 0" 
with zero Net Sales. Now the first shift of an employee 
defaults to Shift 1 before the shift is incremented. 
When sales are generated for the first time with an 
employee, his/her shift displays Shift 1 with Net Sales. 

TMS 35338 63778 Issue: Service Alerts did not update upon successive 
service interactions 
Resolution: Previously, after initial menu items were 
added to a check, the Service Alerts did not update 
after the check was picked up, items were added, and 
the check was service totaled. This has been corrected. 

Reports  64860 Issue: Buttons on the Wait Quote screen were not 
localized 
Resolution: Previously, after selecting the Wait Quote 
screen from the Wait List, the OK and Cancel buttons 
were not localized in the appropriate language. This 
has been corrected. 
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Module CRID TPID Description 
Reports  64862 Issue: Last Name field on Add Reservation Entry 

screen was not localized 
Resolution: Previously, the Last Name field on the 
Add Reservation Entry screen was not localized in the 
appropriate language. This has been corrected. 

Totals Posting  62950 Issue: Reprint Check functions re-flagged previously 
batched credit cards to be batched again 
Resolution: Previously, when a check was closed to a 
credit card tender and batched, if the check was 
reprinted with any of the Reprint Check functions, the 
outstanding credit card status was turned on and the 
next batch process included the check again. This 
caused the credit card to be charged twice when both 
batches were settled. This issue has been corrected. 
The following functions can no longer be used when a 
check has been included in a credit card batch: 

• Print Customer Receipt  
• Reprint Closed Check 
• Reprint Previous Closed Check 

Each attempt to use any of these functions produces 
the error "No receipt to print" or "Check is 
already batched". 
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Simphony 2.6  
Table 2 – Simphony 2.6 Resolved Issues 

Module CRID TPID Description 
CAL N/A 38374 Issue: A Property was not displayed in the CAL 

Property list if the primary language of the Property was 
not English 
Resolution: a Property’s primary language set in the 
EMC-> Property level-> Setup tab-> Parameters-> Property 
Parameters-> General-> Language was not English (the 
Enterprise default Language), that Property was not 
displayed in the CAL Property list. It was determined 
that entering the translation text of the Property name in 
the Enterprise default Language resolved this issue. This 
can be done by highlighting the name of the Property in 
the EMC-> Enterprise level-> Setup tab-> Enterprise 
Configuration-> Properties-> Name field, and pressing the 
F8 key on the keyboard. The Text Translation dialog 
window will be displayed with the list of defined 
languages and a space to enter the Property name 
translation. Enter the English text for the Property name 
in the English (United States) text field. Similarly, this 
should be done for each Workstation, KDS Display and 
Revenue Center. 

Credit Card 
Batch Process 

35062 4035 Issue: The Credit Card Batch Detail Report in 
mymicros.net displayed the incorrect Batch Number 
Resolution: Previously, the Batch field in the 
mymicros.net Credit Card Batch Detail Report showed 
the BatchHeaderID instead of the Batch 
Number. As a result it did not correspond with the 
Batch Number in the Payment Driver module. This has 
been corrected by adding a new column named 
BatchNumber to the CCBATCH_DETAIL table in the 
Transaction database. Additionally, the Data Transfer 
Service (DTS) has been modified to transfer the new 
Batch Number field instead of the BatchHeaderID to the 
Reporting database. This change allows the 
mymicros.net Credit Card Batch Detail Report to display 
the correct Batch Number. 
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Module CRID TPID Description 
Database 31607 3631 Issue: Playback Control queries were running too often 

causing excessive database overhead 31607 
Resolution: Previously, unnecessary Playback Control 
queries seemed to be running much too frequently, 
causing excessive database overhead. This has been 
corrected by modifying the TotalPosting.dll file. 
Currently, the Playback control queries in question 
(shown below) have been disabled. 
 
SELECT COUNT(*) FROM PLAYBACK_CONFIG WHERE 
HierStrucID = @IdValue AND ForceOffline = 
1 AND PreventOfflineReplay = 1 
 
SELECT COUNT(*) FROM PLAYBACK_CONFIG WHERE 
HierStrucID = @IdValue AND ForceOffline = 
1 AND PreventOfflineReplay = 1 AND 
(ScheduledStartTime > @limit OR 
ScheduledStartTime IS NULL) 

Database 32392 10655 Issue: mymicros.net Journal Reports that referenced the 
final image of a check failed to generate in an Oracle 
environment 
Resolution: Previously, in an Oracle® environment, 
although the option [23 - Save the Final Check Image] 
was enabled from the EMC-> Property level-> Setup tab-> 
Report Parameters-> Options tab, mymicros.net Journal 
Reports that referenced the final image of a check failed 
to generate. It was determined that this occurred due to 
negative values being inserted to the Type column in 
the POS_JOURNAL_LOG table. This has been corrected 
by modifying the SimphonyDataStore.dll and 
TotalPosting.dll files. 

Database 32399 10689 Issue: All Journal types were not getting posted to the 
POS_JOURNAL_LOG table 
Resolution: Previously, all of the Journal Types were 
not getting posted in the ‘Type’ column of the 
POS_JOURNAL_LOG table. It was thought that all 
Journal Types were required to post data in order to 
generate both PMC and mymicros Journal reports. With 
this release, this reported issue was not reproducible. 
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Module CRID TPID Description 
Database 32060 14091 Issue: There was inconsistency between column sizes in 

the Transactional database Authorization_Log .Context 
column (supported nvarchar(50)) and the Reporting 
database 
LOCATION_ACTIVITY_DB.POS_AUTH_LOG. 
CONTEXTTEXT column (supported only nvarchar(32)) 
Resolution: Previously, due to the variance of these two 
tables column sizes, users were receiving the following 
message in the Reporting database log files (Oracle®) 
database platform): 
ERROR MESSAGE: ORA-12899: value too large for column 

"LOCATION_ACTIVITY_DB"."POS_AUTH_LOG"."CONTEXTTE
XT" (actual: 33 maximum: 32), 

This has been corrected by modifying the mymicros.net 
(Reporting) database schema and will be effective with 
the release of mymicros.net v7.2.0. or higher. 

Database 33676 22823 Issue: Workstation system date change caused posting 
issues 
Resolution: Previously, if a Workstation’s Business Date 
was changed to a future date that was out of the 
ordinary (e.g. year 4002), the Direct Posting Service 
(DPS) threw a smalldatetime error and stopped posting. 
Additionally, when the DPS halted the posting for this 
Workstation, the associated MREQUESTS halted posting 
for the entire site. It was determined that this issue 
occurred because the 
Workstation could create a Check with an invalid date 
that the Direct Posting Service could not transfer to 
mymicros. This has been corrected by modifying the 
Ops.dll, PosCore.dll and SimphonyDataStore.dll files. 
Currently, the Workstation compares its local date/time 
with the server date/time before allowing a Check to be 
rung. If a Workstation has an invalid date, the following 
error message will be displayed. 
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Module CRID TPID Description 
Database 33872 25196 Issue: EMC failed to connect to the database when the 

Microsoft SQL Server Analysis Service was running 
Resolution: Previously, if EMC was installed on a 
machine running the Microsoft SQL Server Analysis 
Service, the application failed as it was unable to connect 
to the Transaction database and caused multiple issues. 
However, if the Microsoft SQL Server Analysis Service 
was stopped, EMC would launch successfully. This 
issue was not reproducible in the current release. 

Database 34006 26995 Issue: Intermittently, there was an issue with Cash 
Management (CM) Lite transactions not posting to the 
Enterprise 
Resolution: Previously, there was an intermittent issue 
with CM Lite transactions not posting to the Enterprise. 
When the client started, there was an error connecting 
with the CM database. This has been corrected by 
modifying the CashManagementHandler.dll, 
EgatewayDB.dll, EgatewayDBWS.dll, 
SimphonyDataStore.dll, and SimphonyDataStoreWS.dll 
files. Currently, the ServiceHost will try to connect to the 
CM database, CheckPosting database and KdsDataStore 
database ten times before generating the reported error. 

Data Transfer 
Service 

32338 10402 Issue: The Data Transfer Service (DTS) log contained an 
error when a Family Group or Major Group name with 
more than 40 characters was configured. 
Resolution: The DTS log contained the following error, 
when a Family Group or Major Group name with more 
than 40 characters was configured. 
30,UpdateMenuItem: exception: String or binary data 
would be truncated. 
The familyGroupNameMaster and 
majorGroupNameMaster columns in the MENU_ITEM 
table in the Reporting database had a limit 
of 40 characters. This issue has been corrected by 
modifying the DataTransferService.exe file. Currently, 
Family Group and Major Group names that are longer 
than 40 characters are truncated when the DTS posts the 
definitions to mymicros. 
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Module CRID TPID Description 
Data Transfer 
Service 

32544 11580 Issue: mymicros.net Sales Mix reports were not 
displaying a Menu Item’s Menu Level name under the 
Level Name column for items that had multiple Price 
records assigned 
Resolution: Previously, when a Menu Item (MI) had 
multiple Price records assigned, regardless of the setting 
of the EMC-> Menu Items-> Menu Item Classes-> Options 
tab-> [10 – ON = Use Sub Level Pricing; OFF = Use 
Main Level Pricing] option, the Level Name for those 
records weren't displayed on reports correctly. Instead, 
Not Defined was displayed under the reports Level 
Name column. This has been corrected by modifying the 
DataTransferService.exe and DirectPostingService.exe. 
Note: If a Menu Item’s Price record is not associated 
with a specific Menu Level and is set to [0 – All Levels], 
the Price Level name will be transferred to mymicros.net 
as a NULL value and the Level Name will display as 
Not Defined on mymicros.net Sales Mix reports. 

Data Transfer 
Service 

33107 16436 Issue: When myinventory was enabled, Simphony 
overwrote the Prep Cost values in myinventory which 
resulted in inaccurately calculating the Cost of Goods 
Sold totals 
Resolution: Previously, when myinventory was 
enabled, the Transactional database Prep Cost values 
were overwriting the myinventory Prep Cost values. 
Therefore, the Cost of Goods Sold totals for the Daily 
Operations Report and the Cost values on the Menu 
Engineering Report were inaccurate. This has been 
corrected by modifying the EMC.exe, 
DirectPostingService.exe and 
DataTransferService.exe files. This fix was applied to 
both Microsoft SQL Server® and Oracle® database 
platforms. Currently, if myinventory is enabled, users 
cannot edit the Prep Cost at the Property and Revenue 
Center as the Prep Cost field will be disabled if my 
inventory is enabled for the corresponding location. 
Users will still be able to edit the Prep Cost at the 
Enterprise and Zone, however, these changes will not be 
moved to mymicros.net if myinventory is enabled. 
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Module CRID TPID Description 
Data Transfer 
Service 

33178 18851 Issue: The MyLaborDefs job failed and the Data 
Transfer Service (DTS) threw an object reference error 
Resolution: Previously, the DTS threw an 
43,MyLaborDefs: Failure syncing to myLabor: Object 
reference not set to an instance of an object. error in the 
log when a Revenue Center (RVC) linked to a Job 
Definition was changed and the MyLaborDefs job could 
not find an operator record for the RVC that the 
Employee Job Code was previously linked to. This 
caused the MyLaborDefs job to terminate and changes 
were not committed until the offending Employee's 
operator record was manually inserted via EMC-> 
<Enterprise / Property / Revenue Center> -> Configuration 
tab-> Personnel-> Employee Maintenance. This has been 
corrected and was not reproducible in the current 
release. 

Data Transfer 
Service 

33629 22511 Issue: Data Transfer Service (DTS) threw an error in the 
log if Major Group Master or Family Group Master ID 
was larger than 2,147,483,647 
Resolution: Previously, in an Oracle environment, if the 
Major Group Master or Family Group Master ID was 
larger than 2,147,483,647, after creating or updating the 
Menu Items belonging to that Major Group or Family 
Group, the DTS threw an error in the log. However, if 
myinventory was enabled, this error did not occur. It 
was determined that this error was caused by the special 
functions which were introduced in Simphony v2 for 
reading Major Group and Family Group Masters. As 
these functions were not configured to handle values 
greater than 32-bit integers, this caused an error in the 
Oracle environment. This has been corrected by 
modifying the DTS module. 
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Module CRID TPID Description 
Data Transfer 
Service 

N/A 29322 Issue: A Data Transfer Service (DTS) error message 
related to mylabor was not clear 
Resolution: Duplicate Payroll ID values can exist if 
Employee records are added through the EMC before 
mylabor is enabled, or if mylabor is temporarily 
disabled to add Employee records via the EMC. 
Previously, the error message that displayed in the DTS 
log did not provide adequate information regarding the 
error and how it could be fixed. This has been corrected 
by modifying the error message to provide sufficient 
information, such as the duplicate Payroll IDs, so that 
the user can find the duplicate entries and correct them. 
The following is an example of the error message: 
MyLaborDefs: Two or more employees with same 
PayrollID <payrollid> found Please fix the PayrollID 
for those employee using EMC. 
Note: mylabor must be disabled in the EMC before 
correcting the duplicate entries. 

Data Transfer 
Service 

33359 37130 Issue: If the price of Menu Items were overridden at a 
lower level, the Data Transfer Service (DTS) threw an 
exception error in the log 
Resolution: Previously, if the price of a Menu Item was 
overridden at the Zone, Property, or Revenue Center 
level, the DTS threw an exception error in the log when 
posting to mymicros.net. This has been corrected by 
modifying the DTS module. Currently, instead of 
throwing an exception, the message 
DTS_MIPRICE_MAPPING was remapped for 
MMMenuItemPrice" with the Menu Item price details is 
posted to the DTS log. 
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Module CRID TPID Description 
EMC 30619 4543 Issue: Menu Items are not displayed in Revenue Centers 

(RVCs) when they're configured in a Zone that only 
contains RVCs 30619  
Resolution: This reported issue is behaving as designed. 
A Property can belong to Zones and can have Menu 
Item Master records defined at the 
Zone level or have their Menu Item Master records 
overridden. In that case, the Revenue Center will pick 
the correct Menu Item Master as defined by the Property 
or Property/Zone combination. 
In short, if a Zone is absent a Property definition, then 
all of the Menu Item Master records defined in that Zone 
are in a state where they will not be reflected in any 
Revenue Center Configuration and never appear on any 
client in the system. This is by design. 
Adding Menu Item Masters to a Revenue Center-only 
Zone will not be allowed. 

EMC 31570 4545 Issue: An error occurred when attempting to Distribute 
or Delete a Property 
Resolution: Previously, if an attempt was made to 
Distribute a Property via the EMC-> Enterprise level-> 
Setup tab-> Enterprise Configuration-> Properties by 
clicking the Distribute icon, the following error message 
was displayed: 
Error: Order Type Parameters Object reference not set 
to an instance of an object. 
Similarly, any attempt to Delete a Property by clicking 
the Delete icon returned the following error: 
Error: SendSyncRequest ERC_COMM_ERROR 
If a second attempt was made to Delete a Property, the 
following error occurred: 
Error: EMCHandler failed: The DELETE statement 
conflicted with the REFERENCE constraint 
"FK_CNTNTDTA_HIERSTRUCID". The conflict 
occurred in database "MCRSPOS",table 
"microsdb.CONTENT_DATA", column 'HierStrucID' 
This has been corrected by modifying the EMCData.dll 
file. 
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Module CRID TPID Description 
EMC N/A 5659 Issue: Context Sensitive Help (CSH) for Revenue 

Centers and Default Revenue Center was required to 
be updated 
Resolution: The CSH text for Revenue Centers and 
Default Revenue Center in the EMC-> Property level-> 
Setup tab-> Hardware/Interfaces-> Workstations-> Revenue 
Centers tab-> Revenue Center Configuration was 
required to be updated to reflect the changes in 
Simphony v2.x. 
The CSH text for Revenue Centers now reads as 
follows: 
This section is used to define the Revenue Centers that are 
available from this UWS when signing in. They are also 
referenced when the Function Key [Sign In RVC Index] is 
used. When configuring this Function Key in Page Design, 
the Index field is used to specify which Revenue Center from 
this list that the Operator will be signed in. If the UWS is an 
HHT, only one Revenue Center is supported. 
The CSH text for Default Revenue Center now reads as 
follows: 
This is the Default Revenue Center for the workstation. A 
Default Revenue Center must be assigned in order for Ops to 
start at the UWS. 

EMC 33211 7923 Issue: Deleting a Property that was included in a Zone 
configuration resulted in an orphaned record that 
caused the EMC to throw an exception error 
Resolution: Previously, for those sites whose systems 
utilized the Microsoft SQL Server® database platform 
(32-bit edition), and a Property included in a Zone 
configuration was deleted, exception errors were 
thrown. Currently, this issue cannot be reproduced on 
systems running Windows Server® 2008 R2 and MS 
SQL Server® 2008 (64-bit edition). Moving forward, 
there are no plans to support 32- bit database platforms 
for Simphony v2.x Database servers. 
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Module CRID TPID Description 
EMC 32967 16182 Issue: Menu Items (MI) records were being overwritten 

at the destination during a MI Distribution, despite the 
Overwrite records if they exist option being disabled 
Resolution: Previously, this reported issue also occurred 
when the Menu Item Master records were defined at the 
Enterprise level and the Definition and Prices records 
were defined at the Property or Revenue Center levels; 
overwrites occurred with any Master, Definition and 
Price Distribution task where an identical record existed 
in the destination. This has been corrected by modifying 
the EMC.exe file. Currently, when the Overwrite 
records if they exist Distribution option is disabled, 
existing MI records are not overwritten at the 
destination. 

EMC N/A 16265 Issue: When User Interface (UI) Resources in the EMC 
were overridden from a Zone, Property or Revenue 
Center (RVC), the changes were not reflected in 
Windows CE Workstations 
Resolution: Previously, when UI Resources such as the 
background of a Page Content Area in the EMC-> <Zone 
/ Property / Revenue Center> -> Setup tab-> Custom Content-
> Content, were overridden from a Zone, Property or 
Revenue Center (RVC), the changes were not reflected 
in Ops clients running on Windows CE. It was 
determined that this occurred because Windows CE is 
unable to dynamically change its resources. Once a 
change is made in the EMC, the Ops client must be 
restarted after performing a Database Sync or Database 
Reload to display the content changes correctly. 

EMC 33360 20456 Issue: An error occurred when adding a new Revenue 
Center (RVC) with a duplicate RVC number to a newly 
created Property 
Resolution: Previously, when adding a new RVC to a 
newly created Property via EMC-> Property level-> Setup 
tab-> Property Configuration-> RVC Configuration, if the 
new RVC was assigned the RVC number of an already 
existing RVC that belonged to another Property, the 
following error message was displayed: 
EMCHandler failed: Violation of PRIMARY KEY 
constraint ‘PK_V_HIER_ANCESTORS’. Cannot insert 
duplicate key in object 
:‘microsdb.V_HIER_ANCESTORS’. The statement has 
been terminated. 
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Module CRID TPID Description 
EMC 33504 21366 Issue: Direct Posting Service (DPS) returned an error 

when posting a deleted Menu Item in a closed or open 
Guest Check to the Reporting database 
Resolution: Previously, if a Menu Item in a closed or 
open Guest Check was deleted from the EMC before it 
was posted to the Reporting database, the DPS returned 
an error as the Menu Item could not be found in the 
Transaction database. It was determined that although 
there were constraints in place to ensure that users were 
prevented from deleting Menu Items that are included 
in an open or closed Check on the current business date, 
they were limited to data that were already posted to the 
Enterprise. Additionally, if a Property had issues with 
the Check and Posting Service (CAPS), no constraints 
were in place to prevent users with access to EMC from 
deleting a Menu Item that had been rung locally. This 
has been corrected by modifying the 
DirectPostingService.exe file. 

EMC 33732 23528 Issue: Attempting to save an Ops Text file in the 
Languages Module returned an error 
Resolution: Previously, when attempting to save an Ops 
Text file in the EMC-> Enterprise level-> Setup tab-> 
Enterprise Configuration-> Languages-> Text Files tab, the 
following error message was returned: 
Error encountered with database server or network 
connection. 
Value cannot be null. 
Parameter Name: inArray 
It was determined that this error occurred when a user 
attempted to save an Ops Text file without loading the 
translated text file. This has been corrected by modifying 
the EMC.exe, EMCText.dll and EMCData.dll files. 
Currently, when a user attempts to save an OpsText file 
without loading the translated text file, the following 
error message is displayed: 
The translation file cannot be empty. Please load 
proper translation file by clicking on the Edit link. 
Additionally, in an Oracle environment, when 
attempting to save the translation file, the following 
error was returned: 
Error encountered with database server or network 
connection 
EMCHandler failed: ORA-12704: character set 
mismatch 
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Module CRID TPID Description 
EMC 33739 23561 Issue: The Context Sensitive Help (CSH) file for the 

EMC-> Property-> Setup tab-> Hardware/Interfaces-> 
Workstations-> Options-> Display/Security-> [36 - Use 
Alternate ID for Sign-in] option was inaccurate 
Resolution: Previously, the CSH text for the [36 - Use 
Alternate ID for Sign-in] option was inaccurate and 
misleading. The legacy CSH file for option 36 indicated 
that an Alternate ID could be utilized to perform 
Manager Authorizations. This was incorrect. This has 
been corrected by modifying the EMCText.xml. 
Currently, the CSH text for option 36 reads as follows: 
Select this option to allow operators to sign-in to this 
workstation using the four-digit Alternate ID, programmed 
on their employee record. Workstations with this option 
enabled will allow users to sign-in using either their Alternate 
ID or their ten digit Employee ID, if no Alternate ID is 
available. 

EMC 33772 23772 Issue: Enabling option [7 - Enable [.Connect]] prevented 
the Direct Posting Service (DPS) from posting 
Resolution: Previously, enabling the option [7 - Enable 
[.Connect]] from the EMC-> Property level-> Setup tab-> 
Property Parameters-> Options tab prevented the DPS 
from posting to the database. This has been corrected by 
modifying the EMC.exe file. Currently, the option [7 - 
Enable [.Connect]] is hidden from the Property 
Parameters module in EMC. 
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Module CRID TPID Description 
EMC N/A 24509 Issue: Revenue Center (RVC) Parameters option [61 - 

Enhanced Prefix Mode] has been renamed and moved 
to the Menu Items Classes module 
Resolution: The option [61 - Enhanced Prefix Mode] 
has been removed from EMC-> RVC level-> Setup tab-> 
RVC Parameters-> Options tab, and now resides in EMC-
> <Enterprise / Property / Revenue Center> -> Configuration 
tab-> Menu Items-> Menu Item Classes-> Options tab In 
the Menu Item Classes module, this option displays as 
[65 - Support Enhanced Prefix Mode (Parent Only)]. 
Consequently, the Context Sensitive Help (CSH) text for 
the Condiment Prefix Type drop-down menu in the 
Menu Item Classes Form View has been updated to 
reflect the new name and location of the option. 
Additionally, in the Table View, the updated CSH text 
has been added to the Condiment Prefix Type column in 
EMC-> <Enterprise / Property / Revenue Center> -
>Configuration tab-> Menu Items-> Menu Item Classes. 
The CSH text for the Condiment Prefix Type now reads 
as follows: 
Use the drop-down box to select the appropriate prefix type to 
determine prefix behavior associated with this condiment type. 
Description Prefix: Helps describe the condiment it modifies 
more clearly. (e.g., Lite Mayo). No Prefix: Indicates that the 
prefix will be used to indicate the removal of the default 
condiment (e.g., No Cheddar) Add Prefix: The prefix will be 
used to indicate the addition of a non-default condiment (e.g., 
Add American). Sub Prefix: Identifies this item as replacing a 
default condiment in the same condiment group (e.g., No 
American, Sub Cheddar). Plain Prefix: The prefix will work 
like a function key. When selected, all condiments are removed 
from the menu item detail. If an item is added back after the 
item is set to Plain, then we will display the items in the check 
detail, including default items that are placed back on the 
menu item. Toggling the Plain key is the same as selecting the 
Reset key. Reset Prefix: This will reset the menu item to its 
original ordered state with no non-default condiments ordered 
and all of the default condiments automatically ordered. These 
options are only enabled with Menu Item Class Option [65 - 
Support Enhanced Prefix Mode (Parent Only)].  
This change has been implemented by modifying the 
EMCText.dll file. 
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Module CRID TPID Description 
EMC N/A 27205 Issue: Context Sensitive Help (CSH) for Menu Item 

Classes option [49 - Participates in Menu Item Master 
Switching] needed clarification 
Resolution: Previously, the CSH text for the option [49 - 
Participates in Menu Item Master Switching] in the 
EMC-> <Enterprise / Property / Revenue Center> -> 
Configuration tab-> Menu Items-> Menu Item Classes-> 
Options tab, did not mention that this option cannot be 
applied to Menu Items that are Condiment Prefixes. This 
has been corrected. The CSH text for option [49 - 
Participates in Menu Item Master Switching] now 
reads as follows: 
In conversational ordering it is possible to configure the 
system 'switch out a parent menu item' based a menu level 
change. For example, assume a server rings up a medium 
burger with 5 condiments. The customer then wants to switch 
it to a 'large' burger. The server is able to press the 'large' 
menu level button and the existing 'medium' burger menu 
item will switch out with the 'large' burger menu item 
retaining all of the condiments. Enabling this bit turns on this 
functionality. However, turning on this bit isn't sufficient. 
All items which switch among each other based on menu 
levels must belong to the same master group. In the example 
given above, one could create three menu item masters: "small 
burger", "medium burger", and "large burger", each 
belonging to the "burger" menu item master group. Each of 
these item's menu item class would have this bit set. This 
option does not function if the Condiment Prefix Type is non-
0 (meaning that the Menu Item is a Condiment Prefix). 
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Module CRID TPID Description 
EMC N/A 27234 Issue: Context Sensitive Help (CSH) for Menu Item 

Classes option [53 - Remove Item on Subsequent Press 
if Ordering Type is Exclusive] needed clarification 
Resolution: Previously, the CSH text for the option [53 - 
Remove Item on Subsequent Press if Ordering Type is 
Exclusive] in the EMC-> <Enterprise / Property / Revenue 
Center> -> Configuration tab-> Menu Items-> Menu Item 
Classes-> Options tab, did not mention that this option 
cannot be applied to Menu Items that are Condiment 
Prefixes. This has been corrected. The CSH text for 
option [53 - Remove Item on Subsequent Press if 
Ordering Type is Exclusive] now reads as follows: 
Consider the case where only one of a group of items can be a 
condiment on a parent. For example, the type of bun on a 
parent can be 'plain' (by default), 'seeded', or 'whole wheat'. 
When parent is first ordered there is no bun condiment. The 
server enters 'seeded' and the seeded menu item entry appears 
on the check. What occurs if the 'seeded' menu item is ordered 
again? If this bit is off, the item remains on the check. If this 
bit is on, the item is removed and the parent reverts back to 
the default state. This option does not function if the 
Condiment Prefix Type is non-0 (meaning that the Menu 
Item is a Condiment Prefix). 

EMC N/A 27239 Issue: Context Sensitive Help (CSH) for Menu Item 
Classes option [54 - Condiment entry assumed multiple 
when parent is multiple (Parent Only)] needed 
clarification 
Resolution: Previously, the CSH text for the option [54 - 
Condiment entry assumed multiple when parent is 
multiple (Parent Only)]in the EMC-> <Enterprise / 
Property / Revenue Center> -> Configuration tab-> Menu 
Items-> Menu Item Classes-> Options tab, did not mention 
that this option cannot be applied to Menu Items that 
are Condiment Prefixes. This has been corrected. The 
CSH text for option [54 - Condiment entry assumed 
multiple when parent is multiple (Parent Only)] now 
reads as follows: 
When entering multiple counts for parents items (e.g., "3 
burgers") this bit controls how counts for condiments act. 
Assume this bit is off: If the server orders 3 burgers and then 2 
cheese, only 2 slices of cheese will appear on the parent item. 
Assume this bit is on: If the server orders 3 burgers and then 2 
cheese, the parent will have 6 slices of cheese (3 x 2). This 
option does not function if the Condiment Prefix Type is non-
0 (meaning that the Menu Item is a Condiment Prefix). 
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Module CRID TPID Description 
EMC N/A 27245 Issue: Context Sensitive Help (CSH) for Menu Item 

Classes option [55 - Discounts Apply to Priced 
Condiments (parent items only)] needed clarification 
Resolution: Previously, the CSH text for the option [55 - 
Discounts Apply to Priced Condiments (parent items 
only)] in the EMC-> <Enterprise / Property / Revenue 
Center> -> Configuration tab-> Menu Items-> Menu Item 
Classes-> Options tab, did not mention that this option 
cannot be applied to Menu Items that are Condiment 
Prefixes. This has been corrected. The CSH text for 
option [55 - Discounts Apply to Priced Condiments 
(parent items only)] now reads as follows: 
For parent menu items only; when this option is enabled, 
Discounts will apply to items in this class and all priced 
condiments attached to the items. When this option is 
disabled, Discounts will not be applied to condiment items. 
This option does not function if the Condiment Prefix Type is 
non-0 (meaning that the Menu Item is a Condiment Prefix). 
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Module CRID TPID Description 
EMC N/A 27253 Issue: Context Sensitive Help (CSH) for Menu Item 

Classes option [57 - Parent items appear on condiment 
order devices (for condiments only)] needed 
clarification 
Resolution: Previously, the CSH text for the option [57 - 
Parent items appear on condiment order devices (for 
condiments only)] in the EMC-> <Enterprise / Property / 
Revenue Center> -> Configuration tab-> Menu Items-> Menu 
Item Classes-> Options tab, did not mention that this 
option cannot be applied to Menu Items that are 
Condiment Prefixes. This has been corrected. The CSH 
text for [57 - Parent items appear on condiment order 
devices (for condiments only)] now reads as follows: 
This option is intended for Menu Item Classes that contain 
condiment menu items. When this option is enabled, the 
parent item will be sent to the order devices programmed for 
its class, as well as to any order devices programmed for this 
class. This option may be enabled in a situation where a menu 
item (Blueberry Muffin) is not normally sent to an order 
device, but when a specific condiment is added (Warm) the 
item should be sent so that it can be prepared. (In this 
example, the Menu Item Class for the "Blueberry Muffin" 
item would have no order devices configured, and the Menu 
Item Class for "Warm" would have one or more order devices 
configured.) When this option is not enabled, Parent menu 
items will be sent based on their Menu Item Class settings 
only. This option does not function if the Condiment Prefix 
Type is non-0 (meaning that the Menu Item is a Condiment 
Prefix). 
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EMC N/A 27254 Issue: Context Sensitive Help (CSH) for Menu Item 

Classes option [58 - Condiment Order device 
programming overrides that of parent] needed 
clarification 
Resolution: Previously, the CSH text for the option [58 - 
Condiment Order device programming overrides that 
of parent] in the EMC-> <Enterprise / Property / Revenue 
Center> -> Configuration tab-> Menu Items-> Menu Item 
Classes-> Options tab, did not mention that this option 
cannot be applied to Menu Items that are Condiment 
Prefixes. This has been corrected. The CSH text for [58 - 
Condiment Order device programming overrides that 
of parent] now reads as follows: 
This option is intended for Menu Item Classes that contain 
condiment menu items. When this option is enabled, the order 
devices programmed for the condiments class will override the 
order devices defined for parent menu items. This option 
maybe enabled in a situation where a menu item (Blueberry 
Muffin) is sent to a different order device when a specific 
condiment is added (Warm). This option does not function if 
the Condiment Prefix Type is non-0 (meaning that the Menu 
Item is a Condiment Prefix). 

EMC 33157 27777 Issue: Remote Distributing a Combo Meal Groups with 
an Alternate Group returned an EMCHandler failed 
error in both Oracle and Microsoft SQL environments 
Resolution: Previously, when attempting to Remote 
Distribute a Combo Meal Group with an Alternate 
Group, the following error message was displayed in an 
Oracle environment: 
EMCHandler failed: ORA-02291: integrity constraint 
(LSI_MICROSDB.FK_ALTERNATECOMBOGROUP) 
violated - parent key not found 
The following error message was displayed in a 
Microsoft SQL environment: 
EMCHandler failed: The INSERT statement conflicted 
with the FOREIGN KEY constraint 
"FK_ALTERNATECOMBOGROUP". The conflict 
occurred in database "MCRSPOS", table 
"microsdb.COMBO_GROUP", column 
'ComboGroupID'.The statement has been terminated. 
It was determined that this error occurred if the Combo 
Meal Group’s Alternate Group record did not exist in 
the destination location. This has been corrected by 
modifying the EMCData.dll file. 
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EMC N/A 30003 Issue: Context Sensitive Help (CSH) for Order Devices 

option [15 - Display New Order Notification] was 
required to be updated 
Resolution: Previously, the CSH text for the option [15 - 
Display New Order Notification] in the EMC-> Revenue 
Center (RVC) level-> Setup tab-> Hardware/Interfaces-> 
Order Devices-> Options tab-> KDS Options, did not 
mention that this feature is not supported when the RVC 
Parameter’s option [50 - Enable Dynamic Order Mode 
(DOM)] is enabled. This has been corrected. The CSH 
text for [15 - Display New Order Notification] now 
reads as follows: 
Enable this option for new orders to flash when they appear on 
the KDS Display. Note: This feature is not supported with the 
Dynamic Order Mode (DOM) enabled. [RVC Option 50 - 
Enable Dynamic Order Mode (DOM)]. 

EMC 33390 34374 Issue: Overriding a Menu Item Class with Forced 
Condiments, and overriding Combo Meal Groups 
deleted the saved records 
Resolution: Previously, when a Menu Item Class with 
Forced Condiments was overridden at the Property or 
RVC level, the Forced Condiments would get deleted. 
Similarly, when a Combo Meal Group was overridden 
at the Property or RVC level, all the Combo Group Items 
were deleted. This has been corrected by modifying the 
EMCData.dll and EMC.exe files. 
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EMC N/A 37113 Issue: There was no Context Sensitive Help (CSH) 

available for Interfaces options [10 - ON = Use 5-digit 
RVC #; OFF = Use 3-digit RVC #] and [11 - ON = Use 8-
digit Check #; OFF = Use 4-digit Check #] 
Resolution: The options [10 - ON = Use 5-digit RVC #; 
OFF = Use 3-digit RVC #] and [11 - ON = Use 8-digit 
Check #; OFF = Use 4-digit Check Check #; OFF = Use 
4-digit Check #] in the EMC-> Enterprise level-> Setup tab-
> Hardware/Interfaces-> Interfaces-> Options tab, did not 
contain any CSH text. This has been corrected. 
The CSH text for option [10 - ON = Use 5-digit RVC #; 
OFF = Use 3-digit RVC #] reads as follows: 
If set, the PMS posting message will support a five digit 
Revenue Center Number. If not set, the PMS posting message 
is limited to a three digit Revenue Center Number. 
The CSH text for option [11 - ON = Use 8-digit Check #; 
OFF = Use 4-digit Check #] reads as follows: 
If set, the PMS posting message will support an eight digit 
Check Number. If not set, the PMS posting message is limited 
to a four digit Check Number. 

EMC 34001 39002 Issue: EMC returned an error when attempting to add 
an Order Device to the Kitchen Display System (KDS) 
Distribution Group 
Resolution: Previously, when attempting to add an 
Order Device to the KDS Distribution Groups from the 
EMC-> Revenue Center (RVC) Level-> Setup tab-> 
Hardware/Interfaces-> KDS Distribution Groups in the 
Oracle database environment, EMC failed and returned 
the following error: 
Failure to connect to host: localhost  
SendSyncRequest returned with error code: 
ERC_CONNECTION_DOWN at 
EMC.Data.WebService.EMCClient.Execute(Int32 
timeOutSec) at 
EMC.Data.WebService.EMCClient.IsMultiTenantNot
Authenticated() 
at 
EMC.Framework.Login.ServerLogger.AttemptServerC
onnection() 
This has been corrected by modifying the 
EMCHandler.dll file. 



 

78 Resolved Issues 

Module CRID TPID Description 
EMC 34710 40663 Issue: Table View Filtering in Menu Item Maintenance 

Definition Records tab did not work 
Resolution: Previously, Table View Filtering in EMC-> 
<Enterprise / Property / RVC> -> Configuration -> Menu 
Items-> Menu Item Maintenance-> Definition Records tab 
did not work. When a search criterion was defined from 
the filter box and the Filter Now button was pressed, the 
Definition Records tab did not return any search results. 
This has been corrected. 

EMC 34716 40733 Issue: Condiment items with a prefix removed from a 
check in a Previous round, made all other Condiments 
with the same prefix appear without the prefix in the 
Check Detail Area 
Resolution: Previously, if a Condiment item with a 
prefix was removed from a check in a Previous round, 
all other Condiments with the same prefix appeared 
without the prefix in the Check Detail Area. It was 
determined that this functionality was working as 
expected. 

EMC 34596 41033 Issue: Creating a new employee using the Add 
Employee Record from Template option duplicated the 
Payroll ID 
Resolution: Previously, when creating a new employee 
using the option Add Employee Record from Template, 
the copied employee’s Payroll ID was assigned to the 
newly created employee. This has been corrected by 
modifying the EMCCommands.xml, EMCText.dll, and 
EMCText.xml files. Currently, if a duplicate Payroll ID is 
entered, the following error message will be displayed: 
This record cannot be saved because its Payroll ID 
matched one or more Payroll ID of other employees. 
Additionally, if the user enters a duplicate Username, ID 
Number or an Alternate ID number, an error message 
will be displayed. 
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EMC 33613 41940 Issue: Changes were made to the EMC to allow for a 

more user friendly way of editing simscripts and xml. 
Users were unable to save their simscripts and xml edits 
in the EMC due to the unavailable (grayed out) Save 
toolbar icon 
Resolution: Previously, changes were made to the EMC 
to allow for a more user friendly way of editing 
simscripts and xml. After making simscripts and xml 
edits in the EMC, however, users were unable to save 
their work due to the unavailable (grayed out) Save 
toolbar icon. This has been corrected by modifying the 
EMCframework.dll file. Users are now able to save their 
simscripts and xml edits in the EMC by clicking the 
Save icon on the toolbar. 

EMC 34988 48151 Issue: When using an existing Property to clone in 
setting up a new Property, several Revenue Center items 
were not populating to the new Property. 
Resolution: Previously, when using an existing Property 
to clone in setting up a new Property, several Revenue 
Center items were not populating to the new Property. 
This has been corrected by modifying the EMC.exe file. 
Currently, all Revenue Center items are populated to the 
new Property when using an existing Property as a 
clone. 

EMC N/A 48828 Issue: Employee Roles Option [19 - Post Menu items to 
Checks Belonging to Another Operator] was not 
working as expected 
Resolution: Previously, when option [18 - 
Authorize/Perform Pickup of a Check Belonging to 
Another Operator] was enabled, option [19 -Post Menu 
items to Checks Belonging to Another Operator] was 
ignored by the system (regardless of being enabled or 
not). As long as option 18 was enabled, any Operator 
could add additional Menu Items to another Operator's 
check. This was not the correct behavior. Option 18 can 
be located by accessing the EMC-> Enterprise level-> 
Configuration-> Personnel-> Roles-> Operations-> Guest 
Checks-> Guest Check Control Options section. Option 
19 can be located by accessing the EMC-> Enterprise level-
> Configuration-> Personnel-> Roles-> Operations-> 
Transactions-> Other Employee Checks Options section. 
This has been corrected by modifying the Ops.dll. 
Option 19 now functions as expected for privileged 
Operator's. 
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EMC N/A 27190 Issue: EMC Roles Option [19- Post Menu items to 

Checks Belonging to Another Operator] is ignored 
when Team Service is enabled 
Resolution: Previously, the CSH text for option [5 – 
Reference Entry Required] in the EMC-> <Enterprise / 
Property / Revenue Center> -> Configuration tab-> Menu 
Items-> Menu Item Classes-> Options tab, did not mention 
that this option cannot be applied to Menu 
Items that are Condiment Prefixes. This has been 
corrected. The CSH text for option [5 – Reference Entry 
Required] now reads as follows:  
Select this option to require a reference entry for menu items 
in this class. This option does not function if the Condiment 
Prefix Type is non-0 (meaning that the Menu Item is a 
Condiment Prefix). The reference entry is user defined text 
that outputs with the Menu Item to order devices, guest 
checks, customer receipts and journals. It is often used 
describe what an open priced menu item posting represented. 

EMC N/A 27191 Issue: Context Sensitive Help (CSH) for Menu Item 
Classes option [9 - Condiment Changes Print Group of 
Parent Menu Item] needed clarification 
Resolution: Previously, the CSH text for option [9 - 
Condiment Changes Print Group of Parent Menu 
Item] in the EMC-> <Enterprise / Property / Revenue 
Center> -> Configuration tab-> Menu Items-> Menu Item 
Classes-> Options tab, did not mention that this option 
cannot be applied to Menu Items that are Condiment 
Prefixes. This has been corrected. The CSH text for 
option [9 - Condiment Changes Print Group of Parent 
Menu Item] now reads as follows: 
Select this option to cause a parent menu item that is modified 
by a condiment to use the print group of the condiment. This 
is used to modify the parent menu item's Order Device 
Sorting. For example, the condiment "As Entree" could be 
used to modify an appetizer, thus forcing it to print and sort 
with other entree menu items. If a parent menu item has 
several condiment menu items following it that use this 
option, the last condiment for which this option is enabled 
determines the parent's print group. This option does not 
function if the Condiment Prefix Type is non-0 (meaning that 
the Menu Item is a Condiment Prefix). 
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EMC N/A 27193 Issue: Context Sensitive Help (CSH) for Menu Item 

Classes option [22 - ON = Use Own Output Link; OFF = 
Use Parent's (Condiments Only)] needed clarification 
Resolution: Previously, the CSH text for the option [22 - 
ON = Use Own Output Link; OFF = Use Parent's 
(Condiments Only)] in the EMC>  <Enterprise / Property / 
Revenue Center> -> Configuration tab-> Menu Items-> Menu 
Item Classes-> Options tab, did not mention that this 
option cannot be applied to Menu Items that are 
Condiment Prefixes. This has been corrected. The CSH 
text for option [22 - ON = Use Own Output Link; OFF = 
Use Parent's (Condiments Only)] now reads as follows: 
This feature applies to condiment menu items. Select this 
option to cause menu items in this class (condiment menu 
items) to output independently of the parent menu item, 
printing to their own Order Devices. Disable this option to 
cause menu items in this class to print to the same Order 
Devices as the parent, provided that this Menu Item Class has 
the same Order Device Output configured. Programming 
note: By default, the ideal setup of a condiment group class is 
to keep this option disabled, and to enable all Order Devices as 
the output. This way, the condiment will always follow the 
parent item to its printer(s). Change these settings for 
different site configurations, but programming Menu Item 
Classes in this default manner will suit the need of most site 
operations. This option does not apply to Prefix Condiments 
(where Condiment Prefix Type is set to other than 0 – “Not a 
Prefix”). 
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EMC N/A 27195 Issue: Context Sensitive Help (CSH) for Menu Item 

Classes option [23 - Add Condiment Price to the Parent 
Item's Price on Check Only] needed clarification 
Resolution: Previously, the CSH text for the option [23 – 
Add Condiment Price to the Parent Item's Price on 
Check Only] in the EMC-> <Enterprise / Property / 
Revenue Center> -> Configuration tab-> Menu Items-> Menu 
Item Classes-> Options tab', did not mention that this 
option cannot be applied to Menu Items that are 
Condiment Prefixes. This has been corrected. The CSH 
text for option [23 - Add Condiment Price to the Parent 
Item's Price on Check Only] now reads as follows: 
This feature applies only to parent menu items. Select this 
option to cause the price of any condiments that are applied to 
this menu item to add to this menu item's price on the guest 
check. This presents the customer with a single price for the 
menu item and its condiment. Liquor Menu Item Classes 
often have this option bit enabled--for instance, if a server sells 
a Vodka Martini, perhaps the "Vodka" item is $5.00, and the 
"Martini" modifier is $2.00. On the guest check and receipt, 
this will show as a $7.00 Vodka. This option does not apply to 
Prefix Condiments (where Condiment Prefix Type is set to 
other than 0 – “Not a Prefix”). 
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EMC N/A 27196 Issue: Context Sensitive Help (CSH) for Menu Item 

Classes option [30 - Sort Condiments by Print Group] 
needed clarification 
Resolution: Previously, the CSH text for the Menu Item 
Classes option [30 - Sort Condiments by Print Group] 
in the EMC-> <Enterprise / Property / Revenue Center> -> 
Configuration tab-> Menu Items-> Menu Item Classes-> 
Options tab, did not mention that this option cannot be 
applied to Menu Items that are Condiment Prefixes. This 
has been corrected. The CSH text for option [23 – Add 
Condiment Price to the Parent Item's Price on Check 
Only] now reads as follows: 
This option applies to parent menu items, when more than one 
condiment is being used to modify the item. Select this option 
to cause condiments that are entered for this parent item to 
sort by print group. Disable this option to cause condiments 
to print in the order in which they were entered. For example, 
Prime Rib is a menu item that requires three condiments—
meat temperature, potato type, and salad dressing. In addition 
to these required condiments (which must be entered first), 
other condiments such as "End Cut" are ordered for this item. 
By programming Menu Item Class Print Groups in such a 
way as to anticipate this situation, the "meat temperature" 
items could be Print Group 1, the "potato type" and "salad 
dressing" items could be Print Group 4, and the "End Cut" 
item could be Print Group 2. Then, when the item is ordered, 
the chef will see the condiments print in this order: meat 
temperature, End Cut, potato type, and then salad dressing. 
Therefore, the system sorted the "End Cut" item immediately 
after the "meat temperature", making the ticket more logical 
to read. This option does not apply to Prefix Condiments 
(where Condiment Prefix Type is set to other than 0 – “Not a 
Prefix”). 
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Module CRID TPID Description 
EGateway N/A 11627 Issue: The TotalLogSize setting in the Web.config file 

cannot exceed 10 digits or the EGateway will not start 
Resolution: The TotalLogSize setting in the Web.config 
file establishes the amount of disk space that may be 
used to store log files for the system. By default, this 
value is set to 10485760 bytes (10 MB) when Simphony is 
installed. 

 
However, this value can be adjusted for a customer’s log 
retention needs. If the "TotalLogSize" setting was set to a 
value that exceeded 10 digits, it prevented the EGateway 
from starting. Therefore, the uppermost limit for this 
setting cannot exceed the value of 9999999999 bytes (~9 
GB) before causing the EGateway to fail to start. 

EGateway 33378 20077 Issue: Rounds in a Check that failed to post were 
erroneously marked as successfully posted 
Resolution: Previously, if a round failed to post to the 
Check and Posting Service (CAPS) due to an error (e.g., 
database timeout), the MREQUEST record in CAPS 
incorrectly showed that this was successfully posted to 
the Enterprise and caused the subsequent rounds to fail 
as well. This has been corrected by modifying the 
EGatewayHandlers. Currently, failed rounds are 
marked correctly as failed in CAPS, and once the error is 
resolved, the rounds of the Check are posted to the 
Enterprise without user intervention. 
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EGateway 33945 25553 Issue: The v1.x EGateway DBDownload Handler than 

runs on v2.x Application Servers unnecessarily cached 
and refreshed Menu Items Definitions, Masters and 
Prices every five minutes and used excessive system 
resources 
Resolution: Previously, the v1.x Gateway was being 
used to handle Client Application Loader (CAL) and 
Credit Card (CC) batching duties. Additionally, the v1.x 
Gateway was caching and refreshing the files related to 
Menu Items. It was determined that the overuse of the 
1.x EGateway resulted in the use of excessive resources 
on the v2.x Application Server. This has been corrected 
by modifying the DbDownloadHandler.dll file. 
Currently, the v1.x Gateway no longer performs the 
caching and refreshing of the files related to Menu 
Items. 

Extensibility N/A 19777 Issue: Simphony did not have Extensibility hooks for 
MenuItemDetail methods to allow its taxes to be 
changed 
Resolution: Previously, Simphony did not have 
Extensibility hooks for MenuItemDetail methods to 
allow its taxes to be changed. This has been corrected by 
modifying the PosCore.dll and Ops.dll files. 

Extensibility 34745 41415 Issue: Extension content did not load if an Extension 
Application Version was set in EMC 
Resolution: Previously, when an Extension Application 
Version was set from the EMC-> <Enterprise / Property / 
Revenue Center> -> Custom Content-> Extension 
Application-> General tab-> Version column, extension 
content did not load if the minimum/maximum version 
was set to 2.5-2.5. It was determined that this was 
caused by a misprint in the version-splitting code. This 
has been corrected by modifying the 
EGatewayHandler.dll file. 
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Install 32945 16041 Issue: Users could not specify a SQL Server Named 

Instance when installing Simphony in a Microsoft SQL 
environment 
Resolution: Previously when installing Simphony in a 
Microsoft SQL environment, users could not specify a 
SQL Server Instance as the Server Name field was 
grayed out. This has been corrected by modifying the 
Setup.exe file. Currently, during installation the Server 
Name field is automatically populated with the specific 
server. Additionally, a new field named, Instance Name 
has been added to include the instance name. When the 
default instance is in use, the Instance Name field 
should be left blank. 
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Interfaces 32529 11450 Issue: When using a Room Inquiry function from Ops, 

there was no way for users to navigate the subsequent 
list of displayed guest names when more than 10 names 
were displayed 
Resolution: Previously, when performing a Room 
Inquiry (for sites using a PMS Interface) and there were 
more than 10 guest names displayed, there were no 
navigational tools to allow users to scroll down or to 
Page Up\Down to see any remaining names that were 
displayed there. This has been corrected by modifying 
the fid_fo.isl (Opera PMS) SIM script, Ops.dll and 
OpsUI.dll files. 
When the updated fid_fo.isl SIM script is applied, Ops 
will display Page Up, Page Down, Up\Down Arrows 
and functional Home’and End buttons to provide 
navigational options for users as shown here: 

 
It has been determined that the required (and modified) 
fid_fo.isl SIM script will be made available to users by 
the Opera PMS product group. 
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Interfaces N/A 21475 Issue: The Interface Service was encoding PMS 

messages using ASCII and caused data loss 
Resolution: Previously, the Interface Service encoded 
Interface messages using ASCII. This resulted in data 
loss as the conversion caused special characters (e.g. 
guest name) to be replaced by interrogative points. This 
has been corrected by modifying the PMS.dll file. 
Additionally, an Encoding Type drop-down menu has 
been added to the EMC-> Enterprise level-> Setup tab-> 
Hardware/Interfaces-> Interfaces-> Interfaced module, to 
provide users the ability to select the appropriate 
conversion type for PMS messages. The supported 
Encoding Types are as follows: 

• 0 – ASCII 
• 1 – Default Windows 
• 2 – UTF8 
• 3 – Unicode 
• 874 - Thai 
• 1250 - Central Europe 
• 1251 - Cyrillic 
• 1252 - Latin I 
• 1253 - Greek 
• 1254 - Turkish 
• 1255 - Hebrew 
• 1256 - Arabic 
• 1257 - Baltic 
• 1258 – Vietnam 

Note: The Interface Encoding Type, the Region and 
Language Setting of Windows where the Emulator is 
running, and the language Encoding Type of the EMC 
set via the EMC-> Enterprise level-> Setup tab-> Enterprise 
Configuration-> Languages-> Miscellaneous tab-> Local ID 
must be identical. For example, if the Interface Encoding 
Type is set to 1253 - Greek then both the Language Local 
ID and the Region and Language Setting of Windows 
must also be set to Greek. 
This change has been implemented by modifying the 
PMS.dll, PosCommonClasses.dll, EMCHandler.dll, 
EMCData.dll, Ops.dll, CGwDataTypes.xml, 
Interface.xml, InterfaceService.dll and TotalPosting.dll 
files. 
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Interfaces 33776 23828 Issue: Sales itemizers were posting incorrectly to the 

wrong Sales Total field in the standard interface 
Resolution: Previously, sales itemizers were posting 
incorrectly to the wrong Sales Total field in the standard 
interface. For example, consider a scenario where food is 
designated as Sales Itemizer-1 and beer is Sales Itemizer-
2. After ringing up a check with beer (Sales Itemizer-2) 
only, the check posted in the standard interface as food 
(Sales Itemizer-1). Sales itemizers are now posting 
correctly to the right Sales Total field, regardless of what 
Sales Total fields are used. This has been corrected by 
modifying the Ops.dll and PosCore.dll files. 

Interfaces 34203 29742 Issue: All Guest Checks were posted to the Opera 
interface with the closed date 1/1/0001 
Resolution: Previously, when a Guest Check was closed 
to a tender linked to the Opera interface, the closed date 
of the Guest Check was always posted as 1/1/0001 to the 
OPERA interface. However, the Guest Checks printed 
the closed date correctly. This has been corrected by 
modifying the Ops.dll file. 

Interfaces 34898 35085 Issue: When displaying the PMS inquire response 
message, the formatting was intermittently incorrect 
Resolution: Previously, the formatting of the PMS 
inquire response message was intermittently, incorrectly 
displayed. This has been corrected by modifying the 
Ops.dll and Pms.dll files. The PMS inquire response 
message is now consistently formatting correctly. 

iPad 34463 21772 Issue: iPad client status bar displayed the localhost IP 
Address instead of the Static IP Address 
Resolution: Previously, when an iPad client was 
configured to use a Static IP Address through EMC-> 
Property level-> Setup tab-> Hardware/Interfaces-> 
Workstations-> General tab-> Address / Host Name, the 
status bar displayed the local host IP Address instead of 
the configured Static IP Address. As a result printing, 
Check Sharing and other functionalities did not work. 
This has been corrected by modifying the Ops.dll file. 

Journals 32580 12899 Issue: Check Journal Report now creates entry for [Edit 
Seat] function 
Resolution: The Check Journal Report now posts an 
entry when the operator uses the [Edit Seat] function. 
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Journals 33695 23210 Issue: The initial zero in the Time stamp entry for 

minutes was getting truncated 
Resolution: Previously, the Time stamp entry 
performed in the first 10 minute of the hour posted to 
the journal, whereby the initial zero in the value for 
minutes was getting truncated. This has been corrected 
by modifying the PosCore.dll and ServiceHostCore.dll 
files. Currently, the Time entries are accurately posting 
to the journals. 

Journals 33694 23204 Issue: When a void is performed and then cancelled, the 
journal summary showed a positive amount (rather than 
the action taken to add a negative amount to the Check) 
Resolution: Previously, cancelling a void of tender 
caused a positive amount to post to the journal entry. 
Currently, this issue cannot be reproduced in the 
MICROS system test environment. 

KDS N/A 3672 Issue: Timed Menu Items that were voided before being 
fired were not correctly shown on Expo and Prep 
Displays 
Resolution: Previously, Expo and Prep Displays did not 
correctly display the Menu Items that were voided 
before they were fired to the Prep displays – the Status 
of voided Menu Item was not changed to Done on the 
original chit on the Expo Display and the Prep Display 
showed the voided Menu Item twice at the time of fire. 
This has been corrected by modifying the Kitchen 
Display System (KDS) module. Currently, when a Menu 
Item is voided before being fired to the Prep display, the 
Expo Display marks the voided Menu Item as Done on 
the original chit and the Prep Display shows the voided 
Menu Item as an unnamed item on the chit. This was 
corrected by modifying the KDSController.exe file. 

KDS 33777 23834 Issue: When Dynamic Order Mode (DOM) was enabled, 
bumped Order Chits that were picked up for the next 
round were sent to the Kitchen Display System (KDS) 
Resolution: Previously, when the option [50 - Enable 
Dynamic Order Mode (DOM)] was enabled from the 
EMC-> Revenue Center level-> Setup tab-> Parameters-> 
RVC Parameters-> Options tab, if a Check from the 
previous round was picked up and Service Totaled with 
an Item that is not configured to go to the KDS, the KDS 
Expo Display and the KDS Prep Display re-displayed 
that bumped Order Chit from the previous round. This 
has been corrected by modifying the KDS module. 
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KDS N/A 30115 Issue: The Backup KDS Controller will not takeover 

automatically when the Primary KDS Controller is 
down and there are only 2 workstations available 
Resolution: Previously, in instances where there are 
only 2 workstations, the Backup KDS Controller will not 
take over automatically when the Primary KDS 
Controller and the Service Host are down. Typically, the 
Backup KDS Controller "checks" to see if it is the 
workstation that is not communicating to the Primary 
KDS Controller before it takes over. In a situation where 
there are no other workstations, the KDS Controller will 
not take over due to believing that the workstation is 
offline. Currently, the automatic takeover does not work 
in a 2-workstation scenario and cannot be supported 
because if the workstations lose communication with 
each other, each workstation will believe that it is the 
sole master. In the 2-workstation scenario, it is sufficient 
and appropriate to have a functioning manual takeover. 
Manual changeover in this scenario is supported since it 
requires human intervention to determine the real 
reason why the primary KDS goes down. 

mylabor 33358 20370 Issue: The Simphony mylabor client code did not 
properly deal with the .resources files that were sent 
down from the mymicros server 
Resolution: Previously, the system attempted to 
download mylabor client codes to the CAPS workstation 
every 30 seconds. The downloads continually failed 
because the code that determined whether there were 
new files to download did so by comparing file versions 
and the code did not work with the .resources files since 
they had no version information. 
The following message was being written to the 
EGateway log file: 
10/15/12 17:08:17.545, 2, 1,Labor, 37,A new version 
of 
 
MICROS.myLabor.Data.fr-FR.resources has been 
detected. Local version: <file not found> Enterprise 
version: 1.2.0.1, 
10/15/12 17:08:17.811, 2, 1,Labor, 37,Saving 
language file: 
C:\Micros\Simphony\WebServer\wwwroot\EGateway\Handle
rs\LanguageResource s\MICROS.myLabor.Data.fr-
FR.resources, 

This has been corrected by modifying the MyLabor.exe 
to ignore the call to UpdateLanguageResources. 
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Module CRID TPID Description 
mylabor 33960 26262 Issue: The Employee Financial Report did not display 

Declared Tips when Direct Tips or Indirect Tips were 
declared through mylabor 
Resolution: Previously, if Tips were declared through 
mylabor, the declared Direct or Indirect Tip amount was 
not displayed in the Workstation Employee Financial 
Report nor the mylabor Employee Financial Report. This 
is by design. Tip amounts are displayed on Employee 
Tip Reports. 

mymicros.net 32736 3795 Issue: The Indirect Tips total amount was not displayed 
onEmployee Tip Reports 
Resolution: Previously, the Indirect Tips total amount 
was not displayed individually on the Employee Tip 
Report. Instead, Indirect Tips totals were added to the 
Direct Cash Tips total. This was incorrect. Indirect Tips 
totals now display separately on the Employee Tip 
Report and are no longer reflected in the Direct Cash 
Tips total. This has been corrected by modifying the 
DataPostingService.exe file. 

mymicros.net 33287 19298 Issue: Tender/Media-> Paid-In and Paid-Out transaction 
values did not display on the mymicros.net System Sales 
Summary report 
Resolution: Previously, the transaction values for the 
EMC-> Enterprise level-> Sales-> Tender/Media-> Loan 
(Paid-In) and Pick-up (Paid-Out) types were written to 
the Reporting database, but were not being displayed on 
the mymicros.net System Sales Summary report. The 
System Sales Summary report setup in mymicros.net 
was documented with the release of mymicros.net v7.0 
as outlined in the mymicros.net Version 7.0 ReadMe 
First document. There are several fields on the System 
Sales Summary report that require Data mapping, but 
this reported issue was specifically in reference to the 
Paid-In and Paid-Out fields under the report’s Cash 
Collected section. To access the mymicros.net Version 
7.0 ReadMe First document, click here . Refer to pages 8 
through 11 to review the necessary mymicros.net Data 
mapping steps. 

http://downloads.micros.com/micros/simphony/Wiki/Docs/WhitePapers/MM_v7.0.0_RMF.pdf
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Module CRID TPID Description 
mymicros.net 33391 20515 Issue: mymicros.net Tip Reports displayed the total of 

the Service Charges and the Charge Tips in the Service 
Charges line 
Resolution: Previously, when the Service Charges 
options [3 - Post to Charged Tips Total on Tip Reports] 
and [4 - Post to Service Charges Total on Tip Reports] 
were enabled from the EMC-> <Enterprise / Property> -> 
Configuration tab-> Sales-> Service Charges, the mymicros 
Reports, Property Tip Report, RVC Tip Report and the 
Employee Tip Report displayed the sum of the Service 
Charges and Charged Tips on the Service Charges line. 
This was incorrect as Service Charges and Charge Tips 
should be displayed separately in the reports’ Service 
Charges line and the Charged Tip line respectively. This 
has been corrected by modifying the following 
mymicros.net report templates: 
MMEmployeeTipUWS.xml, MMEmployeeTip.xml, 
MMSystemTip.xml and MMRevCtrTip.xml. 

mymicros.net 33617 22384 Issue: mymicros.net Void Reason report displayed 
alphanumeric table names as #ERROR 
Resolution: Previously, when the [18 - ON = Use 5-digit 
table#; OFF = Use 4-digit Character Table ID] option 
was disabled from the EMC-> Revenue Center (RVC) level-
> Setup tab-> Parameters-> RVC Parameters-> Options tab 
and if the table name was alphanumeric, the ‘Table’ 
column of the mymicros.net Void Reason report 
displayed the table name of the Check as “#ERROR”. 
Additionally, the following error message was 
displayed at the bottom of the report: Data type 
mismatch error tableid. This has been corrected by 
modifying the MMVoidReason.xml file. 

Ops 30781 4122 Issue: An interruption occurred during Database Reload 
and caused the Workstation to become unusable 
Resolution: Previously, an interruption occurred when 
reloading the Workstation database using the [Reload 
Workstation Database] or the [Reload CAPS] function 
key. As a result, Ops failed to load and the Workstation 
became unusable. This has been corrected and was not 
reproducible in the current release. 
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Module CRID TPID Description 
Ops N/A 4326 Issue: Adding a Condiment to a Previous Round Menu 

Item returned an error 
Resolution: Previously, when an Operator picked up a 
Check from a previous round and added a Condiment 
to a Menu Item on that Check, Simphony threw an error 
in the EGatewayLog file. This error also occurred if the 
previous round Check had a Weighed Menu Item. It 
was determined that the error occurred due to the 
Parent Menu Item not being moved to the current round 
prior to making any changes. This has been corrected by 
modifying the Ops.dll file. Currently, when adding a 
Condiment to a Menu Item in a previous round, the 
Parent Menu Item is moved to the current round before 
making a change after carrying out a Condiment Prefix 
check. 

Ops 30677 4485 Issue: Users were not automatically logged out of 
Property Management Console (PMC) Function screen, 
despite system being configured to do so 
Resolution: Previously, if the option EMC-> Property 
level-> Configuration tab-> Personnel-> Employee Classes-> 
Operator Options tab-> RVC Operator Options-> Options-> 
[15 - If Staydown Operator, Enable the Auto Popup 
Timeout] was enabled, users were not automatically 
logged out of the PMC Function screen when it reached 
the configured inactivity threshold. The inactivity 
timeout setting can be configured through the EMC-> 
Property level-> Revenue Center level-> Setup tab-> 
Parameters-> Control Parameters-> Configuration tab-> in 
the Automatic Operator "Popup" Interval (min:sec) 
field, but this setting was being ignored. With this 
release, this reported issue could not be reproduced. 

Ops 32938 4696 Issue: Check Summary Descriptor for Discount has been 
introduced 
Resolution: New Check Summary Descriptor for 
Discount has been added to the EMC-> <Enterprise / 
Property / Revenue Center> -> Descriptors tab-> 
Miscellaneous-> Check Summary Descriptors. The 
DataStore must be dropped or the Service Host has to be 
restarted for the Discount Summary Descriptor to be 
recognized. This enhancement was implemented by 
modifying the EMCCommands.xml file. 
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Ops 31930 6228 Issue: An Oracle® error occurred when adding a 
Property through the Add Property Wizard 
Resolution: Previously, an Oracle® error occurred when 
a Property was added through the EMC-> Enterprise 
level-> Tasks tab-> Wizards-> Add Property Wizard. It was 
determined that when a Property was added through 
the 'Property Wizard' it automatically created a 
Reporting Location in the CORE_ORG_LEVEL table of 
the Reporting database’s COREDB database. The 
Property name was used as the Location Reference 
name of the Reporting Location by default, and if the 
Property name exceeded eight characters, an error 
occurred since the applicable database column only 
allowed a maximum of eight characters. The error 
message displayed as shown below: 
Unable to open the specified page 

EMCHandler failed:ORA-12899: value too 
large for column 

COREDB”,”CORE_ORG_LEVEL”,”OR
GLOCATIONREF”(actual: 
15,maximum 8) 

This has been corrected by modifying the EMC.exe, 
EMCCommands.xml, EMCText.xml files. 
Notes: It’s important that ‘Location Reference’ entries 
are unique for each Property on the system. 
Additionally, these other restrictions also apply: 

• Property Numbers cannot be more than 9 
characters 

• Property Names cannot be more than 32 
characters 

• MyLabor Logons cannot be more than 12 
characters 

 
If an existing Location Reference name is added the 
following message will display: 
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Module CRID TPID Description 
Location Reference name {0} already exists. Please 
choose different Location Reference name. 

Ops 7914 33496 Issue: Intermittently, the Check Detail area was not 
displaying Menu Item (MI) Reference entries as 
expected 
Resolution: Previously, there were intermittent 
instances where MI Reference Entries were not 
displaying on Ops. This has been corrected by 
modifying the PosCore.dll and Ops.exe (for TPID 
#10218). Currently, MI Reference entries display as 
expected. 

Ops 32101 8715 Issue: Cash Drawer opened when a Guest Check with a 
0.00 subtotal was over tendered even though the Control 
Parameters option [36 - Do Not Open Drawer if 
Subtotal is 0.00] was enabled 
Resolution: Previously, even though the EMC-> 
<Enterprise / Property / Revenue Center> -> Setup tab-> 
Parameters-> Control Parameters-> Options tab-> [36 - Do 
Not Open Drawer if Subtotal is 0.00] option was 
enabled, the Cash Drawer opened when a Guest Check 
with a 0.00 subtotal was over tendered. This has been 
corrected by modifying the Ops.dll file. Currently, the 
Cash Drawer does not open if a check with a 0.00 
subtotal is over tendered. 

Ops 32434 10957 Issue: The EMC->Enterprise level-> Control Parameters-> 
Configuration tab-> Number of Checks printed before 
Authorization setting did not work as expected 
Resolution: When the Roles | Printing option [23 - 
Authorize/Perform Unlimited Reprinting/Printing of a 
Check] was disabled and the Control Parameters option 
Number of Checks Printed Before Authorization was 
configured, the Workstation did not prompt for 
authorization if the number of checks printed exceeded 
the number specified in the control parameter. With this 
release, this reported issue was not reproducible. 
Currently, when Role option 23 is disabled, employees 
with that Role are prompted to print based on the 
Control Parameter setting for the Number of Checks 
Printed Before Authorization field, which is the 
expected behavior. 
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Module CRID TPID Description 
Ops 32438 10985 Issue: An Operator was able to Unassign a Cash Drawer 

from others despite option [17 - Auth/Perform Assign 
Cash Drwr 1&2; Unassgn Drwr from Others] being 
disabled 
Resolution: Previously, an Operator was able to 
Unassign a Cash Drawer from others even if option 
EMC-> Configuration tab-> Personnel-> Roles-> Operations 
tab-> Miscellaneous tab-> [17 - Auth/Perform Assign Cash 
Drwr 1&2; Unassgn Drwr from Others] was disabled 
for the employee. Additionally, the Operator was not 
prompted for Authorization when the cash drawer was 
Unassigned from another Operator. With this release, 
this reported issue was not reproducible. 

Ops 32534 11474 Issue: Unable to split a check after an Item or Subtotal 
Discount was applied; users received a Cannot Split 
Check With Allocated Discounts message 
Resolution: Previously, users received a Cannot Split 
Check With Allocated Discounts message when they 
attempted to split a check with an Item or Subtotal 
Discount already applied to the order. If users split the 
check first and then applied the Discounts, it was 
working as expected and no message was displayed. 
This has been corrected by modifying the Ops.dll and 
PosCore.dll files. 

Ops 32643 13307 Issue: Negative checks that were tendered to 0.00 
caused the check to close with a Change Due amount 
equaling the negative amount and an Amount Due 
value equal to 0.00 
Resolution: Previously, the scenario described above 
would only occur if the EMC-> Tender Media-> Ops 
Behavior option [2 – Amount Required] was OFF and the 
[3 – Assume Paid in Full] option was ON. This has been 
corrected by modifying Ops.exe file. Currently, if a 
negative check is tendered to 0.00, the check will remain 
open and the 0.00 amount remains in the Check 
Summary area. 
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Module CRID TPID Description 
Ops 32684 13733 Issue: Ops ignored the [2 - Condiment Items Only] 

configuration setting for a Discount’s Condiment 
Discountability field 
Resolution: Previously, despite assigning the [2 - 
Condiment Items Only] setting to the Condiment 
Discountability field in the Discount module, Ops was 
not enforcing the discount as expected for condiment 
Menu Items (MI). Parent MI’s were also being 
discounted. This has been corrected by modifying the 
Ops.dll file. Currently, applied discounts configured to 
only affect condiment MI’s are performing as expected. 

Ops 32729 14308 Issue: Service Host threw an exception error when more 
than 100 Menu Items were rung 
Resolution: When trying to ring more than 100 Menu 
Items at the same time on a Windows CE Workstation, a 
Service Host exception error was thrown and Ops was 
terminated. With this release, this reported issue was not 
reproducible. 

Ops 32799 14743 Issue: Guest Check Info Lines were not displayed in the 
Check Detail area until a Service Total was performed 
Resolution: Previously, Guest Check Info Lines were 
not displayed as expected unless a Service Total or 
various functions were performed. This has been 
corrected by modifying Ops.exe so that SIM now sorts 
the Check Detail whenever an info line is added, thus 
allowing the info lines to display as expected. 

Ops 33514 15451 Issue: Upon using the [Edit Barcode] function, it caused 
a Failure error and exception errors in log files 
Resolution: Previously, use of the [Edit Barcode] 
function was not working as expected. This has been 
corrected by modifying the TotalPosting.dll file. 

Ops 32910 15835 Issue: When using the [Update Selected Item Count] 
function, it caused financial report totals to be inaccurate 
Resolution: Previously, the Total Revenue Section on 
financial reports displayed (understated values) while 
the Begun/Paid section displayed correct totals. This has 
been corrected by modifying the Ops.dll file. Currently, 
Financial reports are updated accordingly when the 
[Update Selected Item Count] function is utilized. 
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Module CRID TPID Description 
Ops 32911 15839 Issue: Workstation and mymicros Reports did not show 

any record of using the [Update Selected Item Count] 
function key 
Resolution: Previously, if the [Update Selected Item 
Count] function key was used on a Check, there was no 
entry in the Workstation Check Journal, Employee 
Journal Reports, and mymicros Reports to indicate the 
item count was increased using the [Update Selected 
Item Count] key. This has been corrected by modifying 
the Ops.dll. 

Ops 32912 15842 Issue: When using the [Split Item Off] function, it 
caused financial report totals to be inaccurate 
Resolution: Previously, the Total Revenue Section on 
financial reports displayed (overstated values) while the 
Begun/Paid section displayed correct totals. This has 
been corrected by modifying the Ops.dll file. Currently, 
Financial reports are updated accordingly when the 
[Split Item Off] function is utilized. 

Ops 32927 15935 Issue: Using the [Touch Reorder] function generated 
incorrect price amounts for Menu Items (MI) with 
decimal quantities 
Resolution: Previously, the [Touch Reorder] function 
gave the user the option to select any item from the 
previous or current round and order it again with the 
expectation that the reordered item would retain any 
changes that were made to the item when it was 
originally ordered. In the case of items with decimal 
quantities, [Touch Reorder] incorrectly rounded the 
MI’s price up while maintaining the appearance of a 
decimal quantified item. This has been corrected by 
modifying the Ops.dll file. Currently, MI’s with decimal 
quantities have their price correctly applied and 
displayed on Ops. 
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Module CRID TPID Description 
Ops 32928 15940 Issue: The Journal log file entries for Menu Items (MI) 

with decimal quantities were being rounded up to the 
nearest whole number 
Resolution: Previously, when the EMC-> <Enterprise / 
Property / Revenue Center> -> Menu Items-> Menu Item 
Classes-> General tab-> Count Entry-> [2- 
Decimal/fraction allowed, round sales count up] option 
was enabled, the log file entries for MI’s with decimal 
quantities did not match the same value displayed on 
Ops. The logging values of MI’s with decimal quantities 
were being rounded up. This has been corrected by 
modifying the PosCore.dll, Ops.dll and the 
SimphonyPosApi.dll files. 

Ops 32956 16146 Issue: Changes made to the Menu Item Availability 
module were not reflected on Workstations 
Resolution: The Menu Item Availability feature is not 
currently supported in Simphony v2.x. It was formerly 
available in legacy applications such as 9700 HMS. Users 
that attempted to configure the Menu Item Availability 
module noted that their changes weren't being seen on 
the Workstations. A new Menu Item Availability check 
box in the EMC-> Enterprise level-> Setup tab-> Enterprise 
Parameters-> EMC Modules tab that when selected and 
saved, will be hidden from view and therefore non-
configurable moving forward (once the EMC is closed 
and reopened). Please see the attached screen shot 
below. There is no CSH file for the Menu Item 
Availability field. This change was implemented by 
modifying the EMC.exe file. 
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Module CRID TPID Description 
Ops 32960 16173 Issue: A Table Name did not display for any language 

except Language1 
Resolution: Previously, for multi-language sites, when 
another Language for the Table Names was configured, 
users were unable to see the alternate language. Users 
could only see Language1. Additionally, when users 
attempted to switch the Language using the ‘Screen 
Language List’ function, it displayed the other 
languages as blank, even though they were in the 
database. This has been corrected by modifying the 
Ops.dll file. Note that if Language2 does not have any 
name configured for the Table Name, it displays the 
Language1 Name by default. 

Ops 33047 17394 Issue: When a Payment Tender/Media was assigned to a 
Screen Look Up (SLU), an error was displayed on the 
Workstation 
Resolution: Previously, when a Payment Tender/Media 
was assigned to a SLU, a Tender/Media not found 
message was displayed on the 
Workstation. This has been corrected by disabling the 
ability to configure Payment Tender/Media types 
through SLUs. Payment tenders will be required to be 
configured via the Page Design module using a Payment 
Tenders button. When the Tender/Media type is a 
Payment, the SLU dropdown menu will be grayed out 
and thus non-configurable. 

 
The Context Sensitive Help (CSH) for the Tender/Media-> 
General tab-> Key Type field has been updated to read as 
follows: 
Select a Key Type for this Tender/Media. The available types 
are Payment, Service, Total, Pickup, or Loan. Payment 
tenders may not be assigned to a SLU and will be 
programmed through a Payment Tenders button. 
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Module CRID TPID Description 
Ops 33051 17419 Issue: After using the [Reprint Closed Check] function, 

it did not display in Employee or Check Journal Ad Hoc 
reports or on the mymicros Check Image or Workstation 
journals 
Resolution: Previously, there was no report or journal 
tracking of the use of the [Reprint Closed Check] 
function. This has been corrected by modifying the 
Ops.dll file. Currently, use of the [Reprint Closed 
Check] function is displayed on Check Journal reports 
and mymicros Check Images and Workstation journals. 

Ops 33136 18060 Issue: Upon making configuration changes in the Page 
Design module, from CE clients, users received a 
System.Windows.DependancyObject message on Ops 
and some pages would not load properly 
Resolution: Previously, when the Page Design option to 
not display the Bottom Status Bar was enabled, users 
received the reported errormessage. This issue was 
initially occurring on Simphony v2.5. Currently, this 
issue is not reproducible on Simphony v2.6. There was 
no software code changes performed for this reported 
issue. 

Ops 33133 18223 Issue: Ops did not allow voiding a Menu Item using a 
Barcode Scanner 
Resolution: Previously, when trying to void a Menu 
Item using a Barcode Scanner, Ops returned the 
following error: Not allowed with Void. 
This has been corrected by modifying the Ops.dll file. 
Currently, pressing the [Void] function key and then 
scanning a Menu Item will remove the Item from the 
sales transaction. 

Ops 33177 18850 Issue: The Customer Rear Display did not display the 
correct Amount Due total after performing a Void 
Resolution: Previously, when performing a Void of a 
Menu Item, Discount, Service Charge, or Tender Media, 
the customer rear display showed that the item was 
voided, but the Amount Due total wasn't updated 
correctly until another positive transaction was 
performed. The displayed total remained the Amount 
Due total prior to performing the void. This has been 
corrected by modifying the Ops.dll file. 
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Module CRID TPID Description 
Ops 33190 19066 Issue: Reordering a voided Menu Item with an 

Automatic Discount using the [Touch Reorder] key, 
incorrectly calculated the Automatic Discount amount 
Resolution: Previously, when an Operator voided a 
Menu Item with an Automatic Discount and then 
reordered the same Menu Item using the 
[Touch Reorder] key, the Automatic Discount amount 
was incorrectly calculated. This has been corrected by 
modifying the Ops.dll file. 

Ops N/A 19114 Issue: Ops did not have a functionality to auto-complete 
Required Condiment Groups 
Resolution: Previously, the Ops did not have a 
functionality to auto-complete Required Condiments 
Items. This has been corrected by modifying the 
EMCText.xml file, Ops.dll, and 
PosCoreCodeGenerator.dll files. Currently, if a 
Condiment is a part of a Required Condiment 
Group with the maximum value set to greater than one 
Item in the EMC-> <Enterprise / Property / Revenue Center 
(RVC)> -> Configuration tab-> Menu Item Classes-> Table 
View-> Forced Condiments tab, and the option [63 – 
Autofill] is enabled for that Condiment from the EMC-> 
RVC level-> Configuration tab-> Menu Item Classes-> Table 
View-> Options tab, then, the Sales Count of the 
Condiment is changed to meet the maximum value. 
However, if a Condiment is ordered with a quantity 
greater than one, the option [63 – Autofill] is ignored. 

Ops N/A 19156 Issue: Additional default LogZones were added to the 
EGateway log directory-> 'LogZone_LoadHandlers.txt' 
file for Win32, Windows CE and iPad clients 
Resolution: Previously, there were only five default 
LogZones listed in the EGateway log directory-> 
'LogZone_LoadHandlers.txt' file. Six more default Log 
Zones have been added for Win32, Windows CE and 
iPad clients. They are: OPS, PosCore, KDS, Printing, 
Labor and TtlsPosting. See the Ops Client Logging Setup 
article for more detail on how to enable Ops client 
logging. 
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Module CRID TPID Description 
Ops 33283 19733 Issue: When the Last Entry Area was enabled, 

navigational tabs were rendered inconsistently on 
different Workstation environments 
Resolution: Previously, when a page was designed to 
have eight navigational tabs and the 'Last Entry Area' 
was enabled, Ops rendered the tabs inconsistently in 
Windows CE, PosReady and 2015 Windows 7 
Workstations. In certain Workstations, the eighth tab 
was partially or fully invisible. This has been corrected 
by enhancing the Page Design module. Two new fields, 
Tab Item Width and Tab Item Height have been added 
to the Tab Control configuration menu to provide users 
the ability to configure the height and the width of the 
tabs. 

Ops 33290 19756 Issue: Ops did not post the individual Tax Exempt 
amounts to the CHECK_DETAIL table in the Check and 
Posting Service (CAPS) database 
Resolution: Previously, when a Tax Exempt Coupon 
was used to tender a Check, Ops only posted the total 
Tax Exempt amount to the CHECK_DETAIL table in the 
CAPS database. Individual Tax Exempt amounts were 
not posted to each check detail Item— the value 0.00 
was posted to the TaxForgivenTotal column in the 
CHECK_DETAIL table instead of the Tax Exempt 
amount. As a result, the Data Posting Service(DPS) did 
not post the Tax Exempt amount to mymicros. This has 
been corrected by modifying the PosCore.dll file. 

Ops 33338 20246 Issue: A weighed Menu Item’s price fluctuated + or - 
.01¢ based on the manual weight entry rather than 
adhering to the MI’s configured price (per pound or 
metric unit of measure) 
Resolution: Previously, a weighed MI’s price seemed to 
vary between the Ops Detail Area and the Guest Checks 
and Customer Receipts. It appeared as though the MI’s 
price varied based on the manually entered weight 
rather than maintaining its configured price. This has 
been corrected by modifying the PosCore.dll, Ops.exe, 
OpsUI.exe and PosApi.dll files. Currently, the price of a 
weighed MI does not change; the Amount Due is based 
solely on the entered weight of the item and is 
calculated using the items configured price record(s). 
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Module CRID TPID Description 
Ops 33348 20350 Issue: If the default Revenue Center (RVC) was 

changed, the Dining Table image was not displayed in 
the Workstation causing Begin Check to prompt for the 
table number 
Resolution: Previously, if the default Revenue Center 
(RVC) was changed and then a user signed into the 
Workstation and viewed the table objects, white boxes 
displayed instead of the Dining Table Image. When a 
box was selected and the [Begin Check] function was 
performed, Ops prompted for the table number. It was 
determined that when the default RVC was changed to a 
new RVC, all RVC related objects including Dining 
Table objects were updated based on the new default 
RVC. However, if a user signed back-in to the previous 
default RVC immediately afterwards, the RVC related 
objects were not updated based on the signed in RVC. 
This caused the Dining Table objects to use the settings 
of the now default RVC which had no table defined 
(since no table was defined, there was no image or color) 
therefore, Ops prompted for the table number when 
attempting to begin a Check. This has been corrected by 
modifying the Ops.dll and OpsUI.dll files. 

Ops 33401 20741 Issue: Sales Itemizers were not printed on Split Checks 
Resolution: Previously, although the option [20 - Print 
Sales Itemizers] was enabled from the EMC-> 
<Enterprise/Property> Configuration tab-> Sales-> 
Tender/Media-> Options tab-> Printing tab, the Sales 
Itemizer lines were not printed on Split Checks. This has 
been corrected by modifying the Ops.exe file. Currently, 
to print Sales Itemizers on Split Checks, the desired 
tender must be selected as the Default Reprint Check 
Tender via the EMC-> Enterprise level-> Setup tab-> 
Parameters-> Tender Parameters-> Configuration tab. 

Ops 33405 20796 Issue: Canceling a service round with a partial Room 
Charge payment did not correctly post to a Property 
Management System (PMS) interface 
Resolution: Previously, when performing a partial 
Room Change to a guest’s account and then cancelling 
the service round, upon being prompted to confirm the 
guest account to Void the partial tender, if the operator 
cancelled the operation, the round cancelled in Ops, 
however the tender was not voided in the PMS interface 
(e.g., Opera PMS). This caused the total tendered to the 
associated account to be inflated on PMS reports. This 
has been corrected by modifying the Ops.dll file. 
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Module CRID TPID Description 
Ops 33418 20842 Issue: If the option [8 - Use Number of Seats for Guest 

Count] was enabled and a Guest Check was split in to 
more than two Checks, Ops incorrectly calculated the 
Guest Count 
Resolution: Previously, when the Revenue Center (RVC) 
Parameters option [8 - Use Number of Seats for Guest 
Count] was enabled from the EMC-> RVC level-> Setup 
tab-> RVC Parameters-> Options tab, and an Operator 
split a Guest Check into more than two Checks, the 
Guest Count was incorrectly calculated by Ops. This has 
been corrected by modifying the Ops.dll and 
PosCore.dll files. 

Ops 33440 20941 Issue: When Items were shared between Split Checks, 
the Check Begun, Check Paid and Total Revenue 
amounts on the Property Financial Report did not match 
Resolution: Previously, when Menu Items with 
Inclusive Tax was shared between Split Checks, the 
Check Begun amount was off by .01¢ for the displayed 
Check Paid and Total Revenue amounts on the Property 
Financial Report. It was determined that this occurred 
because the -0.01¢ balance was not posted to the Check 
Begun totals when there was a tax difference and it was 
an Inclusive Tax. This has been corrected by modifying 
the PosCore.dll file. 

Ops 33463 21076 Issue: An error occurred when performing a [Return] or 
a [Transaction Void] operation using a Credit Card 
Resolution: Previously, when a [Return] or a 
[Transaction Void] operation was performed using a 
Credit Card, the following error was displayed: Tip 
Amount cannot exceed payment amount. This has been 
corrected by modifying the MCreditDebit.dll file. 

Ops 33474 21089 Issue: Servers could Void Items from a Previous Round 
if they voided the modifier (condiment) first 
Resolution: Previously, it was reported that when 
voiding a modifier (not a required condiment) from a 
Previous Round, that users could then void the Parent 
menu item as well, despite not having such Void 
privileges. This has been corrected by modifying the 
PosCore.dll file. Currently, if such a void is attempted, 
users receive a Void and re-order this item first 
message. For non-privileged employees, authorization is 
required if there is an attempt made to Void both items, 
either with or without modifiers. 



 

Resolved Issues 107 

Module CRID TPID Description 
Ops 33537 21726 Issue: Printed Guest Checks and Customer Receipts 

inaccurately calculated the price of Weighed Menu 
Items with a Tare Weight 
Resolution: Previously, Guest Checks and Customer 
Receipts inaccurately calculated the price of Weighed 
Menu Items (the EMC-> Configuration tab-> Menu Items-> 
Menu Item Classes-> Options tab-> [15 - Weighed Items]) 
with a Tare Weight (the EMC-> 
Configuration tab-> Menu Items-> Menu Item Maintenance-
> General tab-> Tare Weight). It was determined that the 
price was inaccurately calculated because the Tare 
Weight was being rounded. This has been corrected by 
modifying the EMCText.xml and 
OpsUI.dll files. 
Currently, the weight of the Menu Item and Tare Weight 
displayed and used in calculations uses the same level of 
precision. The level of precision is determined by the 
Unit of Measure as follows: 

• Kilograms: 0.000 
• Pounds: 0.00 
• Ounces: 0.0 

The Context Sensitive Help (CSH) text has been updated 
to inform users not to enter more digits than the scale 
will display. 
The Context Sensitive Help (CSH) text for Tare Weight 
in Table View reads as follows: 
This column displays the Tare Weight for each definition. 
Enter the weight of the empty package for an item that is sold 
by weight (e.g. the weight of the salad container at a salad bar, 
where the salad is sold by weight). The Tare Weight entered in 
this field should not be more accurate than your scale can 
measure so that the system does not round. For Kilograms this 
is to the thousandth 0.000, for pound the hundredth 0.00, and 
for ounces the tenth 0.0. 
The CSH text for Tare Weight in Form View reads as 
follows: 
Enter the weight of the empty package for an item that is sold 
by weight (e.g. the weight of the salad container at a salad bar, 
where the salad is sold by weight). The Tare Weight entered in 
this field should not be more accurate than your scale can 
measure so that the system does not round. For Kilograms this 
is to the thousandth 0.000, for pound the hundredth 0.00, and 
for ounces the tenth 0.0. 
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Ops 33564 21918 Issue: Automatic Discounts were not adhering to the 

configured Effectivity Time settings 
Resolution: Previously, Automatic Discounts were not 
adhering to the Effectivity Time settings configured in 
the EMC-> Discounts-> Effectivity tab-> Recurrence Time Of 
Day-> Active Start/End Time settings. This has been 
corrected by modifying the PosCore.dll file. 

Ops N/A 22108 Issue: Discount option [25 - Discount Combo Meal 
Group Items] did not work with Manual Discounts 
Resolution: When a Discount was configured as a 
Manual Discount, the [25 - Discount Combo Meal 
Group Items] option located in the EMC-> <Enterprise / 
Property level-> Configuration tab-> Discounts did not 
function. It was determined that this option was 
working as expected. This issue was not reproducible in 
the current release. 

Ops 33938 22475 Issue: Client returned an error if a Workstation was 
offline to the Enterprise for more than three days 
Resolution: Previously, when a Workstation was offline 
to the Enterprise for more than three days, instead of 
updating the DataStore or commencing a full database 
download, the following error occurred: 
Unable to load application 
Exception occurred: Object reference not set to an 
instance of an object. 
It was determined that this error occurred due to several 
temporary tables being included in the 
SYNC_ANCHORS table. Since they were not a part of 
the schema, they could not be updated. This has been 
corrected by modifying the SimphonyDataStore.dll file. 

Ops 33627 22519 Issue: Ops default Cash tender behavior was 
inconsistent when Tender Media Rounding was 
configured 
Resolution: Previously, based on the order of operations 
on an Ops client, the behavior of a default Cash tender 
that was configured for Rounding was sometimes 
inconsistent. This issue was documented within the 
Simphony 2.5 Maintenance Release 3 RMF article for 
Fix ID 30403. See the Currency Rounding and Amount 
Rounding by Tender Media articles for more conceptual 
information. 
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Ops 33639 22543 Issue: Automatic Discounts were applied even when the 

Discount amount was greater than the amount of the 
Discountable Item(s) 
Resolution: Previously, Ops applied Automatic 
Discounts to Menu Items even when the amount of the 
Discount was greater than the amount of the 
Discountable Item(s). This caused the Ops to generate 
negative sales. 
This has been corrected by modifying the EMCText.dll, 
PosCore.dll, PosCoreCodeGenerator.dll and 
EMCData.dll files. A new option [32 - Limit Discount 
value to value of Discountable Item] has been added to 
the EMC-> <Enterprise / Property> -> Configuration tab-> 
Sales-> Discounts Module. If the option [32 - Limit 
Discount value to value of Discountable Item] is 
enabled, when the defined Automatic Discount amount 
is greater than the amount of the Discountable Item(s), 
the Discount will be applied but, the Discount amount 
will be limited to the amount of the Discountable Item. If 
the option is disabled and the defined Automatic 
Discount amount is greater than amount of the 
Discountable Item(s), the Discount will not be applied. 
The Context Sensitive Help (CSH) text for option [32 - 
Limit Discount value to value of Discountable Item] 
reads as follows: 
Select this option for the Discount amount applied to be 
limited to the Discountable amount of the Item/Award if the 
defined Amount Off is higher than the Item/Award. If the 
Amount Off is 5.00 and the Item/Award is 4.00, applying a 
Discount with this option enabled will limit the Discount to 
4.00. If the option is disabled, the Discount will not be applied 
as it is larger than the Item/Award. 

Ops 33698 23243 Issue: Ops inaccurately displayed the Check and 
Posting Service (CAPS) Connection Status 33698 
Resolution: Previously, Ops did not accurately display 
the CAPS Connection Status (Offline/Online) Windows 
CE Workstations displayed the CAPS Connection Status 
as Micros.Ops.OpsContext whereas; Windows 32 
Workstations did not display the CAPS Connection 
Status (the status bar element was blank). This has been 
corrected by modifying the Ops.dll, OpsUI.dll, 
OPsUICommon.dll files. 
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Ops 33798 24182 Issue: Employees were unable clock in when the [12 - 

Mag Card Entry Required for Employee ID] option was 
enabled 
Resolution: Previously, when mylabor was enabled 
from the EMC-> Properties-> General-> Enterprise 
MyLabor Enabled, and the option [12 - Mag Card Entry 
Required for Employee ID] was also enabled from the 
EMC-> Property level-> Setup tab-> Hardware/Interfaces-> 
Workstations-> Options tab-> Display/Security tab, 
Employees were unable to clock in and the following 
error was displayed: 
Cannot read employee number from Mag Card. 
This has been corrected by modifying the Ops.dll and 
OpsText.xml files. Additionally, when an Employee 
attempts to use manual ID number entry to clock in, the 
following message is displayed: 
Mag Card required for Authorization. 

Ops 33751 23646 Issue: Windows CE Service Host threw an exception 
error intermittently 
Resolution: The Windows CE Service Host 
intermittently threw the following exception error: 
Error 
ServiceHost.exe 
OutofMemoryException 

at System.Threading.Timer.ring() 
This issue was not reproducible in the current release. 

Ops 34011 23932 Issue: Users were unable to log on to the Workstations if 
the Check and Posting Service (CAPS) database 
exceeded the maximum size of the local database 
Resolution: Previously, if the CAPS database exceeded 
the maximum size specified in the Configuration 
Handler for the local database, users were unable to log 
on to the Workstation. This has been corrected by 
modifying the ConfigurationHandler.dll and 
SqlCeDbHelper.dll files. Currently, users are able to log 
on to the Workstation with limited hard disk space. 
Additionally, when the Workstation is initializing, if the 
local database size has exceeded the recommended 
maximum size, the following warning message 
is displayed to the user: 
OPS:LocalDB has exceeded recommended maximum 
size 
If the CAPS database size has exceeded the 
recommended maximum size, the following message is 
written to the log: 
CAPS DB has exceeded recommended maximum size 
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Ops N/A 23935 Issue: Ops did not notify the user when the local 

database or the Check and Posting Services (CAPS) 
database exceeded the maximum 
recommended size 
Resolution: Previously, users were not notified when 
the local database or the CAPS database exceeded the 
recommended maximum size. This has been corrected 
by modifying the EGatewayHandlerUtils.dll, 
ChkPostSvcStarterHandler.dll, 
ConfigurationHandler.dll and Ops.dll files. Now, when 
the local database of a Windows CE Workstation has 
exceeded the maximum recommended size, Ops 
displays the following message: 
Ops local database has exceeded maximum 
recommended size 
If the CAPS database has exceeded the recommended 
maximum size, the following error message is written to 
the log: 
CAPS DB has exceeded recommended maximum size 

Ops 33784 25650 Issue: The [Begin Check] function caused Windows CE 
Workstations to hang up if the Workstation had Open 
checks from another Revenue Center (RVC) other than 
its currently assigned RVC 
Resolution: Previously, when a Workstation running 
Windows CE had Open checks from a Revenue Center 
(RVC) other than its currently assigned RVC, the 
Workstation hung up when the Begin Check function 
was used. This has been corrected by modifying the 
EGatewayHandlers.dll file. Currently Windows CE 
Workstations do not hang up when accessing Open 
checks from multiple RVCs. 

Ops N/A 25173 Issue: The Condiment/Combo Orderer Title Bar did not 
display any title for Allowed Condiments on Windows 
CE and Windows 32 Workstations 
Resolution: Previously, on Windows CE and Windows 
32 Workstations, when the Condiment/Combo Orderer 
was configured to display the Tile Bar, the 
Condiment/Combo Orderer Title Bar did not display 
any title if the Condiment Group was an “Allowed” 
Condiment Group. This has been corrected by 
modifying the Ops.dll file. Currently, the 
Condiment/Combo Orderer Title Bar will display a title 
only if the Layout of the Condiment/Combo Orderer is 
List Box, Tabbed List Box, or Tabbed Grid Box. 
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Ops 33693 25651 Issue: Open Checks disappeared from the Open Check 

Screen Look Up (SLU) permanently when the 
Workstation restarted 
Resolution: Previously, when a Check was opened on a 
POSReady Workstation and Service Totaled, then 
picked up on a Windows CE Workstation, if the 
Workstation was rebooted, the Check disappeared from 
the Open Check SLU. This has been corrected by 
modifying the EGatewayHandlers file. 

Ops 33740 26129 Issue: On Windows CE Workstations, Operators 
received a ServiceHost.exe error message 
Resolution: Previously, Windows CE Workstations 
would intermittently display a ServiceHost.exe error as 
shown below: 

 
When the Quit button was pressed, the Ops would exit 
and a reboot of the Workstation was required. This has 
been corrected by modifying the Windowsbase.dll, 
PresentationFramework.dll and Ops.dll files. 

Ops 33985 26725 Issue: Enabling option [2 - Use DDMMMYY Date 
Format] had no effect on the Workstation display, Guest 
Checks and Workstation Reports 
Resolution: Previously, although the option [2 - Use 
DDMMMYY Date Format] was enabled from the EMC-
> Property level-> Setup tab-> Parameters-> Property 
Parameters-> Options tab, the Workstation display, 
Guest Checks and all Workstation Reports, excluding 
the Check Journal Report, displayed the date in the 
MMMDDYY format (e.g., SEP25'01). Additionally, the 
Workstation display would display the date in correct 
format only if the Regional and Language setting of the 
Workstation was configured to use DDMMMYY format. 
This has been corrected by modifying the POSCore.dll 
file. 
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Ops 34033 27285 Issue: An Object reference not set to an instance of an 

object exception error was thrown when the Service 
Host was started on a Workstation client 
Resolution: Previously, an exception error was thrown 
when the Service Host was started on a Workstation 
client. The error message was displayed as follows: 

 
It was determined that this error occurred due to several 
temporary tables being included in the 
SYNC_ANCHORS table. Since they were not a part of 
the schema, they could not be updated. This has been 
corrected by modifying the SimphonyDataStore.dll file. 

Ops N/A 27663 Issue: When a Check Name was not defined for an 
Employee, all Guest Checks displayed an empty string 
as the Check Name instead of displaying the Employee’s 
First Name 
Resolution: Previously, if a Check Name was not 
defined for an Employee via the EMC-> Enterprise level-> 
Configuration tab-> Personnel-> Employee Maintenance, a 
Check Name was not displayed on the Guest Checks. 
This has been corrected by modifying the Ops.dll file. 
Currently, the First Name of the Employee that created 
the Check is displayed if a Check Name is not defined in 
the EMC. If an Employee’s First Name is also not 
defined, then a Check Name will not be displayed. 
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Ops N/A 27847 Issue: Menu Items with Condiments could not be 

consolidated 
Resolution: Previously, when Menu Items with 
Condiments were rung in, multiples of the same 
Condiment in a single Menu Item did not consolidate. 
This has been corrected by modifying the poscore.dll 
file. Multiples of the same Condiment in a single Menu 
Item can be sorted and consolidated by selecting the 
desired consolidation method from the Screen Sort Type 
drop-down menu in the EMC-> <Enterprise / Property / 
Revenue Center> -> Setup tab-> Parameters-> Format 
Parameters-> Configuration tab, and by enabling the 
options [45 - Sort Current Round Condiments on 
Screen] and [46 - Sort And Consolidate Current Round 
Items on Screen] in the EMC-> <Enterprise / Property / 
Revenue Center> -> Setup tab-> Parameters-> Format 
Parameters-> Options tab. 
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Ops 33677 22824 Issue: Workstations did not compare local date/time 

with server date/time before allowing a Check to be 
rung 
Resolution: Previously, Workstations did not compare 
the local system date/time with the server’s date/time 
before allowing a Check to be rung. This caused posting 
issues, as it allowed a Workstation to create a Check 
with an invalid date (e.g. 4002) that the Direct Posting 
Service could not transfer to mymicros. As a result, the 
MREQUESTS halted posting for the entire site. This has 
been corrected by modifying Ops.dll, PosCore.dll and 
SimphonyDataStore.dll files. Currently, if there is a 
difference between the Workstation date/time and the 
server date/time, the Operator will be prevented from 
beginning a Check and the following error message will 
be displayed. 

 
When ringing in a Check, the Workstation now behaves 
as follows: 

• When a Workstation is online, the Ops will not 
begin a Check if there is more than a two hour 
difference between the Workstation and the 
server. 

• When a Workstation is offline, the Ops will not 
begin a Check if the Workstation does not have 
the same year date as the server. 
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Ops 34157 29000 Issue: Menu Item Classes option [20 – allow decimal 

quantity when ordering] has been removed 
Resolution: The Menu Item Classes option [20 – allow 
decimal quantity when ordering] has been removed 
from the EMC-> <Enterprise / Property / Revenue Center> -
> Configuration tab-> Menu Items-> Menu Item Classes-> 
Options tab. Currently, in order to allow 
the use of decimal quantities, the option [2 – 
Decimal/fraction allowed, round sales count up] or the 
option [3 – Decimal/fraction allowed, set sales count to 
1] must be selected as the Count Entry via the EMC-> 
<Enterprise / Property / Revenue Center> -> Configuration 
tab-> Menu Items-> Menu Item Classes. This change has 
been implemented by modifying the Ops.dll, 
PosCore.dll, and EMCText.xml files. 

Ops 33961 29423 Issue: The Check Detail Area did not display the 
Reference Entry for Tax Exemptions performed on 
Guest Checks, nor was it printed on Guest Checks and 
Customer Receipts 
Resolution: Previously, when the option [2 - Require a 
Reference Entry with Tax Exemptions] was enabled 
from the EMC-> <Enterprise / Property / Revenue Center> -
> Setup tab-> Taxes and Order Types-> Tax Parameters-> 
Options tab, and a [Tax Exempt All] or a 
[Tax Exempt Item All] was performed on a Guest 
Check, the entered Reference Entry was not displayed in 
the Check Detail Area. Additionally, the Reference Entry 
was not printed on the Guest Check and the Customer 
Receipts. This has been corrected by modifying the 
PosCore.dll and Ops.dll files. 

Ops 34248 30309 Issue: An error occurred in the EGateway log when a 
barcode was added to a Menu Item using the [Edit 
Barcode] function key 
Resolution: Previously, when a barcode was added to a 
Menu Item using the [Edit Barcode] function key, an 
error occurred in the EGateway log. Furthermore, the 
barcode record was not added to the EMC-> Revenue 
Center Level-> Configuration tab-> Menu Items-> 
Barcodes module. Subsequently, attempting to add a 
new barcode from a different Workstation caused an 
error. This has been correct by modifying the 
CGwCheckStructs.xml, Ops.dll, OpsText.xml, 
PosCore.dll, TotalPosting.dll and 
EGatewayHandlerUtils.dll files. 
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Ops 34261 30557 Issue: Menu Item Availability did not display the names 

of all the Menu Items 
Resolution: Previously, the Menu Item Availability 
PMC Procedure only displayed the names of some of the 
Menu Items. However, the Menu Item Master IDs of all 
the Items were displayed. This has been corrected by 
modifying the Ops.dll and OpsUI.dll files. Currently, if a 
Menu Item Definition has a name defined in the EMC-> 
<Enterprise / Property / Revenue Center> -> Configuration 
tab-> Menu Items-> Menu Item Maintenance, Menu Item 
Availability will display the Menu Item Name. If a 
Menu Item Definition does not have a name defined, 
Menu Item Availability will not display the Menu Item 
name. 

Ops 34324 31384 Issue: Weighed Menu Items displayed twice in Guest 
Checks when using the Extension Application 
ScaleExtensions.dll on Simphony version 2.5 MR1 HF6 
or higher 
Resolution: Previously, on a system running Simphony 
2.5 MR1 HF6 or higher, when the Extension Application 
ScaleExtensions.dll was used and the option [15- 
Weighed Item] was enabled from the EMC-> <Enterprise 
/ Property / Revenue Center> -> Configuration tab- > Menu 
Items-> Menu Item Classes-> Options tab, the Guest 
Check displayed the Weighed Menu Item twice in the 
Check Detail area. However, this did not affect the 
Check total nor was it displayed on the printed Check. 
This has been corrected by modifying the OpsUI.dll file. 
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Ops 34756 34952 Issue: Tax Exempt reference entry did not display in 

long Guest Checks 
Resolution: Previously, when the option [2 - Require a 
Reference Entry with Tax Exemptions] was enabled 
from the EMC-> <Enterprise / Property / Revenue Center> -
> Setup-> Taxes and Order Types-> Tax Parameters-> 
Options tab and the operator pressed the [Tax Exempt 
All] function, if the Guest Check was long, the Tax 
Exempt Reference entry was not displayed in the Check 
Detail area. 
The Tax Exemption Reference entry was only displayed 
if several Menu Items were removed from the Check or 
added to the Check. In addition, if a Menu Item was 
selected from the Check and the View By Seat option 
was applied, the Tax Exemption Reference entry was 
displayed. However, selecting the options View By 
Course and View By Entry did not display the Tax 
Reference Entry. It was determined that when 
calculating the top detail item index for the Check Detail 
area that the Ops was ignoring the reference entries. 
This has been corrected by modifying the OpsUI.dll file. 

Ops N/A 35822 Issue: An ID Tech integrated encrypted card swipe 
removed track2 masked data 
Resolution: Previously, when a Credit Card was swiped 
on an ID Tech integrated Card Reader, track2 masked 
data was removed. As a result, the Credit Card tender 
could not be found. This has been corrected by 
modifying the Micros.Payment.dll file. 
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Ops N/A  40738 Issue: Operators could not begin Checks on Tables that 
had no names defined 
Resolution: Previously, if the Revenue Center (RVC) 
Parameters option [18 - ON = Use 5-digit Table #; OFF = 
Use 4-digit Character Table Name] in the EMC-> RVC 
level-> Setup tab-> RVC Parameters-> Options tab was 
disabled, when an Operator attempted to begin a Check 
using a Table that had no name, the error Table entry 
not found was displayed and the Operator was 
prompted to search for a Table by name. 
This has been corrected by disallowing the ability to 
create tables with blank names. Additionally, users are 
prevented from creating tables with duplicate names in 
a Revenue Center. However, duplicate Table Names are 
allowed across different Revenue Centers within a 
Property. If the user attempts to insert a Table without 
entering a name, the following error message is 
displayed: 

 
If the user enters a Table Name that already exists, the 
following error message is displayed: 

 
Furthermore, the Context Sensitive Help (CSH) text for 
option [18 - ON = Use 5-digit Table #; OFF = Use 4-digit 
Character Table Name] and the function key [401 - 
Begin Check by Table] have been updated. Instances 
where Table ID was used in reference to the Name field 
of the Table Module have been changed to Table Name 
for clarity. 
The CSH text for option [18 - ON = Use 5-digit Table #; 
OFF = Use 4-digit Character Table Name] now reads as 
follows: 
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This option bit controls what should be entered when a user is 
prompted for Table Number on the Workstation. Select this 
option to use the 5-digit table numbers programmed in the 
Tables module. Disable this option to use the 4-character 
Table Name entered in the Table Module. This option must be 
disabled when International LDS is used. 
The CSH text for [401 - Begin Check by Table] function 
key in the EMC-> <Enterprise / Property / Revenue Center> 
-> Configuration tab-> User Interface-> Content-> Page 
Design now reads as follows: 
This key is used to begin a Check by Table Number or Table 
ID, based on the setting of the Revenue Center Parameter 
option, [18 - ON = Use 5-digit Table #; OFF = Use 4-digit 
Character Table Name]. 
These changes have been implemented by modifying 
the EMC.dll and EMCFramework.dll files. 

Ops N/A 41007 Issue: Closing a Guest Check in a different Revenue 
Center (RVC) after signing out from the default Revenue 
Center (RVC) with an Open Check returned an error 
Resolution: Previously, if the default RVC had at least 
one Open Guest Check and an Operator signed in to a 
different RVC from the default RVC, when the Operator 
attempted to close a Guest Check an Exception error 
was returned. It was determined that this occurred if the 
Table Names of the signed in RVC differed with that of 
the default RVC. This issue was not reproducible in the 
current release. 

Ops 33613 43359 Issue: The tax on the auto service charge is unaffected 
by the taxes enabled or disabled for that Serving Period 
Resolution: Previously, the tax on the auto service 
charge was not affected by the taxes enabled or disabled 
for that Serving Period. This has been corrected by 
modifying the PosCore.dll file. Now, the tax on the auto 
service charge is affected by the taxes enabled or 
disabled for that Serving Period. 

Ops 35059 51692 Issue: The PMS Interface ping message was being sent 
in the wrong format 
Resolution: This has been corrected by modifying the 
EGatewayHandlers. With this release, the PMS Interface 
ping message format is now consistent with MICROS 
3700 and MICROS 9700 HMS ping messages. 
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Ops N/A 52225 Issue: The Service Host crashed when an Employee 

used a magnetic stripe card to sign in 
Resolution: Previously, when an Employee used a 
magnetic stripe card to sign in to the OPS, the Service 
Host crashed. It was determined that this issue only 
occurred with newer DT Research 362 Tablet Mag Card 
readers. As a workaround, the OPOS driver should be 
removed from DT Research 362 Tablet Mag Card 
readers. For DT Research 362 Tablet configuration steps 
and more information, please see the Simphony 2.5 
Maintenance Release 2 ReadMe First article referencing 
SCR 27940. 

Ops N/A 53345 Issue: Check Screen Look Up (SLU) did not navigate to 
Next Page/Panel assigned from the Page Design module 
when Next Page/Panel was not visible by condition 
Resolution: Previously, when a Check SLU was 
configured with a Next Page/Panel which was not 
visible by condition, the Check SLU did not navigate to 
the assigned panel. A new option named [Always 
Display Next Page Panel] has been added. When this 
option is enabled, the Check SLU ignores all visibility 
conditions and correctly navigate to the configured Next 
Page/Panel. This has been corrected by modifying the 
OpsUI.dll file. 
A new option named [Always Display Next Page 
Panel] has been added to the EMC-> <Enterprise / 
Property / Revenue Center>-> Configuration tab-> User 
Interface-> Content-> Edit tab-> Check SLU Configuration 
Panel. 
The Context Sensitive Help (CSH) text for the new 
option reads as follows: 
Enable this option to ignore all visibility conditions and 
always navigate to the next page and panel. 

 



 

122 Resolved Issues 

Module CRID TPID Description 
PMC 31194 32143 

3743 
Issue: Posting a Guest Check with a discount failed, 
when the Opera [Full Discount And Service Charge 
Breakdown] option was enabled 
Resolution: Previously, when the Opera [Full Discount 
And Service Charge Breakdown] option was enabled 
and a user attempted to close a Guest Check to which a 
discount was applied, the following SIM exception error 
was displayed and the posting failed: 

 
This has been corrected by updating the 'fid_fo.isl' 
(Opera PMS) SIM script. 

PMC 
Procedures 

32143 9067 Issue: When selecting the Assign Employee ID or 
Assign Employee PIN, operators could not enter first 
and last names within the filter functionality due to the 
alpha-numeric keyboard not appearing on the Ops 
Display 
Resolution: Previously, Users could not enter names 
within the filter functionality when selecting the Assign 
Employee ID or Assign Employee PIN due to the due to 
the alpha-numeric keyboard not appearing on the Ops 
Display. As a work around measure, operators entered 
names in the filter functionality with a keyboard 
attached to the workstation. The alpha-numeric 
keyboard now displays correctly on the Ops Display. 
This issue has been corrected by modifying the Ops.dll 
file. 

PMC Reports 32426 5874 Issue: mymicros Combo Items Summary Report failed 
to generate as tables in the Reporting database which 
referenced Combo Meals were not being populated 
Resolution: Previously, the 
COMBO_ITEM_DAILY_TOTAL,COMBO_ITEM_DP_T
OTAL and COMBO_ITEM_FB_TOTAL tables in the 
Reporting database, which referenced Combo Meals 
were not being populated. As a result, the mymicros 
Combo Items Summary Report failed to generate. This 
has been corrected by modifying the PosCore.dll, 
Ops.dll and the DirectPostingService.exe files. 
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PMC Reports 32902 15742 Issue: Revenue Center (RVC) names were not displayed 

on Financial Reports 
Resolution: If a site was using multiple languages and 
an Employee had an Alternate language assigned to 
their Employee record, and if that Alternate language 
had not been translated in the Revenue Center 
Configuration > Name field, Revenue Center names 
would only display RVC rather than the actual RVC 
name on Financial Reports generated by that Employee. 

 
In order to resolve this issue, navigate to the EMC > 
Property > Setup tab > Property Configuration > RVC 
Configuration module. Click within the Name field and 
press the F8 key on the keyboard. The Text Translation 
window will display. Adjacent to the Language field, 
enter the translated text within the Text field for that 
Revenue Center’s name. Repeat these steps for each 
applicable Revenue Center. Once complete, click the 
Close button and Save all changes. 
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PMC Reports 33427 20872 Issue: Employees could not run the Employee Open 

Checks Report when option [31111 - Do not Run with 
Open Checks for Any Report] was enabled 
Resolution: Previously, if the Role option [31111 - Do 
not Run with Open Checks for Any Report] was 
enabled for a Role via EMC-> Enterprise level-> 
Configuration tab-> Personnel-> Roles-> Operations tab-> Ad 
Hoc Reports tab-> General options, Employees belonging 
to that Role were prevented from running any report, 
including the Employee Open Checks Report, and from 
clocking out if the Employee had any open Checks. This 
was inconvenient as open Checks were not visible in 
Ops, and Employees could not run the Employee Open 
Checks Report to identify the Check(s) that prevented 
them from running the reports/clocking out. 
This has been corrected by modifying the EMCtext.dll 
and Ops.dll files. Employees can now run the Employee 
Open Checks Report even when option [31111 - Do not 
Run with Open Checks for Any Report] is enabled. 
The Context Sensitive Help (CSH) for the option has 
been updated as follows to reflect this change: 
Select this option to not allow employees associated with this 
Role to run any report when there are open checks. Only 
Employee Open Check report can run in order to view open 
checks. 

PMC Reports 33974 26552 Issue: Indirect Tips amounts were not displayed on 
Employee Tip Reports when mylabor was not being 
utilized 
Resolution: Previously, when mylabor was not used, 
Indirect Tips amounts were not displayed separately on 
Employee Tip Reports. The Employee Tip Report 
displayed the correct cumulative tip total amount as 
Direct Cash Tips, but did not itemize the Indirect Tips 
amount. This has been corrected by modifying the 
DataPostingService.exe file. Currently, both Direct Cash 
Tips and Indirect Tips amounts are displayed as 
separate values on Employee Tip Reports. 
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PMC Reports 34193 29612 Issue: The Cashier Financial Report did not display the 

Cashier’s name if the View was selected as Property 
Resolution: Previously, when the Cashier Financial 
Report was generated with the View selected as 
Property, the reports did not display the Cashier’s 
name. However, the Cashier Financial Report did 
display the Cashier’s name if a Revenue Center was 
selected as the View. This has been corrected by 
modifying the Ops.dll file. 

Printing N/A 3614 Issue: Simple Recovery Model was not set as the default 
Recovery Model when creating a Microsoft SQL Server 
Express workstation database 
Resolution: Previously, when creating a Microsoft SQL 
Server Express workstation database, the database 
Recovery Model was not set to Simple Recovery Model 
by default. The Recovery Model had to be manually 
selected. Currently, the Simple Recovery Model has 
been set as the default Recovery Model for all Win32 
Microsoft SQL Server Express workstation databases. 

Printing 32872 4825 Issue: The digit indicating the number of times a check 
reprint was performed did not display within a 
reprinted check’s xxx REPRINT # xxx header text 
Resolution: This reported issue was previously 
documented in the Simphony Discovery wiki for 
Simphony 2.5 Maintenance Release 2 in the ReadMe 
First (RMF) article for Fix ID 26780. See that article for 
more detailed information. 

Printing 31860 5431 Issue: Revenue Center (RVC) name was not properly 
aligned in Dopplebon Printing 
Resolution: When the Revenue Center options [3 - Print 
Dopplebon] and [7 - Print Revenue Center Name on 
Orders] were enabled, the RVC name was printed 
correctly only on the first chit, while the successive chits 
printed the RVC name left aligned. With this release, 
this reported issue was not reproducible. 

Printing 33016 9154 Issue: The [Update Selected Item Count] function in 
Non-Dynamic Order Mode (DOM) environments on a 
check’s second round, would not send Menu Item (MI) 
count updates to Remote Order Device(s) 
Resolution: Previously, MI count updates were not 
being sent to Remote Order Devices in Non-DOM 
environments when the [Update Selected Item Count] 
function was utilized. This has been corrected. 
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Printing N/A 21420 Issue: When using the [Void Closed Check] or [Void 

Close Check from list] functions, any negative Menu 
Items on a Validation Chit were not printed as expected 
Resolution: Previously, when voiding items from a 
closed check, any items with negative values associated 
with them were not printed as expected. This has been 
corrected by modifying the PosCore.dll and Ops.dll 
files. 
Note: In order to ensure that specific transaction values 
are printed, certain options shown below are required to 
be enabled: 

• Format Parameters-> [51 - Print Full Check 
Detail During Void Closed Check] 

• For International sites that desire printing 
voided Tax amounts, review the Tax Parameter-> 
International Options- > [14 – Print Item 
Inclusive Tax Detail] and [15 – Print Check 
Inclusive Tax Detail] options. 

• For Validation Chit printing, review the Control 
Parameters-> [26 - Validation Required for 
Menu Item, Service Charge Voids] option. 

Printing 33525 21534 Issue: The 24-hour time format was not displayed on 
PMC (Workstation) Reports as expected 
Resolution: Previously, despite the EMC-> Property-> 
Setup tab-> Parameters-> Property Parameters-> Options-> 
[3 - Use 24 Hour Clock] option being enabled, most of 
the PMC generated reports did not display time in 24-
hour format as expected. Currently, only the 
Check Journal Report (in the Body section of the report) 
correctly displays the 24-hour time format when this 
option is enabled. Another software change request has 
been submitted for resolving the 24-hour time format 
display on all other areas of Ops and the PMC Reports. 
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Printing 33588 22053 Issue: Epson TM-U295 Slip Printers supported firmware 

versions are indentified 
Resolution: Epson TM-U295 Slip Printers are supported 
and have been tested with Simphony v2.x. The 
following TM-U295 Slip Printer firmware versions have 
been tested and are supported for use with Simphony 
v2.x: 
Standard Firmware ESC/POS 

• 3.02 ESC/POS (tested) 
• 3.01 ESC/POS 
• 3.00 ESC/POS (tested) 

Additionally, the use of Epson TM-U290 slip printers is 
not supported by Simphony v2.x since they have gone 
End of Life. Furthermore, Epson TM-U295 Slip Printers 
running TM-U290 Emulation Firmware (EP) is also not 
supported by Simphony v2.x while using the following 
firmware versions: 

• 3.03 EP 
• 3.02 EP 
• 2.01 EP 
• 2.00 EP 

Printing 33778 23844 Issue: Enabling option [10 - Print Open and Closed 
Time on Check] and disabling option [33 - Don't Print 
Check Open Time on Customer Receipts] did not print 
the date/time the Check was opened and closed on 
Guest Checks and Customer Receipts 
Resolution: Previously, although option [10 - Print 
Open and Closed Time on Check] was enabled and the 
option [33 - Don't Print Check Open Time on Customer 
Receipts] was disabled from the EMC-> <Enterprise / 
Property / Revenue Center> -> Setup tab-> Parameters-> 
Format Parameters-> Options tab, the date/time the Check 
was opened and closed was not printed on the Guest 
Checks and Customer Receipts. This issue was not 
reproducible in the current release. 



 

128 Resolved Issues 

Module CRID TPID Description 
Printing 33934 25929 Issue: Loss of communication to the Print Controller 

resulted in failed print jobs 
Resolution: Previously, when a Workstation lost 
connectivity to the Print Controller, or received an error 
code when a print job was submitted, the Workstation 
was not able to print using the Print Controller even 
after connectivity was restored, unless the Workstation 
was restarted. This has been corrected by modifying the 
PosCore.dll file. Currently, Workstations do not require 
a restart to reconnect with the Print Controller. 

Printing N/A 27284 Issue: Context Sensitive Help (CSH) for function key 
[572 - Reprint Closed Check] was incorrect 
Resolution: Previously, the CSH text for the [572 - 
Reprint Closed Check] function key in the Edit 
Command dialog window of EMC-> <Enterprise / 
Property / Revenue Center> -> Configuration tab-> User 
Interface-> Content-> Page Design read as follows: 
This function is used to locate a closed check and reprint the 
receipt for it. 
The description in the CSH was incorrect and 
misleading as the [572 - Reprint Closed Check] function 
is used to print the Guest Check of a closed transaction, 
and not the Customer Receipt. This has been corrected. 
The modified CSH for the function Key [572 - Reprint 
Closed Check] now read as follows: 
This function is used to reprint the Guest Check of a closed 
transaction. 

Reports 33109 17912 Issue: The Menu Item Sales RVC Detail Report was 
generated, users received a No information available 
for the selected range message 
Resolution: Previously, Menu Item Sales Detail Reports 
were not successfully running and displayed the 
aforementioned message. This issue was not 
reproducible in the current release. 

Reports 33200 19193 Issue: Workstation Financial Reports always showed the 
default currency symbol under the section Currencies In 
Bank 
Resolution: Previously, if multiple currencies were 
configured in the EMC, Workstation Financial Reports 
showed the default currency symbol for all entries 
under the “Currencies In Bank” section. This has been 
corrected by modifying the Ops.dll file. Currently, the 
Currencies In Bank section of the Workstation Financial 
Reports show the entries with the relevant currency 
symbol. 
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Reports 33866 25034 Issue: Drilling down in the Tender Media Report did 

not display Transaction details of the Credit Card 
Resolution: Previously, drilling down into a specific 
credit card tender in the Tender Media Report, did not 
display the transaction details for that Credit Card. It 
was determined that the problem was not with the 
Credit Card Report, but with the Direct Posting Service 
(DPS) which did not populate the RecordID column in 
the GUEST_CHECK_LINE_ITEM table for details where 
the detailType = 6. This has been corrected by 
modifying the DirectPostingService.exe file. 

Reports 33584 25642 Issue: Running Financial Reports on a Workstation 5 
(WS5) Check and Posting Service (CAPS) client or a 
backup WS5 CAPS client caused the other to be 
unresponsive 
Resolution: Previously, running Financial Reports on 
either a WS5 CAPS client or a backup WS5 CAPS client 
caused the other to be unresponsive. The Workstation 
not running the report returned to normal state after the 
report had finished running on CAPS. This has been 
corrected by modifying the LocalReporting.dll file. 

Reports 33919 25981 Issue: Voiding Menu Items after using the [Split Off 
Item] function key caused inaccuracies in reporting 
Resolution: Previously, when the [Split Off Item] 
function was used, voiding Menu Items resulted in 
reporting inaccuracies. The issue was not reproducible 
in the current release. 

Security 33833 24201 Issue: The ManagedSecurityApi leaked memory on idle 
Windows CE Workstations 
Resolution: Previously, the ManagedSecurityApi leaked 
memory when a Windows CE Workstation was left idle. 
As a result, the memory in use increased over time. This 
has been corrected by modifying the 
SimphonyUtiliities.dll file. 

SIM 32211 9606 Issue: Use of the confirm SIM script command 
displayed an "Event not found" message and generated 
a Cannot Evaluate Extension Application error 
message 
Resolution: Previously, use of the confirm SIM script 
command generated error messages. With this release, 
this reported issue was no longer reproducible. 
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SIM 32797 14735 Issue: A SIM Exception error was thrown when multiple 

Print Check Trailer events were called from the same 
SIM script  
Resolution: Previously, multiple Print Check Trailer 
events weren’t printing as expected. The first Check 
Trailer printed, but not the second. This has been 
corrected by modifying the PosCore.dll file. Currently, 
multiple Print Check Trailer Events may be called from 
the same SIM script. 

SIM 32802 14781 Issue: The @dtl_type SIM script variable was not 
working as expected 
Resolution: Previously, when using the @dtl_type SIM 
script variable, Guest Check information lines were not 
stored correctly. This has been corrected by modifying 
Ops.exe file. Currently, Guest Check info lines that are 
added by SIM scripts are now properly recognized. 

SIM 32816 14893 Issue: The SIM script dtl_name variable did not send 
Unicode characters to interfaces and SIM log files as 
expected 
Resolution: Previously, when Unicode characters were 
being used, SIM was able to display the characters 
correctly in Ops, but did not send the characters to third 
party interfaces or to SIM log files. This has been 
corrected by modifying the Ops.dll file. Currently, 
Unicode characters display correctly in Ops and the SIM 
log files. In order to ensure that Unicode characters are 
written to text log files, SIM scripts must contain a 
Unicode parameter (e.g., fopen fn, fileName, append, 
local, Unicode). 

SIM 32889 15665 Issue: The SIM script Mid command did not honor the 
string variable's declared size 
Resolution: Previously, if the variable string length was 
less than the starting point defined in the Mid 
command, the following exception is thrown in Ops: 
Index and length must refer to a location within the 
string. 
Parameter name: length 
This has been corrected by modifying the PosCore.dll 
file. 
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SIM 32980 16305 Issue: The response message from a SIM ‘Guest Inquire’ 

request was incomplete and was not displaying the last 
ID number of the last line of the response 
Resolution: Previously, when using a SIM ‘Guest 
Inquire’ key on Ops while interfacing with a Property 
Management System (e.g., Opera PMS), the Response 
message (RxMsg) from the PMS was incomplete and 
could cause a problem with the Guest inquiry. This has 
been corrected by modifying the Ops.dll file. Currently, 
a full PMS response is displayed by SIM in Ops. 

SIM 33106 17908 Issue: When a GetRxMsg SIM script timeout occurred, 
the script aborted and provided no reason or ‘timeout’ 
error message to users 
Resolution: Previously, users would not receive a 
‘timeout’ error message when a GetRxMsg SIM script 
timeout occurred. Now, when a GetRxMsg SIM script 
timeout occurs, users receive a ‘timeout’ error message. 
This has been corrected by modifying the Ops.dll file 
and PosCore.dll files. 

SIM 33158 18566 Issue: When executing SIM using CE, the execution is 
distinctly slow relative to PosReady. This causes a 
significant delay in posting to the interface and closing 
checks in ops when CE SIM is used for interfacing 
Resolution: Previously, the execution of SIM using CE 
was distinctly slow relative to PosReady, thus causing a 
significant delay in posting to the interface and closing 
checks in ops while using CE SIM for interfacing. Now, 
the execution speed of SIM using CE has been increased 
due to code optimization of object creation and speed. 
The optimized code reduced the number of garbage 
collections incurred during script execution as well as 
improved performance of commonly called functions. 
This has been corrected by modifying the Ops.dll and 
PosCore.dll files. 

SIM 33601 22266 Issue: Subsequent to tendering a Check, Interface 
Scripting Language (ISL) events were executed in the 
incorrect order 
Resolution: Previously, the EGateway log file indicated 
that after a Check was tendered, the ISL events were 
executed in the incorrect order. This has been corrected 
by modifying the Ops.dll file. 
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Stored Value 
Card 

33874 25218 Issue: Print tokens sent from iCare were not printed 
when Stored Value Card Interface(SVC)/Loyalty driver 
was configured 
Resolution: Previously, print tokens sent from iCare 
were not printed if the native SVC/Loyalty drivers were 
configured. When debug logging for the drivers was 
enabled, the client log showed that iCare was sending 
the print tokens to the client correctly. It was determined 
that the print tokens from iCare were placed in the 
iCareLoyaltyModuleData's PrintLines property. As 
these were string values placed into the PrintLines string 
list that had no special characters to mark them as 
iCare's unique print token items, everything in the 
PrintLines property were dumped to the printer 
message. This has been corrected by modifying the 
StoredValueCommandModule.dll file. 

Totals 
Posting 

33589 21961 Issue: When using an Auto Service Charge and 
combining that check to another blank check, the UWS 
RVC Financial report displayed negative tax and 
credited the Total amount by this same negative amount 
Resolution: Previously, if an item was rung up that had 
no associated tax and then another a blank check was 
created and the original check was transferred to the 
new check; the RVC Financial report displayed negative 
tax and transaction credit amounts. This has been 
corrected by modifying the Ops.exe and PosCore.dll 
files. 

Totals 
Posting 

33941 26371 Issue: Pickup (Paid Out) and Loan (Paid In) Tenders did 
not post the DescriptorID of the Reason Code to the 
TOTALS table 
Resolution: Previously, Pickup and Loan Tenders did 
not post the DescriptorID of the Reason Code to the 
TOTALS table. This has been corrected by modifying the 
Ops.dll and PosCore.dll files. The DescriptorID of the 
Reason Code associated with Tender Media types Loan 
and Pickup are now written to the Data3 column for the 
TOTALS table for these operations. 
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Transaction 
Services 

N/A 21752 Issue: KDS Dynamic Order Mode (DOM) is not 
supported through Transaction Services 
Resolution: Previously, it was reported that Menu Items 
were not printing on Order Device printers if the 
following configuration was established: 
1. EMC-> RVC Level-> Setup tab-> Parameters-> RVC 

Parameters-> the [50 - Enable Dynamic Order Mode 
(DOM)] option was enabled. 

2. EMC-> RVC-> Setup tab-> Hardware/Interfaces-> Order 
Devices-> choose KDS-> KSD tab-> enable DOM Type 
to [DOM on Tender]. 

It has been determined that DOM is currently working 
as designed and is not supported through Transaction 
Services and POS API clients. Therefore, the 
configuration described above is not valid for sites 
utilizing Transaction Services clients. 

Transaction 
Services 

33562 21923 Issue: An Exception error was thrown when adding a 
second condiment to a Menu Item (MI) from a POS API 
client 
Resolution: Previously, upon adding a second 
condiment to a MI from a POS API client, users would 
receive an Error Code: UnhandledExceptionObject 
reference not set to an instance of an object error 
message. This has been corrected by modifying the 
SimphonyPosApi.dll and SimphonyPosApi_web.dll 
files. 

Transaction 
Services 

N/A 40993 Issue: When overtendering through a Transaction 
Services API the difference was calculated as a Change 
Due and not as a Charge Tip 
Resolution: Previously, if an Operator, overtendered to 
a tender that had a Service Charge configured as a Tip 
via a Transaction Services API, the difference between 
the Total Due amount and the tendered amount was 
calculated as a Change Due and not as a Charge Tip. It 
was determined this behavior was by design. When 
overtendering via a Transaction Services API, the 
overtendered amount will not be converted to tips even 
when the option [9 - Charged Tip Required] is enabled 
from the EMC-> <Enterprise / Property> -> Configuration 
tab-> Sales-> Tender/Media module. For cash 
transactions, if a tip needs to be added to a Transaction 
Services Check, a tip Service Charge detail item should 
be added. For Credit Card transactions, the 
Simphony_EPayment class named tipAmount in the 
Simphony_TenderMediaEx should be filled. 
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Module CRID TPID Description 
Transaction 
Services 

N/A 40838 Issue: The Table Number of the current Application 
Programming Interface (API) request used the previous 
request’s Table Number 
Resolution: Previously, when posting a Tender to a 
Guest Check using the AddToExistingCheck function, if 
a Table Number was provided, the Table Number, 
Employee Object Number, Revenue Center (RVC) 
Number and the Order Type of the previous transaction 
request was used. This has been corrected by modifying 
the Tsops.dll and Simphonyposapi_web.dll files. 
Currently, if a Check Number is provided when 
carrying out an AddToExistingCheck request, the Table 
Number is only submitted for that request. 

Transaction 
Services 

33884 25328 Issue: When a Check sent from the Transaction Services 
was picked up at a Workstation, the Guest Count was 
not displayed 
Resolution: Previously, when a check sent from the 
Transaction Services was picked up at a Workstation, 
the Guest Count was not displayed at the Workstation. 
It was determined that in the Transaction Services 
Service Host DataStore, the ‘Covers’ column in the 
CHECKS table was set to “0” after the Check was picked 
up in Ops and the service totaled/tendered. This has 
been corrected by modifying the Simphonyposapi.dll 
file so that GuestCheck.CoverKey is set to true for Cover 
Counts assigned to the Check. 

Workstation 33687 22960 Issue: Intermittently, generating an Employee Financial 
Report elicited an XSLT Transformation Error message 
Resolution: Previously, sometimes upon running an 
Employee Financial Report, users received an XSLT 
Transformation Error There are multiple root 
elements, Line 1, position 57 message. Currently, with 
this release, this reported issue is not reproducible. 
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Workstation 33705 23288 Issue: Cashier Reports did not track Payment tenders on 

the correct Cashier Financial Report 
Resolution: Previously, when an Operator picked up a 
check that was begun on a Workstation that had a 
different Cashier assigned (or no Cashier assigned), the 
Payment tender totals would not be added to the correct 
Cashier Financial Report. The Payment tender was 
staying with the Workstation that originally rang a 
check. If there was no Cashier linked to the Workstation 
beginning the check, the Payment tender did not display 
on any Cashier report. If there was a Cashier linked to 
the Workstation beginning the check, the Payment 
tender displayed on that specific Cashier’s report; not 
the Cashier who closed the check. Currently, with this 
release, this reported issue is not reproducible. 
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